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Introduction
GPR-SLICE is interactive software for processing and creating images
of ground penetrating radar reflection data.
GPR-SLICE integrates
radargram profiles taken over a survey grid to produce horizontal time
slice maps of radar anomalies in the ground. Time slice maps can
effectively show the size, shape, location, and depth of buried targets.
Subtle reflection features that are indistinguishable between adjacent
radargram profiles can be imaged and detected on time slice maps
created from 3D volume datasets. A book entitled GPR Remote Sensing
in Archaeology (Goodman and Piro ISBN 978-3-642-31857-3) discusses the
processes involved in making images from GPR data. Time slice maps of
GPR data have greatly improved the quality and utility of this relatively
new geophysical tool for a variety of applications.
GPR-SLICE provides a complete and single software package that
interfaces directly with raw radar field data, processes the raw data, and
creates a multitude of possible image presentations. A few of the main
features of GPR-SLICE Software are:
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

automated survey information file creation
easy file/data management with quick controls to change
between survey data
resampling of radargrams from survey wheel or user inputted
markers
standard gridding menus for creating time slice maps and 3D
volumes
easy batch time slice creation and processing controls called
BlueBox Batch runs from raw data to final 3D volume generation
integration of all the multi-channel formats and navigation from
the main GPR manufacturers
plane pixel map menu for showing many slices on a single
screen
radargram batch processing and radargram and 3D radargram
displays
examine radargram processes quickly from up to 5 directories on
a single screen
3D volume displays including:
X, Y, or Z volume slices
mouse control fence diagrams
isosurface rendering and isosurface trajectory animations
various standard volume cutaways
static corrections for topography and the unique correction for
antenna tilt-statics
7
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•
•
•
•
•

easy transform controls for enhancing time slice maps
exportable animation menu
staggering correction
automated mosaic corrections for large scale / multi-grid surveys
complete GPS navigation

GPR-SLICE was developed for need to have a comprehensive but easy
way to quickly process the enormous amounts of radargrams collected in
the field. GPR-SLICE makes it possible to quickly obtain 3D images of
radargram profiles right in the field. Sites the size of 20m by 20m
collected at 0.5m interval can have complete time slice analysis done in
less than 3 minutes, making on site evaluations accessible and easy.
Trajectory renderings and 3D volume displays are easy to create within
GPR-SLICE allowing for animated movies of progressive transparent
renders as well as a multitude of 3D displays.
Most importantly, GPR-SLICE is a user’s software.
The future
directions of the developments in the software come from user’s input.
Many of the new features created in GPR-SLICE are what users need to
image and provide that needed specific controls for their GPR datasets.
Whenever the latest version for GPR-SLICE has been updated, it can be
downloaded from the Subscribers Only page of the www.GPRSURVEY.com.

What’s New in V7.MT in 2021
Whats new in GPR-SLICE v7.MT – well the MT of course.
GPR-SLICE
2021 now is a multithreaded application! What does that mean? Well it
means that if you have multiple cores – logical cores – on your computer
you can speed up processing by almost the N times – where N is the
number of logical cores! When one processes a set of radargrams, GPRSLICE can now send out each radargram process as a separate thread in
Windows.
Windows then will send that separate process to the next
open logical core available for processing!
GPR-SLICE will send N
profiles to be simultaneously processed on each core.
The list of
processes available are outlined in the Options menu and include
radargram filtering, radargram conversion, radargram editing, time slice
binning and gridding operations. The desired number of cores can also
be set and is available in the Options menu. If you are running other
applications you can limit GPR-SLICE to any portion of the available
logical cores so all active applications will run smoothly.
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The next biggest accomplishment made in GPR-SLICE is block volume
gridding and recompositing of huge data volumes into single imagery!
What does this mean?
Well in the Radar pulldown for compiling full
resolution pulse imagery to a 3D volume, and with the settings made with
block gridding, 3D header files are written to tell GPR-SLICE to composite
all the individual zscans in each individual block volume in OpenGL back
into a single image. There are no limits to the size of imagery that can
be achieved since no of the blocks are stored in memory and are just
read as need to create the Zscan imagery. Shown in below is a site with
70gb of block volumes made with 266 blocks. The total size of the site is
1200mx420 m or about 50 hectares of data! A single image composite
of all the blocks is put back into GPR-SLICE displays!
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(data courtesy of Luke Cooper, Underground Mapping Services Inc)
o Google map or any bitmap import into OpenGL Volume
o Specialized vector volume addition menu to synthesize data
taken on varying surface structures (such as a 4 side square
column)
o Spreadsheet editing of OpenGL Volume drawn objects
o Spreadsheet editing of GPS track listings
o Combining up to 3 different antenna frequencies into a single
radargram
o Vector imaging for rooms, walls and circular structures made
simple with menus to automatically set the vector navigation
files
o Compilation of 3D Vector xyza data volume from 3D vector
radargrams after slice/resample operations
o GPS multi-radargrams display options: 1) GPS full scale
2)GPS equidistant scale and 3) GPS 1-scan per 1-pixel
o GPS post processing from master.gps file
o Independent axis labeling for depth and time now
accommodates seismic reflection profiles and velocities
o Time to depth radargram conversion using the Horizon menu
and layer interval velocities
o Shade color display
o Multiple instances of GPR-SLICE running from separate
software folders
10
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o
o
o
o
o
o
o
o
o
o
o
o
o
o

o

o
o
o
o

Radargram thresholding and filtering
FK (frequency-wavenumber) radargram filtering
32-bit radargram processing
Customized trajectory animations in OpenGL
OpenGL Volume XYZ-2D menu augmented with radargram
displays on Zscan anomaly picking
Roll/pitch/yaw added to direct compilation of multichannel
data to 3D radargram volumes
Negative/opposite – low amplitude isosurfaces
Radargram differencing
Auto hyperbola detection with a 3 & 5-point vertical search
help button
Advances in utility mapping functionality with anomaly picking
on 2D radargram and 3D volumes to export to pipe features
2D-FFT processing of time slices to filter spatial frequency
components
Complete one button batch processing - BlueBox Batch
processing from raw data to final 3D volume generation
BlueBox Batch processing for XY decoupled grid generation
useful in concrete and high density cross grid surveys
Advances in Multi-Channel array integration for all the
manufacturer – IDS Stream, 3D Radar, Mala Mira, Terravision
along with BlueBox Batch processing with a special available
menu for super large sites
OpenGL XYZ-2D menu for tracking real time anomalies in Z
planes directly onto the X and Y fence cuts in a volume all
shown in a single dialog
OpenGL Volume TSPoints operations for real time capturing of
user defined anomalies and expanded drawing tool operations
Vector Imaging and integration with accelerometers for
mapping radargrams into their real 3D space
Automated hyperbola detection and storage of peak
responses of hyperbola for a variety of applications
Zond, Mala X3M, CX11, CX12, GSSI SIR 4000, GeoScanners
Akula, Transient Technologies, GeoTech, Loza, and UTSI
Electronic
multichannel,
SEGY
multichannel,
Isung
multichannel, Impulse Radar Raptor multichannel equipment
added

GPR-SLICE v7.MT has complete 1 button BlueBox Batch processing
from conversion to processed 3D volumes! The user can set a variety of
parameters for processing in any menu, and then begin the complete
batch processing. The settings can be easily saved or recalled to any new
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project, allowing the user to quickly and easily process a similar dataset
with the same desired settings and batch filter processes.
Batch
processing is also available for all multichannel GPR systems as well.
GPR-SLICE v7.MT batch processing is referred to as ”BlueBox”
processing, since although a single button can be used to generate final
results from raw radargrams, the user needs to learn what settings are
needed to achieve the desired imaging.
The concept of BlueBox
processing is introduced to distinguish it from “black box” processing
where the user has no direct interface with any of the steps in generating
3D volumes of GPR reflection data.
Complete descriptions of BlueBox
Batch processing is given in section XIII after the user has familiarized
themselves with the basic flow of operations in GPR-SLICE.
Automated hyperbola detection has been integrated into the
Hyperbola Search menu to assist investigators in their quest to map
deterioration of bridge decks or other engineering sites constructed with
rebar.
The Automated hyperbola options can be used to tabulate and
map amplitudes of hyperbolas which are necessary for evaluating
concrete conditions and weathering. A complete description of the autohyperbola detection algorithms is provided in the special topic section I.
Road evaluation and mapping of road layers is becoming an important
part of infrastructure evaluation. GPR is one of the most important
geophysical techniques to assist in remote detection and mapping of road
layer stratigraphy.
GPR-SLICE horizon mapping and detection menus
have been enhanced for advanced auto-detections of horizon layer for up
to 15 layers. Each layer can have its own layer velocity. Based on the
horizon layers and interval velocities, GPR-SLICE can transform time
radargrams to depth radargrams which can be used in additional
processes. In addition, GPR-SLICE was advanced to include metal plate
calibration algorithms to help extrapolate and estimate subsurface
thicknesses, surface dielectrics, and sublayer velocities. The complete
description of horizon mapping and detection is further details in the
Static section of this manual.
Multi-channel imaging is becoming more frequent in GPR
investigations. GPR-SLICE integration of multi-channel systems now
includes the Mala Mira, IDS Stream, 3D Radar of Norway, Isung
Multichannel and UTSI. Navigation and integration of the multi-channel
configurations are now completely seamless in GPR-SLICE and easy to
import for starting BlueBox Batch processes.
The complete details of
enhances to multi-channel processing in GPR-SLICE is given in the
supplemental manual to v7.MT available on the website.
12
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Installing GPR-SLICE
The steps to install GPR-SLICE V7 are:
1) Create a folder c:\slice\v7.0\ directly on your local drive
2) Unzip the GPR-SLICE v7.MT Setup.zip available at https://www.gprsurvey.com/subscribers-only.html and place directly on the local c drive
3) Copy the license file mailed to you into the c:\slice\v7.0\ folder.
4) Run the CBUSETUP.exe in the V7.0 folder which will install the security
device driver. CBUSETUP.exe can also be located on the www.marx.com
website on the download support page, should the latest driver be
needed.
5) Locate the application GPR-SLICEv7.exe and make a shortcut to it for
convenience.
…. you now are ready to run the software.
To get into the software you must first create an active project by
using Files pull down menu.
After creating your first project a very
useful setting is available in the Options menu called “menu font size”
shown in the next figure. This can be used to scale all the text and menu
dialogs with a single setting. Depending on your eyesight and the
resolution of the display monitor, setting from anywhere from 7-14 or
more can be used.
Note: GPR-SLICE software can also be run from any disk drive. Make
sure that whichever disk drive is being used that the \slice\v7.0 folder
has complete open access and that all the files in the folder do NOT have
the read only checkbox engaged. To change the file access rights click on
the v7.MT folder and go to properties list item. Uncheck the read only
switch if it is engaged and then update the access in Windows.
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Multiple Instances of GPR-SLICE
GPR-SLICE can now be launched from any user defined
directory. This new feature allows the user to run multiple threads of
GPR-SLICE simultaneously as long as the project folders are different and
multiple copies of the software installation are created in separate folders.
There is no limit to the number of simultaneous threads of GPR-SLICE
that can be run. This new feature in GPR-SLICE is particularly valuable
for multichannel users or for single channel projects that take significant
time to process, allowing the user to work on several projects at the
same time. To utilize multiple threads options for GPR-SLICE, just
copy the entire contents of the v7.MT folder t different unique folder (s)
name. The software can be launched from any folder or from as many
replicated folders as you like – you are not limited to two application
14
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threads running simultaneously.
Running multiple applications of GPRSLICE from different folders is thread safe as all log and work files during
processing have been localized to the folder where the software is
launched. Windows will probably decide what CPU core to use for
additional threads.
Note: The active project folder name from the separate GPR-SLICE
threads must be different and you should not run operations on the same
project folder.
Note:
GPR-SLICE is not thread safe for most applications from within a
single instance of the software.
This means, that if you run the filter
menu for example and doing some batch process and then decide to run
the radargram menu or some other radargram menu operation, the filter
menu will be stopped, and control will go over to the radargram menu.
This can also cause some confusion and unpredictable results. However,
with the new relaxation of the folder where the software is run from in
2016, multiple instances of the software can be launched!!!
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Quickstart Introduction: raw data to 3D volume

In this quickstart introduction to GPR-SLICE V7.MT Software, we are
going to go through all the elementary steps needed to create 2D and 3D
time slices. V7 was written for the flow of control moving from top to
bottom in the pulldown menu, and then left to right.
The 12 general
steps to produce a series 2D time slices are:
STEP 1. create new project
2. transfer data
3. create new information file
4. edit info
5. convert data
6. reverse data (if necessary)
7. set, correct, or assign navigation
8. time 0 correction
9. spectra+gain
10. bandpass filtering
10a. Optional: migration, Hilbert transform
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11. slice/xyz
12. gridding
13. grid smoothing
14. time slice display, transform adjustment, 3Dvolume
generation
15. launch OpenGL Volume
The first 5 steps are all contained in order within main Files menu.
Step 1. Create New Project

Clicking the Create New Project button will launch a dialog asking for
a default directory and new project name as well as the GPR equipment
type used. The user can first Browse for any folder, then type in a name
for project. In the example above a project called “treasure” is created
directly at c:\GPR projects \treasure\.
Clicking the New Survey button
will generate the project folder with 16 subfolders: 12 radargram folders
for storing radargram signal processes and 4 other folders for imaging
output. (In addition, two radargrams folders called work2 and work3 are
made for future growth). The user can explicitly create projects on any
separate external or internal hard drives.
17
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Step 2. Transfer Data

After completing steps 1 the user needs to import data into the GPRSLICE project folder. The transfer data option available in the Files menu
is operated by:
1) Click the Browse button to locate the root of the folder where the raw
GPR data reside
2) Click the Search button to display the files into the dialog (optional)
3) Click the Import radargram data to \raw\folder button to begin
transferring the raw data into the project.
Note: There is an option to import all the files from a survey with an
Append identifier in the Transfer Data menu. This is useful when multiple
grids nearby are to be combined into a single comprehensive process but
when the separate grids might have the same filenames and unique
names are needed.
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Step 3. Create New Info

An information file is needed to detail the radar profile names and their
location on the ground. For a perfect rectangular grid, there is a quick
method to assign all the information.
1) One first sets the info filename to create, the type of survey (x or y
etc), the x start/end and y start/end
2) Click Import – Create Info button with *.* radargram extension
highlighted in the option listbox.
The last option will create an information file called info.dat with the
radargram file names and for this example a y survey. The option will
automatically discover all the radargrams with the given file extension
and place them across the ranges in x and y chosen.
(For GPS, one would set the survey to GPS and then also click the Import
– Create Info button).
19
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Step 4. Edit Information File

In the Edit Info File menu, the user can edit line length or redefine line
lengths based on the survey wheel calibration. The first operation is to
1) Click the button called ### Get TS which will read the radargram
header to find the recording time window and the samples/scan for the
radargram data. (Every manufacturer will have this similar button)
The ### Get TS button will also test to make sure all the radargrams
have identical recording parameters – if not it will return a warning
2) Optional: If the user wants to use the survey wheel calibration they
can click the ### Get XY button which will read this information and
based on the Optins menu set range unit, will place this information in
the information column.
Optional: For GPS surveys click the ### to UTM button for most
manufacturers to generate the navigation files
20
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Step 5. Convert Data

All GPR manufacturers’ data needs to be converted to GPR-SLICE
format. We typically will not apply any gain in this menu since we need
to correct for time 0 across the dataset first. One can use this menu to
optionally apply an AGC to look at the signal. If the signal shows a lot of
dc-drift or wobble noise, they can use the button batch gain- wobble. If
the data do not show dc noise, they can use just the button batch gain.
1) First click the AGC button to apply a gain to see if there is significant
dc-drift and wobble noise.
The example above shows significant
wobble noise. So for this data we should apply a pre-conditioning to
the data on conversion with batch gain – wobble button. However,
we must not apply any gain during conversion. See next step.
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2) Click the gain reset button to remove all gaining on the radargram
3) For this data click the batch gain – wobble button to convert the data
with dc-drift / wobble removal which will remove the low frequency
noise. The converted radargrams are written to the the \radar\ folder
of the project
Optional: Some manufacturers that record 32bit radargram resolution,
one can apply a constant gain across the data to see in the initial pulse.
Typical 32 bit radargrams from GSSI are actually recorded with about 2425 bits of resolution even though the data are 32 bit designation. To see
the initial pulse in the window, one may need to apply a constant gain of
100-500 for it to graphically appear. Mala and UTSI 32 bit radargrams
typically do not need any constant gain applied since these radargrams
have more native resolution in the raw radargrams and the initial pulse
will appear in this menu.
Note: Since 2013, GPR-SLICE has provided full 32 bit processing through
all the menus in the software.
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Step 6. Reverse Data (optional)

If radargrams in the field were collected in the reverse direction or in
a zig-zag direction, the reverse process can be used to un-reverse them.
1) The radargrams that were collected in the opposite direction are
checked on manually, or using some of the quick buttons available
2) Clicking the Start Reversing button will flip all the radargrams around
that were collected in the opposite direction (and rewrite them in the
\radar\ folder)
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Step 7. Set Navigation

The next step is to set the navigation:
1) For data collected with a survey wheel the set navigation should
always be Artificial Markers. This button will place marker tags on the
scans to define the range units recorded. In this example, a 10 meter
profile will have 11 markers assigned across the radargrams a 1
meters marks. (Note for fractional line lengths, the markers are
located at fractional locations and not exactly 1 range unit)
2) Optional: For GPS surveys the user will click navigation options #4
GPS/Vector Scan # which will tag those scans with the synced GPS
navigation.
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Step 8.

Time 0 correction

Time 0 must be edited from the radargrams before we can apply
range gain. Open the Radargram Editing menu found on the main Radar
pulldown menu:
1) Set the input directory to \radar\, the threshold for determining a time 0
trigger (.2), and the time 0 method between (1,2 or3) for defining the
ground wave reflection. In this example, method 1, with a threshold of
0.2 (e.g. 20% of the maximum signal) is used to trigger time 0 detection.
2) For data where time 0 is relatively constant along the radargrams, but
time 0 might be changing between radargrams, the time 0 correction
button Auto 0ns line-by-line truncate is clicked to detect time 0 and use
the median value across each individual line.
3) After the time 0 is detected the software will prompt the user with the
radargram profile with the minimum and maximum sample detection for
time 0.
Clicking the OK button in this message box the software will
start time 0 correction. The graphic window can be engaged to see the
time 0 editing process on each radargram.
4) If the user likes the time 0 editing operation, another message box comes
up after deleting the graphic window and will ask the user if they want to
update to the new infoedit.dat file. Click OK to do this (or no to redo
time 0 corrections with different settings).
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Step 9. Spectra+Gain settings

Range gain and bandpass filters need to be applied to the
radargrams via the Spectra+Gain menu.
1) Enter the Spectra+Gain menu and click the AGC Gain button to
make a possible gain curve. Adjust the gain curve manually if so
desired
2) Set the lo-cut and hi-cut frequencies desired to bandpass the
radargramsusing the left mouse button and the right mouse
button the red plot – spectral curve
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Step 10a. Bandpass Filtering

With the spectra+gain setting made the next step is to run
bandpass filters on all the data:
1) In the Filter menu clicking the bandpass button will apply range gain
and simulataneous bandpass filtering. The processed radargrams are
written to the \bandpass\ folder of the project.
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Step 10b. Optional Processing

There are many radargram signal processes that can be applied in GPRSLICE Software. For this data one can optionally do migration and
perhaps Hilbert transforms before making time slices
1) For migration, first enter the Search menu to set the hyperbola
matching with the mouse or mousewheel and also set the migrator
aperture with the slider bar. The radargram size can be adjusted with
the X and Y pixels settings if necessary. (The velocity model can be
constant, profile or a block velocity model. To chose profile or block
velocity models, the user can use the right mouse clicks at different
depths in the radargam followed by clicking the Calculate button to set
the velocity model. For simple constant velocity models the user
simply leaves the velocity model on constant and choses a velocity
with the mouse before exiting the menu)

29

30

2) Optional: With the velocity set one can click the Test Migration button
to preview how the migration will look. If it looks good, then proceed
to run migration in the main Filter menu across all the radargrams in
the info file. Diffraction stack migration or Kirchhoff migration are
available. Kirchhoff is recommended.
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3) Optional: Apply a Hilbert transform to the migrated radargram data.
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Step 11. Slice / XYZ
Step 11 is the heart of GPR-SLICE operations for coarsely spaced
single channel sureys, where time slice datasets are created. The user
can apply time slice analysis to any radargram folder for which they have
done processing. In this example, time slicing will be applied to the
\hilbert\ folder. The general steps are:
1)
2)
3)
4)
5)
6)

Set the radar folder to slice
set the time slice overlap (in this example 50% overlap)
set the number of time slices
click Help Thick to set thickness
set the bins per mark (in this example 4)
set bin parameter - usually abs(amplitude)
5a) optional: click the Show Example button to see the slice overlap
and binning settings
7) set the identifier to name the time slices
8) start the slice/xyz process
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Step 12. Grid the Time Slice *.dat Files

The next step to create time slice pixel maps is the gridding process.
The grid processing will interpolate between the xyz data to make time
slice grids/pixel maps. The time slice grids that get created can be made
with very fine or coarse cell sizes. In above example inverse distance
interpolation is highlight. The gridding steps are:
1) Choose inverse distance interpolation and smoothing factor of 2
Optional: one can choose Kriging interpolation – for this one needs to
also use the Variogram button to set the appropriate parameters
(range, sill and nugget)
2) Set the cell size draft quality (for example) and broader search
3) Click help set button which will automatically choose set gridding
values such as the start and end values for the grid, the cell size,
search and blanking radii
4) Clicking the start gridding to begin the gridding process.
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Step 13. Apply Low Pass Filter to Time Slices

To remove gridding noises a 3x3 or 5x5 low pass grid filter can be applied
the raw time slices. Click the desire filter in the Filter Type listbox, set
the append identifier (e.g. to "l" for low pass) and click the 2D filter
button. The filtering process will append the letter "l" to all the smoothed
grids.
1) Set the Append Identifier for the grid filter smoothing
2) Choose the desired low pass filter (usually 3x3 or 5x5 low pass)
3) Click the Start 2D filter button
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Step 14. Display Time Slices, Adjust Transforms and Generate 3D
Volume

The final quickstart step is to display the 2d time slice dataset created
in the GRID menu. The user can enter Pixel Map, which is conveniently
available on the task bar at T-slice as well as in the PIXEL pull-down
menu.
1. Choose the desired grid set identifier listbox
2. Draw the time slices to the screen using a desired number of
rows and screen size
3. Left click the graphic to bring up the transform menu
4. Click the Auto-Gain-All button to set balanced – normalized
transforms
5. Click the Interpolate+3D File button to generate a 3D volume
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Step 15. Launch OpenGL Volume
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Making XY Cross Survey Information Files
GPR-SLICE can handle any kind of survey navigation as long as the
information file is properly set. Commonly, XY surveys are made. The
easiest way to create the information file from cross surveys is to
generate an infox.dat file and separately create an infoy.dat file. These 2
files can then be appended at the bottom of the Create Info File menu.
Shown below are some of the steps outlined in the Create Info File menu:
Combining/Appending Information Files

Any combination of information files can be appended together in the
Create Info File menu. For instance, for cross grid XY survey, first the
infox.dat and the infoy.dat files are made independently in the menu and
then appended together. These files are then clicked on in the File
Listbox, after which the Append button is clicked on with the name of the
output filename, e.g. infoxy.dat. The operations here were modified in
2011 to enable up to 500 information files to be appended in one
operation by consecutively clicking on the desired info files in the File List.
An example of cross surveys can be seen in section XIX of the manual
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Navigation Menu: Overview

The Navigation Menu is used to assign locations to the radargrams
and all time slice images. GPR-SLICE V7.MT can implement navigation in
a variety of different ways. These methods are discussed under the
headings of:
1.
2.
3.
4.

Artificial Markers
Field Markers
Interval markers
GPS Trace #
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1) Artificial Markers
The Artificial Marker process, which is a button seen in the Navigation
Menu, will create navigation marks based on the total number of scans
recorded within a radargram. This is a very useful way to handle
radargrams collected with a survey wheel. Survey wheels always have
some slippage in them even on very flat and smooth surfaces. For this
reason, the total number of scans recorded will vary between lines,
sometimes as much as several % on bumpy surfaces. (Note: a survey
wheel may not be the appropriate device to use to navigate the antenna
across the ground on very irregular surfaces).
The artificial marker process can be used to create the navigation
information across the entire collected number of scans. For instance, if
a radargram has 201 scans and the information file for this radargram
suggests that it is a 10m long line, then the artificial marker process will
write 11 markers including the beginning and at every 20 scans along the
radargram.
The artificial marker process assumes the radargram
begins and ends at the desired locations along the grid.
For data
collected with a survey wheel some equipment manufacturers such as
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GSSI writes a survey wheel mark within the radargram scan on the
second sample. Even so, with slippage these markers should probably be
avoided in doing the navigation.
Artificial markers can also be used in a very special case if the user is
doing a GPR-GPS survey and manufacturers synced navigation scan
numbers are not available. In this case, if the GPS information files
contain equally spaced readings in time or in distance and the GPS/GPS
survey has a constant scan density on the ground, then GPS radargrams
can be quickly assigned navigation by clicking the “Artificial Marker”
button. What this process assumes is that GPS readings are made at
equidistant readings across the radargrams and for each point in the GPS
navigation file, is assigned a scan location in the radargrams. Also the
start and end of the radargrams is exactly coincident with the start/stop
of the log files then this navigation option can be used. Note: this old
method when there was not synced scan numbers associated with the
navigation could be used but there are still a lot of recording
requirements which are unlikely to allow this navigation assignment to be
appropriate.
We recommend that all GPS navigation use the synced
navigation buttons – buttons that assign the scan numbers to the
navigation recordings. One can tell if they have synced scan numbers by
looking in the 5th column of the navigation files generated using the
manufacturers buttons called #### to UTM in the Edit Info File menu.
Clicking the Show GPS File buttons, one can see if there are incrementing
numbers in the 5th column. If so, this indicates that there are synced
scans numbers. If the column is constant or set to 1, your manufacturer
does not have synced scan numbers.
When one clicks the “Artificial Markers”, the software will place
navigation tags in the 2nd sample of the radargram scan pulse. This tag
will correspond with an exact known location on the ground. Not every
scan needs to be tagged in GPR-SLICE since the scans between two
known navigation points will be dead reckoned and properly positioned
between these two points.
The user can click on the “Show Markers” option in the main
Navigation pull down menu, and see exactly where the navigation has
been set across the radargram.
The last example shows a radargram
which is known to be collected with a survey wheel and is 10 meters in
length.
When the Artificial Marker process is applied, the profile
information file is read to find out the length for that line, and then
assigns the markers equidistantly across the radargram.
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2) Field Markers
The Field Marker process will automatically search for the navigation
markers in all the radargrams listed and will display the number of
detected marker tags in the radargram in the menu. Field markers for
some manufacturers are inserted directly into the binary radargram trace
headers in the field and other manufacturers have the field markers and
their associated scan numbers placed into separate ASCII files. On
conversion, GPR-SLICE places the field markers into the 2nd sample of the
radargram trace header for all the different manufacturers.
Running the Field Marker process will show the results of the number
of markers determined from the survey information file with those
actually found in radargram. Any errors in user field markers will be
shown in the error column in the Navigation menu. If there are any
errors, the user can launch the Edit Menu (as shown in the previous
diagram), by first clicking on the radio button for the appropriate
radargram, and then clicking the Edit button.
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During a survey, marker errors will occur from a variety of reasons.
Hopefully, the number of errant lines can be minimized with good field
practices. The user can insert or delete markers for a radargram that
has a navigation problem. The left mouse button will insert a marker; the
right mouse will delete a marker on the radargram.
Note 1: Sometimes the user may need to guess where the marker error
exists in the radargram because it is not obvious where marker is needed
to add or delete. In this case, the user should also check that line start
and end locations are typed in correctly in the survey information file.
Note 2: In the case when many marker errors occur within a single
radargram and the navigation cannot be adequately determined, it may
be useful for the user not to include this radargram in the survey grid by
deleting it from the information file.
Note3: Careful note taking is required to properly document the
navigation of the radar over the ground if user markers or survey wheels
is to be used. Before any time slice analysis is applied to the radargram
dataset, the marker information for that set of radargrams must be
created in this menu and no errors between the number of markers given
by the information file and those found in the radargram must exist.
Note4: If a user has not used hand markers and they have not used a
survey wheel, nor GPS or total station navigation, there are NO accurate
operations that can be used to apply/detect/assign navigation to the
data.
Note 5: If the user accidentally runs any other navigation operations
such as artificial markers etc., the original field marker tags will get over
written in the radargram scan headers. The user must re-convert the
data from the raw folder to recover the original marker tags.
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3) Constant Interval Markers
An optional process to assign navigation marks using a constant
number of scans across the radargram is also available, which is likened
to using a survey wheel that never has any slippage. This navigation
method can be used when a specific survey requirement in which the
antenna in a survey wheel application was not stopped at the end of the
line but continued on recording past the desired end line. Then using a
constant interval marking, and assuming no slippage, the user can
recover navigation to a location somewhere before the last scan was
recorded. This option may be justified to correct these kinds of (sloppily)
collected datasets. This navigation assignment is not recommended for
most applications with the survey wheel, as the surveyor should only
normally collect data to the start and stop baselines for each profile.
In the above example and just to show the Interval Marker navigation
assignment, an interval of 10 scans between markers is assigned. For
this radargram, which is 10 meters in length, the marker locations
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assigned are shown.
(The total number of scans is 201 for this
radargram. The interval marking only tag the radargram to the 101st
scan. If this navigation were later used, the whole right half of the
radargram would not be included in any part of the processing).
The
navigation log box for Interval Markers will indicate the number of
“leftover” scans which are beyond the last marker tagged.
4) GPS/Vector Trace #
GPS random navigation requires separate GPS files for each
radargram contained in the information file.
This GPS Trace # process
will extract the corresponding scan locations for each GPS reading that is
in the 5th column of *.*.gps files and place a marker tag in the 2nd sample
of that scan pulse.
During the creation of the *.*.gps files from each
manufacturer’s native GPS log files, GPR-SLICE stores the scan/trace
number in the 5th column of those files. These scan numbers will be
tagged on those scans in the radargram during application of the GPS
navigation. Generally, all the recent manufacturers will have the lat/long
or UTM location associated with a scan number in the radargrams. The
GPS scan numbers – locations where GPS information UTM exist - can be
randomly located and do not have to be equidistantly identified across the
radargrams.
Note: Older GPS equipment may not have scan numbers. If so, for those
non-synced GPS radargrams, this navigation option will not work and the
only alternatives may be artificial markers (e.g. rubber banding all the
GPS equidistantly across the radargrams)

General Notes for Navigation Assignment
Note 1: Whatever last type of navigation assignment is run, will be the
active navigation information.
Marker information is overwritten every
time a new navigation process in this menu is run. Markers should be
recreated each time when the user is about to do slicing on any
resampled or processed radargrams such as migrated or filtered
radargrams to insure that the proper navigation is assigned, etc.
Note 2:
The user can view the markers assigned across a radargram
by clicking the Show Marker button in the pulldown Navigation Menu, and
should always do so to insure the navigation looks correct.
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Note 3: The actual navigation tag is recorded in the 2nd sample of the
radargram. This is identified in the Navigation menu along with a
threshold that is set for different kinds of navigation types, such as user
field markers or survey wheel markers
Note 4:
A good reason to use artificial marker tagging based on the
total number of scans is shown above. In the above example, the last
marker from a survey wheel survey was not put into the radargram
during the survey. This may have happened because either the
equipment did not go all the way to the end of the line and/or there was
slippage and the survey wheel did not trigger recording the last marker
even though the end of the line was encountered.
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GRID Menu: Overview
The Grid Menu will take XYZ time slice *.dat datasets that are created
at (sparse) grid nodes across a site and generate denser *.grd grid
datasets using standard geospatial interpolation routines. The Grid Menu
features are:
Inverse distance interpolation
Kriging interpolation
Grid filtering
Grid expansion
Grid rotation/translation
Grid Appending (Pixel Map menu)
Grid Math
Grid Blanking
2D Fast Fourier Transform - Time Slice Filtering
Creation of a 3D binary volume
Conversion to Surfer *.grd
The user can create dense time slice grids showing high-resolution maps
of recorded reflection amplitudes across survey sites using several
interpolation methods: inverse distance and kriging.
Inverse Distance Interpolation
Estimation between surrounding data points using a distance weighting
exponent is given in the equation, i.e.
estimated data = w1*z1+w2*z2+....wn*zn
where wi = 1/h^a
h = distance between nearby point and the
point on the grid to be estimated
a = smoothing factor (commonly set to 2)
z = radar reflection strength at the point in the
interpolation
The inverse exponential factor – or often called the smoothing factor - is
used in weighting data by their distance to the desired point to be
gridded. A lower value will more closely weight all values within the
search radius equally; a higher value will more strongly weight data
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within the search radius that are closer to the desired grid point to
estimate.
Kriging Interpolation
Kriging provides the best estimate of interpolated data based on
inversion of the covariance matrix of distances. The general equation
describing kriging is:
data weights = c-1d
where cij = c0+c1
if h=0
= c1 exp(-3h/a) if h>0
a = range at which covariance value remains
essentially the same
h = distance between points
c0 = nugget effect which provides a discontinuity
at the origin
c1+c0 = sill which describes the value of the estimate
at large distances
cij = covariance matrix of formula(1) between points
in the estimate
cij-1 = inverse matrix of cij
d = vector containing values from formula(1) between
points in the estimate and the point to be
interpolated
(see Applied GeoStatics, E.H. Isaacs, R.M Srivastava, Oxford Press, 1989)
The menu has options to predict amplitudes within blanked out areas
within a survey grid if so desired, or the ability to automatically identify
blanked out areas in a grid without having to create separate blanking
files.
Options to apply filters to the grid datasets in the GRID menu can
be done in a batch mode with a single mouse click; gridding processes
are also handled in batch mode as well. The use of identifiers can help
the user to recall the different processes applied to different datasets. The
user can use larger or smaller grid start and end locations than those
recorded in the actual dataset to either look at just a region within the
recorded grid, or to create a larger grid which can be combined with other
areas in the large grid. Combining parts of a larger grid to create a
comprehensive grid is finalized in the PIXEL MAP menu.
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Notes on the Blanking Radius
The blanking radius is the maximum distance to perform interpolation
into the grid from searched data points. If a point in a grid map is being
interpolated, and no nearby data is at least within the blanking radius,
then this point is left blank.
Often in archaeological application many
areas cannot be surveyed because of various obstructions. Sometimes it
is desired to estimate grid values from areas that could not be surveyed.
In this case, using large search radii and large blanking radius will
interpolate into blank areas that can give estimates of the reflected
amplitudes. In the case when users want to conserve the areas not
surveyed with the GPR equipment in the field, then smaller blanking
radius (slightly larger than the minimum distance between XYZ data
points) should be used.
Note: There will always be some slight interpolation within blanked out
areas for a survey grid. By using the smallest possible value for the
blanking radius, areas that have not been surveyed within the site can be
conserved and will be shown automatically within GPR-SLICE time slice
maps. To compute this minimum distance a diagram is shown describing
the calculation of the minimum distance:

The minimum distance that one can set the grid searching without
creating holes in the map and at the same time preserve as much of the
blank areas of the grid that were not surveyed is given by the above
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formula.
For example, in the case when one uses a profile interval in
the field of 0.5m, and has a cuts-per-marker of 2 and a distance unit per
marker of 1 meter, than the minimum distance to create a solid grid of
data would be
sqr[(.5/2)^2+(.5/2)^2)=0.354 m.
Users normally set the blanking radius equal to the search radius, which
defaults to one and a half times the profile spacing or 0.75 meters for this
particular example.
Grid Filtering
3x3 low pass
3x3 high pass
5x5 low pass
5x5 high pass
9x9 low pass
9x9 high pass
17x17 low pass
17x17 high pass
31x31 low pass
31x31 high pass
vert backgnd
horz backgnd
2D-sharpen
A total of 13 different kinds of 2D grid filters can be to the time slice
*.grd datasets. 20 of the filters are matrix filters and the last two filters
are linear background filters to remove noise parallel to either the x
(horizontal) or y (vertical) axes of the time slice grids.
The matrix filter descriptions are given for a 3x3 matrix as follows:
1) 3x3 Low Pass -

111
111
111

2) 3x3 Hi Pass-

-1 -1 -1
-1 9 -1
-1 -1 -1
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The same filters can be translated into larger matrix filters with 5x5, 9x9,
17x17, 31x31 grid elements.
1) Low Pass filter: For very noisy time slices the user may want to apply
5x5 or 9x9 lo pass filter which will take a boxcar average over the filter
size. For instance, a 5x5 will take an average of 5 grids in each direction
about the center of the filter and output this averaged result. This is
useful for smoothing noisy time slices, and is essentially just an average.
2) Hi Pass filter: This filter will amplify very strong amplitude changes
across a grid. This filter will often remove too much essential information
and is usually not the most useful filter for most application.
3) Vertical Background filter – This filter is a threshold line filter that is
applied individually to lines within the grid that are parallel to the y axis.
The filter works by computing an average value of the gridded data over
a filter length that the user sets. This value is then subtracted from the
value of the center of the line filter. This filter is useful in removing
striations noises in the time slice grids. The filter is also useful in
removing the mosaic patterns caused by connecting adjacent grids
collected at different times or during different ground conditions. The
vertical background filter requires the user to set the upper and lower
thresholds for which data will be included within calculating the moving
filter. For instance in the case of strong reflections from target features
along the line, the user can set the threshold to a value just below the
target amplitudes. By doing so, the data from the targets will not be
included as the moving line filter is applied. This will insure that strong
reflectors do not get ‘smeared’ as the filter is applied. The lower setting
can also be used in the same way.
The minimum and maximum
threshold settings are given as a percentage of the relative strongest
reflector along each individual line.
4)
Horizontal Background – This filter is identical to the Vertical
Background line filter just described, however, the filter is applied to the
grid lines in the X directions.
Note 1: If the grid was acquired along the y direction then in the case
that the user needs to do some background filtering, the Vertical
Background filter should be used; likewise, if profiling was done along the
x direction then the Horizontal Background filter should be used.
Note 2: An overall gain can be applied to the filtered grids. Regaining is
usually necessary for Laplacian filtering as grids with weak target
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reflections will require an increase in the dynamic range of the data.
Normally, the gain can be set to 1.
Note 3: The Filter Length setting only applies to Vertical Background and
Horizontal Background filtering. The user will need to try several setting
to see which filter length provides the right amount of filtering to the
data. A Filter Length set to the total length of the grid cells in either the
vertical or horizontal direction will essentially subtract a single – averaged
- value from each grid line individually.
Note 4: Background filters can filter out real signals that are recorded
within the data. For instance, if a buried wall reflection was recorded
parallel to the x direction of a survey area, then a Horizontal Background
filter with maximum thresholds set above these reflections may cause
complete or partial removal of these target reflections from the time slice
maps. Thresholds can be used to not exclude data above or below these
values in the filter.
Example of (vertical) grid line filtering
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Using the vertical filter in the Grid menu, linear features parallel to the
profile lines (top diagram) in this example dataset are removed. The line
filtered grid (middle diagram) is also smoothed with a 9x9 lo-pass boxcar
filter (bottom digram). After filtering hidden features are shown in the
image that could not be seen in the original raw time slice.
Rotating/Translating/Appending Grids
In the GRID Menu an option to translate and rotate grids is available.
Two options are available for rotating and translating grid: 1) fixed grid
origin or 2) translate origin. Fixed grid origin refers to fixing the origin of
the local grid or the southwest corner after grid rotation. The x and y
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translate values in the menu are the values used to set the origin of a
rotated grid. The fixed grid origin option can be useful in georeferencing
a local grid to a UTM grid for instance, where only the southwest corner is
given. The second option -translate origin will simply fix the southwest
corner of the new grid after rotation.
The translate origin is useful to
reference a new set of grids to a common origin so they might be
combined or appended if needed in the Pixel Map menu.
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In the example, a grid is rotated 10 degrees and translated to
x=10000, y=20000 at the origin. With the “fix data origin" clicked on the
southwest corner of the old grid will be rotated/translated so that the
original southwest corner is now at 10000, 20000 in the new grid. This
rotate/translate process will work in batch and will create a whole new set
of grids called with the append identifier.
Appending Gridsets
Often independently created time slice grid sets are needed to be put
into a single encompassing grid files. If the user then wants to append
several grid sets together, they can do so in the Pixel Map Menu. The
general steps for appending grids together are:
Step 1: Use the multi-grid identifier and type in the grid names separated
by commas. In this example, there are 2 grids written as a, b
Step 2: Set the starting grid number (in this example the starting grid is
5 to append the 5th and 6th files together)
(Alternately steps 1 and 2 can be accomplished by explicitly typing the
names of the grids to append in the grid file slots in the menu)
Step3: type in the total # of grids to append together
Step 4: type in a new name for the appended grid.
Step 5: click the Append button and up will come a dialog telling you
what you are appending together and the new grid name.
Note: the cell size – grid density – must be the same for all the grids to
be appended together, if not, an error message will appear.
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An example showing the results of the Rotate/Translate and Append
processes is given in the figure above. Two grids were appended, one of
which was translated 40 meter. The resulting appended grid is shown in
the bottom diagram. All these grids were shown in a single GPR-SLICE
process by individually typing these names into the grid menu items, and
then displaying the first 3 grids. An example of the same processes with
a rotation added to one of the grids during the Rotate/Translate process
is shown in the diagram below:
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Number of units to extend time slice grid and to preserve
fractional start/end points
To allow for fractional grid start/end points an option is available in
the Grid menu call XY Round#. With this option checked on and clicking
Help Set the original fractional grid start/end points will fill the slots in the
menu. When it is set to “yes” the nearest integral grid start/end points
will be set in the menu slots. To avoid the appearance of cutting of grid
maps at the edges of the boundaries,
We have also gotten inquiries from users often with GPS datasets,
why is GPR-SLICE cutting off the edges of gridmap on can either reduce
the Blanking Radius in the menu to prevent interpolation beyond that
distance where data does not exist. Alternatively, if one is interpolating
for instance out 3 meters on a GPS coarsely spaced grid, they can also
set the total number of units to add onto the grid map start/end points
using the slot next to the XY Round# checkbox. In this example an
additional 3 meters is subtracted/added for convenience onto the
start/end points of the grid to insure there is no cutoff on the map edges,
should this be desired. One can also manually set the start/end points to
any customized values without using the Help Set button.

New option to control grid start/end rounding and data unit
additions.
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An example GPS time slice with the XYround# engaged and via the
Help Set button will automatically adjust grid locations to insure no
cutoff edges.
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Grid Blanking

During grid creation, time slice values are interpolated into areas.
The amount of interpolation is a function of the search radius and the
blanking radius. In some small scale sites, areas which are desired to
keep blank and to remove interpolated information, the user can
customize a blanking grid.
To implement grid blanking, the user can click on the Make Blank File
button in the Grid Menu. This will launch a drawing program which will
allow the user to draw blank areas within the displayed grid map. There
are adjustments for the size of the brush, which stores regions as the left
mouse button is clicked. Also, rectangular screen capture blanking option
can also be engaged. Once the desired area to blank is drawn, the Write
Blank Grid button in the drawing menu is clicked. This will store the
blanking information. The blanking information can then be applied in a
batch process to all the grids by clicking the Blank button in the Grid
menu.
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An option to show the location of GPS collected over a time slice grid
in the Make Blanking Grid menu is available in Grid menu. For a GPS
collected survey grid, clicking the GPS pts button shown above, will draw
the GPS navigation points over the GPS time slice. In the examples
above, a narrow and large search radius and blanking radius were used to
create the time slices. The purpose for putting the GPS track map on the
time slice information is for the user to better see how much interpolation
is being done, particular for random data collection. Some areas where
there are very thin GPS locations or errant locations the user may want to
remove these areas from the time slice maps. Correlating the
GPS locations will allow the user to create a customized blanking grid to
run in batch which will preserve additional areas the user wants leave
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blank in the time slice maps. The user can better visualize those areas
that may need to have grid values removed.
2D Fast Fourier Transform - Time Slice Filtering
An extremely powerful method for filtering and removing noises seen
on time slice datasets is 2D Fast Fourier Transform filtering. In this
method the time slices are converted to the spatial frequency domain
using Fast Fourier Transforms:

where x and y are the coordinate location, M and N the grid dimensions,
f(m,n) is the 2D Fast Fourier Transform of the time slice data F(x,y).
Noises in the time slice can be selectively filtered by setting those desired
spatial frequency components in the transformed data f(m,n) to 0 before
computing the inverse Fourier Transform F(x,y).
An example of using 2D-Fast Fourier Transforms to remove noise from
plow scars on time slices is shown in the next figure. In the original time
slice from 21-25ns plow scars can be observed at approximately a 45degree angle to the radar profiles and the grid. Transforming the time
slice with a 2D-Fast Fourier Transform (FFT), the spatial frequency
components comprising the plow scars can be clearly seen (a). The
spatial components of the plow scars in frequency space are identified as
linear features that have a direction that are normal to the plow scars
seen on the time slices. Selectively blanking out these spatial frequency
components (c) and taking the inverse 2D-FFT the plow scars can be
nearly completely suppressed in the filtered time slice (d). In addition,
just the contribution of the plow scars can be visualized by leaving in the
relevant spatial frequencies and blanking other components (e, f). The
2D-FFT filtering is very sensitive to low frequencies near the center of the
image. For blanking operations either a screen capture mode or painting
mode where the user sets blanking brush size can be used. If an area
that is blank does not look good after running the FFT operation, the area
can be un-blanked by clicking the repaint button and un-drawing.
Blanking out the low frequency spatial components, which are near the
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center of the plot, can dramatically alter the final image. The user should
be careful not to completely blank out the central portion of the
transformed dataset. Because the 2D-FFT data is symmetrical between
the 1st and 3rd and between the 2nd and 4th quadrants, blanking
operations only need to be applied to any single quadrant - the software
will automatically blank out the negative (or positive frequencies) in the
other quadrant.
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2D-FFT filtering requires binary grid sizes to implement Fast Fourier
Transforms (M=N); however, grid resampling is done when the native
grids are not binary sizes. GPR-SLICE will automatically do resampling of
the grid for import to the filtering process and will back sample to the
original size and dimensions after the filter is applied. Another example
of a site with a rectangular grid with linear and slightly off parallel crop
noises near 5-10 degrees is shown. A customized filter is applied to the
2D spatial components. The 2D FFT filtered time slice shows suppression
of the linear noises which are non-parallel stripping noises due to
agricultural activity on the survey site. (data courtesy Eileen Ernenwein,
East Tennessee University).

Note: The 2D-FFT filtering process is very sensitive to the central – low
frequency portions of the transformed data. For this example, a small
vertical ellipse of data near the center of the transformed time slice was
zeroed – and which helps to remove the crop noises more effectively.
Import 2D Geophysical Data
GPR-SLICE has capabilities of gridding any 2D and 3D data. Options
were placed into the software at the requests of users that wanted to be
able to grid other geophysical data. The import option located in the Grid
pulldown menu launches a dialog which asks for a filename which
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contains the data. The files must have the *N.dat extension where N
must start with 1 to N number of files to be imported, and be written as a
simple x, y, z comma delimited file with no header. GPR-SLICE requires
the *.N.dat format since users that import ERT data for example often
have a series of files and not just 1.
The user should also make sure
that the very last line has a proper carriage return. Some programs such
as Excel etc, may not properly place the end-of-file carriage return
properly – please check this. Converting the data to CSV MS-DOS from
Excel for example will ensure that a readable file can be imported. The
*N.dat data must reside in the \dat\ folder of the project.
There are options to import the data as raw or de-spiked. Two
options for de-spiked data are to include the data by resetting to the
min/max spike levels, or to exclude points that fall outside of de-spiked
ranges. Also, the user can set data values which are flagged values (e.g.
empty values) in the imported data. In addition, the user can import the
data and shift every other line by the stagger length to compensate for
staggering errors, which is common from zig-zag surveys.
An example of a magnetic dataset is imported from a file called
ftlmag.dat. The Import button will create a GPR-SLICE *.dat file called
ftlmag1.dat with the correct header and format information. This file
ftlmag1.dat can then be gridded in the Grid Menu and displayed in Pixel
Map menu just as a regular time slice is (see the following diagram). One
important point regarding importing geophysical data is that the absolute
values of the data are preserved. In GPR data the “real” values of the
electric fields are currently never known, just the digitized value of the
reflection which is a function of the gain and the binary resolution. For
importation of real geophysical data, the absolute values of the data
range must be preserved. GPR-SLICE tags the imported data grid files
differently than GPR grid files so that these values can appear on the
color legend.

64

65

This magnetic anomaly map made from data collected at the Ft Lewis
archaeological site in Washington State, was historic farm site. The GPRSLICE operations of enhancing any imported geophysical data such as
histogram transform adjustments are available. Although currently only
2D files are importable in GPR-SLICE v7.MT, it is possible to generate 3D
files of non-GPR data in the software.
Using Electrical Resistance
Tomography data collected by Jessica Ogden at the British School of
Archaeology in Rome, 3D volumes could be generated after interpolation
in the Pixel Map menu. An example display is shown below.

65

66

In this ERT 3D volume, 12 resistivity inversion layers were imported
in batch by setting the number of files to 12 in the Import 2D Geophysical
Data menu. A total of 12 files res1-12.dat from the ERT data were placed
in the \dat\ folder before they were imported and gridded. After gridding,
typical Interpolate+3D file generation available in the Pixel Map menu
was applied.
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GeoSoft Oasis Montaj *.gxf Export Format
A new export format for import of GPR-SLICE 2D *.grd grid files has
been created for import into Geosoft’s Oasis Montaj Software. In the Grid
menu, there is a listbox for choosing different formats including the first
export option for making Surfer grids (Figure 5).
The *.gxf (Grid
Exchange Format) is an ASCII format that can be directly imported into
Oasis Montaj Software. The *.gxf format was in fact developed by
GeoSoft for sharing grid files with other software. The exported grid files
are written to the \grd\ folder. An example of a grid file in GPR-SLICE
and its counterpart *.gxf format displayed in Oasis Montaj viewer is
shown in Figure 5.
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Import 3D Geophysical Data

A 4 column ASCII file with a comma delimited format of x,y,z,d of
external geophysical data can be imported, interpolated, and directly
written to a 3D binary file. In the import option the maximum number of
desired grid cells in either the XY and the Z direction are independently
set. The number of cells to search for interpolation in X, Y and Z
directions can also be independently set.
Note: Depending on the number of grid cells and the number of cells to
search as well as the density of the imported data, the resulting volume
may have many empty cells. Examining the volume in Open GL Volume
can also magnify the gaps in the volume since color blending options
need adjacent cells with data to illuminate surrounding cells. If there are
many blanks either reduce the number of grid cells, or increase the
number of cells to search out.
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Smoothing of 3D Volume files
3x3x3 low pass - 3D Volume
5x5x5 low pass - 3D Volume
9x9x9 low pass - 3D Volume
17x17x17 low pass - 3D Volume
3x3x1 low pass - 3D Volume
5x5x1 low pass - 3D Volume
9x9x1 low pass - 3D Volume
17x17x1 low pass - 3D Volume
vert filter - 3D Volume
horz filter - 3D Volume
3D volumes generated in GPR-SLICE can have boxcar smoothing applied
in 3 dimensions. The option is available in the GRID menu with the
button identified as 3D Filtering. Currently 3x3x3, 5x5x5, 9x9x9, and
17x17x17 boxcar smoothing is available (and listed in the bottom of the
filtering listbox as seen in the following diagram). In addition, 3x3x1,
5x5x1, 9x9x1, and 17x17x1 3 volume filters that only apply smoothing in
the discreet z levels can be accomplished with these filters. These
smoothers are particularly useful for 3D volume generated for the full
radar pulse and do not include time slice smoothing from sample other
than the same level.
The option can also be effectively applied to
topographically adjusted 3D volumes. This filtering helps to alleviate
some noises caused by the vertical shifting of normalized grid cells to
adjusted topography levels in the volume.
3D volume vertical and
horizontal line filters are also available.
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PIXEL MAP Menu: Overview
This menu is designed to enhance, and display time slice grids created
in GPR-SLICE. Many functions can be performed in this menu, including:
•
•
•
•
•
•

drawing multi-time slice displays
adjusting time slice transforms
interpolating time slices
creating 2D time slice animations
appending/concatenating grids
overlay analysis

For those topics not included or need further description than given in the
Quickstart section, they are presented here.
Drawing Multi-Time Slice Displays
As shown in the Quickstart section for 2D time slices, the user can
display as many time slices in one screen as they so desire.
If the user
chooses automatic sizes for the screen displays, then they will have the
autoscale switch engaged to some value other than “custom”. If the
autoscale switch is set to 50% for example, all time slices drawn to the
screen will fill up only about half the computer screen.
The user
normally will choose how many time slices plus the number of rows they
will want to display maps at. The Pixel Map Menu will find appropriate
sizes and locations for the time slice maps based on the number of slices
and rows set. The user can also manually set the sizes and the shifting
between plots by turning on the custom option in the auto scale listbox.
For custom sizes, the user will need to specify explicitly the:
X, Y origin of first map measured from the upper left hand corner of
computer screen
X, Y pixel lengths of the individual time slice maps
X, Y pixel lengths to shift between adjacent plots.
With the custom setting engaged, the user can make multi-time slice
displays which are actually bigger than the computer screen. When
images bigger than the computer screen are drawn, GPR-SLICE will
automatically put scroll bars on these displays to allow viewing the entire
image.
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In this example above, the number of time slice grids to display is set
to 6 with 3 rows. The auto scaling function is engaged to custom. The
multi-time slice displays are drawn 70 pixels from the left and right from
the top left hand corner. The pixel lengths for the plots are set to 300
pixels each. The plots are also shifted 360 pixels in the horizontal X
direction, and 200 pixels in the vertical Y direction.
(Also, the
background color is set to black and the font color to white in the Options
menu).
There is an option to only show a portion of a time slice grid to the
display. Checking the focus option on and then setting the x and y
start/end locations to the desired portion of the time slice grid, will
generate separate time slice maps with just the focused region. This
option is very valuable for large scale time slice grids when only a portion
is needed for examination. This could be a very easy way to also remove
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GPR edge effects found at the ends of lines, where noises due to the
collection methods can sometimes occur.
Three types of normalization can be used to display time slice maps:
relative, absolute or ABSOLUTE normalization. Relative normalization will
display each time slice map based on each individual grids own maximum
and minimum grid values. Thus each grid displayed to the screen will
have a red area (assuming a rainbow color table) as its strongest
reflector progressing to blue for its weakest reflector. In the case of
absolute normalization, GPR-SLICE will find the maximum and minimum
within the entire set of grids to be displayed to the screen first, and then
will find the appropriate color for each grid to be display based on these
overall maximum and minimum grid values found. The third option called
ABSOLUTE normalization will colorize the time slice based on the binary
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resolution collected with raw GPR data. For instance, if 16 bit radargrams
are being processed with the square amplitude, then the maximum
values in the time slice grids can be 2^(15-1)^2, which are really huge
numbers. One can display the color legend with the corresponding
numbers depending on the normalization by clicking this on in the
Options menu.
Note: Absolute normalization will generally overweight the top time slices
as this is the area where typical ground reflections reverberate within the
antenna to usually create the strongest recorded reflections within the
dataset.
For absolute normalization to be effective, the user will
generally use a single color transform for all the time slice maps to be
displayed to the screen.

Creating 2D Time Slice Animations
JPG or BMP outputs can be created while time slice maps are being
drawn to the screen. Two types of output control of screen displays can
be set: last grid or grid-by-grid. Last grid will output only 1 bitmap/jpeg
after the entire number of time slices is displayed to the screen. Grid-bygrid will output a picture file after every single grid is drawn to the
screen.
Before starting the drawing to create an animation, the user should
insert an output identifier for creating JPGs, located next to the screen
dump setting in the Pixel Map menu. If the jpeg output control is clicked
on, and the identifier is “a” for example, a series of JPG names called,
a1.jpg, a2.jpg…aN.jpg, will be created when the drawing is started. In
the case when only the last grid option is desired, the single JPG filename
will be given the name aN.bmp, where N is the number of grids that are
actually drawn to the computer screen.
Note: Various resolutions of are available for jpeg outputs, but for GPRSLICE only the highest resolution is used.
Displaying 2 (or more) Different Grid Sets
The user can display two different grid sets on the screen. This is useful
in comparing different analyses that may have been applied to each grid
set on the same computer screen. In the example on the identifier for
each of the grids is inserted – comma delimited - as “a, r” in this
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example. Grid sets with different processing on the same site can also be
shown.
More than 2 different datasets can be shown by continuing the
comma delimited identifier.

Pixel Maps + Contour Lines
Pixel Maps can be shown with contour overlays. The contours can be
applied using either the transform, linear or custom option.
Using
transform, the contours will be applied followed the active transform for
the displayed time slice.
Linear, will place contours at a constant
threshold between contour lines. Custom allows the user to explicitly set
at what threshold values the contour overlays are displayed. For custom
the user can enter any values, separated by commas, between 1 and
255.
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Shaded Color Displays in the Pixel Map Menu
Shading of 2D pixel maps can be used in displays to give an artificial
3D appearance in the drawn time slice imagery. Shown in Figure 6 is an
example comparing normal – unshaded and shaded color time slice
images. This displays preference is currently available in the Options
menu. A slider bar can also be used to adjust the level of shading in the
images.
Some color tables lend themselves better for shade coloring
then others. To assist the user in choosing a good color table with the
option, the standard GPR-SLICE color tables have been expanded. On
the Subscribers Only page of the website, the new color table for software
have been upgraded. The typical standard rainbow color table is still
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table #8, however, color table #9 was added and appears to be a perfect
palette to enhance shade color imagery. Other color tables and ordering
of the color tables in the list have been adjusted. Color tables from 21-30
for instance have bipolar appearance and these can be useful for
radargram displays. For shade relief displays color tables from 41-50 are
useful. From 31-40, color tables with less than 256 continuous colors,
such as 32 or 16 colors are provided to help represent colored contouring
imagery.
Note: Shade color displays are currently only available in the Pixel Map
menu.
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Customizable Legend Display
Color legends in the 2D Pixel Map menu can be customized to display
labels at any desired frequency (see screen shot). In addition, horizontal
or vertical displays of the legend can be set. The legend size is maxed
out to 512 pixels or shorter depending on the axis size that the legend is
output to. The number of decimals for labeling can also be adjusted. As
all 2D grid data are now recorded as double precision floating point
numbers and not strictly integers, all grid maps have decimal data
included.
For time slice images where the squared amplitude or time
slices made from 32 bit radargrams are being used, the numbers are
quite large and the display of numbers on the legend can be shut off with
col Xfm no #s radio button.
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Overlay Analysis
Because structures are often not buried at equal depths, making thin
slices may only show parts of these structures on the time slice maps. To
make a comprehensive image of reflections at different time/depth levels,
Overlay Analysis can be implemented.
In this process, the user can
choose a range of depths to overlay the relative- strongest-reflectors onto
a single map. The shallowest time slice map is first drawn and then
deeper time slice maps which have stronger colors (e.g. stronger relative
reflections at any grid locations) are plotted onto a single 2D map. GPRSLICE Software allows individual transforms to be applied at each level to
be overlaid into the final image, which allows for greater control in
emphasizing important levels in the combined time slice image map. In
the cases when continuous archaeological features are at varying depths
in the ground, the overlay analysis will accumulate reflections from these
different depth ranges and help to create a useful map containing all the
relevant reflections on a single image.
Show in the Pixel Map Menu on the following page is a series of time
slices made across a burial mound site in Miyazaki, Japan. The purpose
of the GPR survey was to determine the shape of a buried moat
surrounding the mound which might give information on the construction
period, either late or early sixth century A.D. In the individual time slice
maps, several levels show reflections which have some information
reflecting from the moat regions. These were identified as time slice
maps 6-11.
To start the overlay process, only those maps which are desired to be
included in the overlay are clicked on (as shown Pixel Menu on the next
page). The user has buttons on the bottom of the menu to click all the
checkboxes next to the grids on or off.
The auto scaling option should
be set to custom and the shifting in x and y plots are set to 0. Clicking
the “Overlay” button will start the overlay process. After the results are
displayed the user may sometimes have to “lighten up” the general
transforms for the time slice maps to prevent overdrawing the maps with
too strong of colors.
The resulting overlay image for the example was
used to discover a “keyhole” shaped burial moat which indicated a early
6th century construction for the mound.
Animations of the overlays operation can also be made by turning on
the Screen Dump for JPGs and setting the grid-by-grid radio button.
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If the shifting of the individual time slice plots is made, then the user
can display the contributions from each map that will become part of the
overlay. This can be visualized in the Pixel Map Menu below. The auto
scaling was taken off custom and the plots were shifted automatically (at
50% scale). The first time slice was drawn fully. The next time slice in
the series shows areas on its map that are stronger in color than the first
map. The 3rd map and so on progressively shows what regions have
stronger reflections (colors) than all the previous maps that were drawn.
This technique of overlaying the relative-strongest-reflectors is not the
same as making simple composites or adding the colors or maps
together. The overlay analysis is a binary process to show the relativestrongest-reflectors over the range of time slices chosen.
The
nomenclature relative-strongest-reflector is used to distinguish the
overlay process which analyzes the individual maps with their relative
color transforms made at each level and overlays the strongest colors –
not strongest absolute reflection amplitudes - at each location. The
strongest colors which are mapped are at the control of the user in
setting transforms at each level in the overlay analysis.

Note: Overlay analysis displays are written to a hardwired grid file
named overlay-analysis1.grd. The overlay-analysis1.grd file can be
redisplayed in the Pixel Map menu and world files also can be generated
from this specially compiled grid file.
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Overlay analysis in the Pixel Map writes out all overlay segments
to individual grid files
Overlay time slices are very useful in presenting all the relevant
information from a site on a single image. Although the depth information
can be lost, the final images are often comprehensive and can be the
most important data presented. A new option to write out each
consecutive overlay time slice to its own 2D grid file is now available. This
new option will allow the user to redisplay in separate maps and also
recall the entire overlay dataset as another independent file gridset with
its identifer given as ###-overlay1-N.grd.
Recently a new Overlaybutton was also programmed into the software to allow the overlay of the
relative-weakest-reflectors which can also have some possible
applications to imaging features of interest that are weak reflectors.

Display of progressive overlays of the relative-strongest-reflector for a
concrete dataset. The button Overlay- is also available for overlays of
the relative-weakest-reflector.
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TSPOINTS.dat Anomaly File
A feature was added to GPR-SLICE which allows the user to store a
file containing mouse clicks of anomalies.
To access this feature, the
user needs to display a series of time slices to the screen. Then, right
clicking the mouse will launch a message box asking the user if they
wanted to store X, Y and T information which contains their mouse
location and the corresponding time slice information. Saying yes will
open up an on screen dialog which will get filled for every left mouse click
that is made on a time slice. The time slice name, the X and Y location,
and the time or depth location of the anomaly is stored in the on screen
dialog. This dialog is written to a file called TSPOINTS.dat and the end of
the operation.
In this example, the time slices are being displayed in
centimeters and thus centimeters are written to the depth column. If
time in nanoseconds were chosen, the depth column would convert to
time rather than depth. The user can also type in a comment as they
store anomaly information.
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The TSPoints option in Time Slice displays is also programmed for
right mouse clicks after initial launch – reporting of dx, dy, dxy between
the last left clicked point in TSpoints.dat file. An example of this new
TSPoints option in GPR-SLICE v7 in the Time Slice display is shown below.
The request for this option was made by a user that was working in a
forensic survey and they needed to quickly report distances between
selected points.
Initially the left mouse is clicked to store a bull’s eye of the first point,
then subsequent right mouse clicks will draw separate chords from the
first selected point to all the locations where the right mouse is clicked.
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ABSOLUTE Normalization Customizable Settings
The display of time slices with ABSOLUTE normalization now have
customizable inputs for the minimum and the maximum values (see next
screen shot). ABSOLUTE normalization will set the peak value and the
minimum value across an entire set of time slices and colorize the data
based on the values.
Lower case absolute normalization – where the
minimum and maximum between all the time slices displayed is searched
first prior to display - is the same as upper case ABSOLUTE normalization
display if the user set values are identical. The customization here is to
allow users investigating 4-D measurements of GPR to “re-colorize” data
collected and to investigate changes in the signal over time. To do this
requires fixing the minimum and maximum values before colorization.
Note:
For those using the Grid Blocking function for either the
Multichannel menus or the Grid menu, when displaying multiple blocks at
the same level in the Pixel Map menu, ABSOLUTE or absolute
normalization should be used.
This will insure that all the blocks are
colorized with reference to one set of min/max values – whereas on
relative normalization each map is independently normalized and could
cause mosaic changes between blocks when looking at the data as a
whole.
Note: In the example the absolute minimum and maximum were set to
the maximum abs (amplitude) time slice parameter of 32768^2 =
1073741842 which is the largest possible time slice value that can exist
84

85
in a grid map for 32 bit radargrams. This value is unlikely and can only
come in the case of an area that has a completely strong reflection.
However, over gaining of a radargram, creating clipped regions could
possible create a time slice parameter in grid map with this value.

2D Time Slice Composite
A new menu that will place multi-grid surveys into a single
composite image is now available on the Pixel pulldown menu (Figure
3). This new menu will allow a user to show all the time slices from a
survey site with multiple grids and to place in a single composite
image with a common origin. To use the new menu, the user will need
to first create a project and transfer all the desired \grid\*.grd time
slices from various projects that they want to composite together. All
the *.grd file should have a common origin and these can be UTM as
well. The new menu does NOT need to have a common grid cell
density and this can be different between the surveys. Once all the
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*.grd file are transferred, clicking the Help Set button in the menu will
discover the first time slice for each grid set which will be placed into
grid filename menu slots.
One can draw the grids with any pixel size they want. The menu
should be able to handle a graphic block that is 65000x65000pixels.
For a site that is say 1km x 1km and the user made 10cm resolution
time slice grids, this would be just a 10000x10000 graphic window
which is still much smaller than the maximum limit!
The transform menu is also enhanced. When the composite image
is displayed, the user can click on any grid block and the software will
know which transform and grid # it is on. The user can adjust the
transform for just that one block if they like particularly if there are
mosaic noises. They can balance these and quickly compare by using
the Redraw One button which will just show the changes to that one
block without redrawing the whole image.
The menu is also programmed to allow easy changes to go to the
next time slice level down by clicking the -/+ button in the Composite
menu.
In addition, placing blocks at different levels in to the
composite image can be done either manually by setting the menu slot
names, or by using the convenient Z+/Z- button in the Trasnform
menu which will increment the active block to the next lower or higher
level. One can imagine that over large sites the overburden depths
can vary and placing continuous features may require extensive use of
finding the appropriate block depth slice.
(Future updates to this
menu will allow or overlay analysis as which is currently not available).
Note: This new menu should allow them a more flexible method to fix
mosaic noises between data blocks.
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Example of the Composite time slice menu at a site in Brownsville,
Texas (data courtesy of Steve DeVore, National Park Service).
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GPR-SLICE new menu - 2D Time Slices from 3D Gridblocks
Recently, a subscriber had a 9 km coarsely spaced multichannel
dataset on a roadway. All the viewing capabilities and drawing utilities in
the OpenGL Volume Gridblock menu were available. However, the one
capability missing was being able to capture the entire site into a Google
Earth KMZ file at sufficient resolution. OpenGL is a device context and
most output is limited to the available screen size.
For this reason a new 2d menu title “2D Time Slices from 3D
Gridblocks” was developed to handle creating output from large sites. The
new menu has as the filename slots showing all the individual 3d binary
block volumes contained in the dataset. For this example, 218 gridblocks
each 50mx50mx143 were generated for the 9km dataset. Graphic
memory in this menu can create massive bitmaps that can be used for
making KMZ or World Files. Google Earth currently has a limit of
displaying georeferenced bitmaps larger than 16384x16384.
To get a
9km site into sufficient resolution to display in google earth, the users can
use the focus settings in the menu to make 4-5 sets of georefenced
imagery at the max resolutions. For bitmaps at 10cm the max resolution
might represent 1.6384 km of data. The new menu has batch button to
conveniently get out all the images from the entire volume levels. For
large sites it may take 5-15 seconds per level to completely render to the
screen - so the batch button will save time to at least have everything
created automatically.
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2D Time Slices from 3D Gridblocks menu for exporting large areas in georeferenced
images.
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OpenGL 2D Surface Plotting Menu
A menu to draw 2D time slices as 2D surface relief maps is now
available in the Pixel Map 2D pulldown menu. In the menu there are 4
possible displays:
1.
2.
3.
4.

net plot
net plot + 2D
surface + 2D
surface

The example shown is a surface + 2D image.
There are Z scaling
buttons to reduce or increase the surface anomalies. Clicking the Z sclbutton several times will make 2D flat displays which can be rotated and
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tilted real time. The time slices can be incremented by clicking the + and
- buttons.
Elemental lighting options have been added to give various effects
where the azimuth, light latitude, intensity and transparency can be
changed with a slider bar.
Several control buttons to adjust the
separation between the surface plot and the time slice can be handled
with the dz-/+ buttons. There is also a Top View Lock checkbox which
when engaged with just the surf will give a normal 2D time slice image.
We hope to expand this menu in the near future to also have some
additional features such as multi-time displays.
The Open GL 2D menu has options to output a single jpg or a series of
jpgs for input to the animation menu. There is a Store jpg button which
will create one jpg. To generate an animation, the user can click the
Generate Animation button. This will cause the OpenGL 2D routine to
display all the time slices set in the Pixel Map menu and create an
animation with the jpgs automatically incrementing their stored named.
Note: Currently to generate an animation, the OpenGL 2D window should
remain maximized. Any changes to the graphic window that are made
as the animation is being generated, will cause those screen changes to
appear in the outputted jpgs.
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GPS-GPR Surveying and Imaging: Introduction
GPR-SLICE was equipped to do 3D imaging from GPR/GPS surveys
beginning in 2003. An example plot of the first GPS track and time slices
generated in 2003 in the software and published in the SAGEEP (Soc. for
the Application of Geophysics and Engineering for Environmental
Problems) 2004 proceedings is shown below:
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Since this first early operation of GPS imaging in the software, many new
options over the years to completely automate the process have been
added to GPR-SLICE. GPR-SLICE is completely compatible with all the
unique GPS formats from Sensors and Software, Mala Geoscience, and
GSSI, US Radar, IDS, 3D Radar, Radarteam, Geoscanners and UTSI
Electronics as well as SEGY recorded GPS radargrams.
GPR-SLICE will
take all the raw and unique GPS log files that the major manufacturers
generate, and convert these files to GPR-SLICE format. GPR-SLICE will
read:
•

Sensors and Software *.gps log files and convert these into UTM
coordinates and write a standardized GPR-SLICE formatted
navigation file called *.dt1.gps used for time slice operations,

•

GSSI *.tmf timing files to get the start and end times for a given
*.dzt radargram, and then extract the necessary and
contemporaneous GPS logging information given in the *.plt, after
which a standardized GPR-SLICE formatted navigation file called
*.dzt.gps is generated for time slice operations – both Time
Stamped and non-Time Stamped log files are converted. GSSI
SIR30 has different extension names and formats, e.g. *.dwg files
which are read an automatically converted to UTM. These files also
have the scan number stored and conveniently given in the native
log files which are written into the GPR-SLICE *.dzt.gps log files.
*.dzg log files read was also added in 2013.

•

Mala Geoscience *.cor or *.gga log files and convert these into UTM
coordinates and write a standardized GPR-SLICE formatted
navigation file called *.rd3.gps used for time slice operations.

•

US Radar *.gps log files and will convert these into UTM coordinates
and will write the standardized GPR-SLICE formatted *.rad.gps
files.

•

IDS *.gps or native *.geox files
are imported directly and
converted to UTM coordinates to make the *.dt.gps files navigation
files

•

3D Radar *.positions.txt or *.nav are read and converted to
*.vol.gps files with the standardized GPR-SLICE navigation format.

•

UTSI Electronics *.gpt files are read and converted to *.dat.gps
files with the standardized GPR-SLICE navigation format.
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•

Zond or SEGY/2 have the GPS information written into the scan
headers which are similar to the SEGY locations. Zond has however
has changed the location of the standard SEGY to accommodate
higher navigation precision.
These location are automatically
inserted into the GPR-SLICE written log files.

•

GeoScanners *.gsf GPS information is written into the scan headers
of these radargrams and this is extracted and placed into the
*.gsf.gps navigation files by GPR-SLICE operations.

GPR-SLICE v7.MT uses a 20 column format for GPS files.
column format contains:

This 20

Eastings, Northings, Elev(m), Time, scan#, GPS quality, N
satellites, HDOP, vector x, vector y, and vector z, + 9
columns for future growth.
The *.*.gps files are automatically generated by clicking the various
manufacturer’s buttons in the Edit Info File menu. In most cases, the
manufacture has either written the $GPGGA NMEA string or have
provided eastings and northings values in their log files. For those
manufacturers that only provide the NMEA string, the latitude and
longitude are converted to eastings and northing using the WGS – 84
values:
Equatorial_Radius: Semi-Major Axis (WGS-84 value = 6378137.0 meters)
Polar_radius:
Semi-Minor Axis (WGS-84 value = 6356752.3142 meters)
Flattening:
f = (a-b)/a
(WGS-84 value = 0.00335281066475)
First_Eccentricity_Squared: ecc = 2f - (f^2)
(WGS-84 value = 0.00669437999013)
Inverse_flattening: Reciprocal Flattening (1/f)
(WGS-84 value = 298.257223563)

There are utility buttons in the Edit Info File menu call “SS to UTM” or
“Mala to UTM” or “GPS to UTM” where the $GPGGA NMEA strings which
contain latitude and longitude information, are automatically converted in
GPR-SLICE to UTM coordinates. UTM coordinates are much more useful
for processing then latitude and longitude, because the actual absolute
ranges in metric units in east and north are assigned.
The scan # does not necessarily have to be written into the file. If
there are no skipped GPS readings – e.g. no GPS fallout - and the
readings are all equidistant in time and/or spatially equidistant in scan
number across the radargrams, then the Artificial Markers can (and must)
be used to generate the navigation tags across the radargrams. If there
are fallouts or the GPS readings are not equidistant in scan # across the
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radargrams, the GPS Trace # process in Marker menu to extract the scan
# from the GPS files must be used for navigation. In this case, the scan
# must exist in the 5th column.
Having the scan # associated with each GPS reading insures the best
and most accurate navigation.
Some users are finding customized
solutions to generate the GPR/GPS files particularly for older equipment
that was not set up to do GPR/GPS collection automatically.
As a review, the two possible navigation steps that are unique to
creating a time slice from GPS navigated data are:
a) run the Artificial Marker process in the MARKER menu to place
navigation
tags
equidistantly
across
the
radargram
corresponding to the total number of GPS recorded and when
the corresponding scan number is not known
b) run the GPS Trace # process if GPS navigation has been
recorded with the corresponding scan number.
After applying the navigation, the dataset then goes through the normal
operation followed in the Slice/Resample menu. One special note, if the
user slices the data with a bins per mark in the SLICE menu of 2, then
the XYZ dataset will be comprised of averaged readings made twice
between GPS readings. If the GPS data were collected for instance every
1 second, then a bins per mark of 2 would mean the data are binned
every ½ second. If the data were gathered based on the survey wheel,
say every meter on the ground, then a value of 2 would correspond to
making 2 time slice parameters between consecutive GPS readings on the
survey wheel at ½ meter.
The user will need to decide what is a
reasonable spatial sampling along the GPS radargram and this is done
with the cut per mark setting.
GPR-SLICE is capable of handling any density of recorded GPS
readings. GPS log files with NMEA or log information collected on every
recorded scan – or for navigation logged on some regular or random
place along the recorded scan are all handled within the software
properly.
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Example of GPS Imaging
For every manufacturer there is a button in the Edit Info File menu to
generate the GPS log navigation files. The button will an abbreviation of
The manufactures name with the “UTM” appended to it. This button
operation will read the manufacturers gps log file or extract that
information from the trace headers etc, and will convert the information
to GPS eastings and northings as well as write the elevation of the
reading. Some manufacturers do not record the store the GPS quality,
number of satellites or the HDOP. For those manufacturers that do not
record this GPS information, GPR-SLICE will place dummy values in those
columns (6,7,8) of the GPR-SLICE log files. An example of a Mala GPS
dataset is shown below to generate the GPR-SLICE GPS log files. GPRSLICE stores the total number of GPS readings in the 4th column of the
information file. The GPR-SLICE GPS log files can be viewed for any
profiles by click the “show gps file” button.
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GPS Track Map Filtering

Various problems with typical GPR/GPS data collection can occur. In
the course of collecting GPS data, there can be data fallouts or multipathing which can cause GPS points to become erratic. Some GPS
navigation systems may not be updating quick enough and duplicate GPS
points can sometimes infiltrate GPS navigation. The main filtering options
that commonly need to be applied to a GPS tracks are:
•
•
•
•

Delete
Delete
Delete
Delete

Double GPS
Double Scans
Extra GPS
–scan#

The first 3 operations should normally be tested on most datasets. The
4th operation to Delete -scan# is a manufacturer specific issue with GSSI
equipment as a GPS track that is walked backward will create
decremented scan numbers in the log file which need to be eliminated.
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•

Delete Double GPS: This option will delete all consecutive GPS points
which are duplicated in the *.*.gps files. The reason for doing this is
that often many GPR/GPS data collections are not able to provide
quick enough unique GPS reading associated with the radar data.
Often the GPS logger will insert the identical GPS reading between
several adjacent readings. In one instance, a recent user of the
software was able to extract GPS readings for every individual record
radar scan. In this particular dataset, the GPS readings would not
change for upwards of 20-30 scans. In order to provide better dead
reckoning navigation between unique GPS readings, it is best remove
duplicate GPS readings and allow the software to interpolate time slice
data between points where unique GPS readings are available.

•

Delete Double Scan #: Normal operations of GPS will have a log file
one scan # associated with one GPS NMEA string. However, in the
instance with poor GPS or duplicate scan#s associated with multiple
GPS NMEA strings, it is critical that these points deleted from the
navigation files. A warning that GPS readings with duplicated scan
numbers will be launched in the Edit Info File menu when GPS log files
from the manufacturers are converted to GPR-SLICE log files.

•

Delete Extra GPS: An operation to remove GPS readings in the log file
with scan numbers listed that go beyond the number of scans in the
recorded radargrams

•

Delete -Scan#s:
A filtering option to remove GPS listings that
decrement in scan #s in the log file (specific to GSSI log files only)

Several other buttons can be used to remove extraneous GPS which are
errant in location and the buttons:
•
•

Delete Bad GPS
Delete Bad Elevation

•

Delete Bad GPS: In this option all GPS points in the *.*.gps files
which are further than the error (set in the GPS track menu) away
from the average GPS reading will be deleted. The auto-detection
in the algorithm will find these GPS points and delete them from the
*.*.gps files. The process will automatically update the *.*.gps
files.

98

99
•

Delete Bad Elev: Filtering of the GPS listings to remove elevations
which are completely in error.

There are other options to interpolate between bad GPS that was
removed. These options are discussed but are regularly used in the GPS
track filtering.
•

Interpolate Double GPS: Often double GPS points or more can be
found in some raw GPS logs do to a variety of reasons. Often the
double GPS points are discovered however the timing information in
the GPS log file is continuing to increment. Clicking this operation
will cause GPR-SLICE to discover the number of double GPS points
and to find where the first unique GPS point is discovered. GPRSLICE will then linearly interpolate the double GPS points to create
unique GPS readings.

•

Interpolate Bad GPS:
This option should be run in place of the
Delete Bad GPS operation. This function will search for all GPS
points which are the set error distance away from the average GPS
reading, and it will replace this point with an interpolated point
found between the two closest valid GPS points surrounding the bad
point. There is a possibility that many poor GPS readings are
significant in a file. A reasonable value of for the error setting may
have to be tried. Values can range from 1-.0000001 sometimes
depending on the data quality.

•

Interpolate Time GPS:
Interpolation of GPS fallouts can be
accomplished in time. In this operation, GPR-SLICE will read the
4th column of the *.*.gps files and extract the time of the GPS
reading. The GPS reading is converted to the total number of
seconds. If any adjacent GPS reading is currently is more than 1
second away, GPS values will be interpolated in between to make
estimated GPS reading every second. In order to properly use this
option, the user must make sure that the 4th column of their
*.*.gps file contains time written as “hh:mm:ss” with quotes
around the time (e.g. “06:55:32”). In later version of GPR-SLICE
UTC time with decimals is now being written for the generated GPS
files.

An error threshold setting was added to the GPS Track menu for
removing GPS data. The error threshold is set to a fractional percent of
the average UTM reading. For errors greater than the error threshold,
the GPS point is automatically removed. This setting in the Track menu
should not be used to try and remove points that are only a meter or so
99

100
away from its estimated position. The setting is for fallout where the
recorded readings are from corrupted navigation numbers that are
incorrectly recorded or from loss of satellites. In these instances, the
GPS fallout are usually numbers that are far away from the average UTM.
Note: After running any of the filtering operations, the information file
will be automatically updated to reflect the edited number of GPS listings
for each radargram. A Recover button in the GPS track menu can be used
undo all the GPS filtering operations from when the menu was launched.
Correcting navigation points manually in the GPS Track Menu
In the GPS track menu that are 2 ways to move or delete bad GPS
points. Using the Edit Track checkbox, right mouse clicks on a point will
delete that point. Left mouse clicks will move that nearest point on
clicking and then on releasing the left mouse button the GPS point will
move the point to the new locations. There are buttons in the GPS track
to highlight any give track and then points along that track can be
incremented/decrements and deleted or moved with the menu buttons.
Line+/-:
Point+/-:
X+/-:
Y+/-:

increment between GPS radargrams
identify a point along a GPS radargram
adjust the highlighted GPS point in the x direction
adjust the highlighted GPS point in the y direction
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Filtering/Smoothing of the Entire GPS Track

Filtering and smoothing and rewriting of the entire noisy GPS track
can be accomplished in the GPS Track Menu. The GPS track filter has 2
settings: the filter length is the number of GPS points on each side of the
local GPS point to take a moving average; the r/error setting is the
maximum error distance acceptable from the difference between the
averaged GPS reading and the local reading. If the threshold is breached,
the averaged GPS reading over the filter length will replace the local
reading. Several different levels of smoothing can be achieved depending
upon the settings. The filter works for either one track or in batch for
whatever number of GPS lines you have in the project information.
Several examples of a single GPS track filtered, as well as a multi-track
filter are shown in the next figures. The user should experiment with
different filter lengths and r/error settings. Longer lengths and small
r/error will provide larger smoothing - whereas reducing the length to a
few gps points on each side of the desired point, along with a larger
acceptable error will produce tracks with less smoothing.

101

102

The filter was designed so that the first N points at the beginning or at
the end of the GPS track are not filtered to preserve the original raw start
and end locations, as well as to only implement the filter when it is
completely over GPS data within the track. One can see that the filtered
GPS track has some original noise (preserved) at the beginning and
end. The current consensus is that it is good to preserve these first few
points at the beginning and end. This may change at a later date.
One can place a track jpg name in the menu and clicking the "Store
Track Map" will write the name of the desired map jpg as well as write a
single comprehensive GPS track file for all the radargrams in the
project with the extension ".txt" in the \raw\ folder. The main project
folder still contains the map.jpg of the track in case you do not want a
customized name.
Along with the options to move points around
individually which we detailed in a newsletter last year, the GPS/GPR
users now have global track filtering options available.
Note: Before leaving the GPS Track menu the user can recover all
filtering done to the GPS track files by clicking the "Recover" button. The
software will automatically update the GPS tracks to the filtered tracks
once you exit the GPS Track menu.

GPS Scan Lag Correction
In data collection with a GPS unit, there is the possibility of recording
delays between the GPS and GPR. The manifestation of this is that the
radar scan number associated with a GPS reading may be off by a
constant number of scans from its real location. For a survey that is
collected with a lot of forward and reverse GPS radargrams, the effect of
this scan lag can be very dramatic just as it is in regularly navigated
dataset. The effect of such a GPS scan lag or latency is shown in the
following diagram (courtesy of 3DGeophysics.com):
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The top diagram shows anomalies that look like they are hatched and
broken. In the bottom diagram is a corrected time slice. To correct for
the GPS scan lag, the user must use a setting in the Navigation menu
called Scan Lag.
The correction for this problem, assuming the
staggering is caused by a constant shift between the GPS reading and its
corresponding scan number, is to add/subtract a constant number of
scans to each associated GPS scan or trace #. The following example a
scan lag of -20 scans is applied to the GPS traces which corrects the
staggered image:
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Decimating the GPR/GPS track
An option to decimate the number of recorded GPS readings for any
given survey is available. There may be various reasons that decimating
the GPS record will provide better navigation.
Some GPS systems
currently can output GPS for every scan. However, in some cases the
GPS loggers are not really updating the position as quickly as it might be
outputting the log information. The net effect can be GPS readings that
are clustered in locations or are in identical locations. In addition, having
GPS readings on every scan, although this can be completely processed in
the software, can lead to overly large ASCII time slice that need to be
gridded. The reason is that if every scan has a navigation marker, then
every scan will also be included in the Slice/Resample operations where
the Cuts-per-Mark setting will require generating a time slice value on
every scan. Having 100 scans per meter or more would generate very
“thick” ASCII dataset which will require more time for gridding. A value
of 10 decimation can often be used with out loss of resolution for most
GPR/GPS surveys when the GPS data exists on every scan. Of course the
decimation should also be chosen based on the scan/GPS reading density.
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Note: For GPS readings collected on every scan, if it desired to process
these time slices just as they are, the bins per mark should be set to 1 –
one can not set it to any higher value since there is one time slice value
per scan
Resample in Range for total station or GPS fallout with survey
wheel engaged

A special button to resample a GPS track or a total station track when
fallout is present can be implemented. The Resample in Range button
reads the track and then will mathematically integrate the length along
the track to reset positions at the desired length. In the example in
Figure 1 the total station track was resampled at 0.5m. The requirement
of the operation is that the data was also collected equidistantly along the
ground (e.g. with a survey wheel). When fallout occurs with total station
(or GPS) multiple points can be recorded in the previous locations until
valid measurements are taken. The delete double GPS point option
should first be engaged so that the general track movement can be
mathematically integrated to give the most accurate resampling of the
track that is synced with scans.
This button became necessary for a
recent dataset collected with a multi-channel equipment in a city street in
Spain where buildings and obstructions caused the total station readings
not to be properly updated.
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Filtering of GPR time slices via GPS quality, NSat, HDOP
The 20 column GPS format now is used in all GPR/GPS operations in
GPR-SLICE v7.MT is useful for filtering of GPR time slices based on the
navigation precision. Three new additions to the GPS files over GPRSLICE v5.0 include: the GPS quality, N Satellites, and the HDOP. The
first 8 columns of the GPS navigation files used in GPR-SLICE v7.MT are:
eastings, northings, elev(m),”time”, scan #, GPSquality, Nsatellite, HDOP

This format became necessary in order to accommodate the use of GPS
quality, the number of satellites and the HDOP in filtering operations.
The GPS quality has 6 levels and these are
0
1
2
3
4
5

–
–
–
–
–
–

no fix
aGPS (autonomous)
dGPS (differential)
not defined
RTK-fixed
RTK-float

The GPS quality can change during recording based on changes to the
system being used. In GPS lingo, RTK fixed is actually a better quality
GPS fix then RTK float, however, the numbering system in the NMEA
string has RTK float as a larger number. During reads of the file, GPRSLICE will re-weight the levels to make RTK-fixed the best possible GPS
quality.
The number of satellites in the fix is also recorded in the NMEA string.
The fewer number of satellites can also be correlated with the precision of
the GPS navigation. The HDOP, called the horizontal dilution of precision
gives a measure of the fix resolution. Fractional values between 1-3 are
common for the HDOP, but values can be higher. The larger the HDOP,
the poorer the GPS fix is. All GPS NMEA strings contain this information
in the raw GPS logs for most manufacturers.
GPR/GPS track portions that do not meet a user defined setting for
GPS quality, N satellites, or HDOP be automatically removed from time
slice images.
Such operations are common with other 2D geophysical
tools that are being used in surveying. These options will help to make
the GPS track operations in the software more robust and provide the
user more controls and quality assurance in navigation and imaging.
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These options can be visualized in the GPS Track menu as well as in
the Slice/Resample operations. Shown in the following figure is an
example GPS track map with portions shown in black. In this dataset,
courtesy of the Indiana Geological Survey, we have the GPS quality set to
dGPS, N satellites to 4, and the HDOP to <= 3.2. If the user wants to see
just HDOP changes, then they can set the GPS quality to the lowest
setting (0-no fix) and also set N satellites to 0. Clicking the Redraw
button will refresh the GPS track map with the new settings.
In the following figure, the GPS track map showing portions of the
track in magenta that are lower in GPS quality, N satellites, and HDOP
then the desired setting the menu. One can delete those lower precision
GPS points (shown in magenta) by clicking the “delete precision” button.
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During Slice/Resample operations, the entire GPS track is processed,
however, at the creation of the XYZ ASCII time slices these settings are
used to filter and remove those portions of the GPS track that do not
meet the desired criteria. So in case the user wants to leave in the low
precision GPS points in the track data, they can alternately filter those
points just on compilation during time slice createion. The GPS quality,
N satellites and the HDOP settings will only show in the Slice/Resample
menu for GPS projects and will remain hidden for non-GPS projects.
An example of a filtered time slice based on the GPS quality, N
satellites and HDOP is shown in comparison with an unfiltered time slice:
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In this example of a GPS quality, N satellite and an HDOP filtered and
unfiltered times slice are compared.
Note: Some manufacturer’s GPS formats have removed information in
the NMEA string such as the number of satellites or the HDOP, etc. The
user may need to place artificial values in the for these in the GPS track
menu to insure that all the points are included in time slice analysis if
precision information is not available.

Manual Filtering of GPS Track
A set of buttons and settings to manually adjust any point along a GPS
track are available. With line+/- and the XY -+ buttons the user can
quickly scroll to any GPS profile and then move along any individual track
to get to a desired GPS point to adjust the location by making repeated
clicks on the X or Y +- buttons. The amount to move the GPS point can
be differentially set for forward and backward movements. An example
is shown in the following screen shot of the GPS Track menu:
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GPR/GPS Total Station Navigation
Total station navigated GPR surveys are possible with GPR-SLICE v7.MT.
For most manufacturer, they use the same format for GPS as the total
station format where the latitude and longitude of the survey are replaced
with the total station y and x values. This *.gps file looks identical to the
*.gps files generated for real GPS navigation – and the GPR-SLICE log
files are also the same 20 column format. For every manufacture, there
is a button with the manufacturers abbreviation followed “to nav” in the
Edit Info File menu. This button will instruct the software that the data
are total station and not GPS. An example of a Sensors and Software
total station dataset and generation of the GPR-SLICE log files is shown
along with the time slices.
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Clicking the SS to Nav button in the Edit Info File menu:

will generate the same standard GPR-SLICE *.dt1.gps file: total station
x, total station y, total station elevation, “time”, scan #. For total station,
fake values of the GPS quality, number of satellites and the hdop will be
inserted into the files.
The example total station GPR tracks for this
project are shown:
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The time slices for this total station GPR/GPS project are show below:
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GPS post processing from a Master.gps file

The GPS Track menu has specialized options to post process raw
uncorrected GPS tracks from a master gps track. This GPS survey will be
made from a single master GPS log file that is recorded simultaneously
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and which is later post processed to yield a corrected GPS track. GPRSLICE can merge the corrected master.gps track with the raw
uncorrected GPS tracks for each of the files in the project.
The
master.gps file should encompass the entire time that comprises the
individual GPS files. The button called GPS Post Proc (shown in the GPS
track screen shot) will read the uncorrected GPS track for each radargram
and will extract the corresponding location in the master.gps processed
track to extract the exact location. Linear interpolation is made between
the 2 bordering times in the master.gps to yield the best possible
corrected track.
The master.gps track will usually have been post
processed in alternate third party software such as Pathfinder before
being use to merge and correct with the individual profile tracks in GPRSLICE
Note: The master.gps is a single recorded GPS over the entire survey
time and is 4 columns with time, eastings, northings and elevation –
comma delimited, and should reside in the \raw\ folder of the project.

Flexible GPS/total station navigation file input read
Some users are developing their own GPS and total station navigation
formats which are not linked to the GPR manufacturer that they are
using. For this reason, a flexible navigation file input read was developed
for the Edit Info File menu. Using the XYZ to Nav button will launch
another menu where the user can set the number of lines to skip in the
header, file extension names, the columns for the x, y, and z of the data
as well as the scan number if it exists. An example of a RadarTeam
Cobra *.txt navigation file format, and how the flexible read can be used
to import this to the *.*.gps files for this manufacturer is shown in Figure
8. This flexible read can be applied to any kind of navigation, GPS, total
station or any user defined navigation. The only requirement is that the
navigation file for a radargram must have the exact same name other
than the defined file extension.
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Creating World Files (*.bpw) or Google Earth (kmz) files
Arc GIS world files or Google Earth kmz files can be automatically
generated in the Pixel Map menu.
The user needs to set the image
format (bmp is recommended) and then click the kmz file or world file
checkbox shown in the following menu image. When the kmz checkbox is
on the autoscaling will automatically turn on to custom. Also, the kmz
border checkbox available in the Options menu, a border of 140 pixes
around the output georeferenced images will be made to account for all
the labeling. The world files and Google Earth files are all written to the
\jpg\ folder of the project.
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4 Corner Lat/Lon/UTM for Georeferencing Local Grids
Another option to place local grids into a georeferenced grid by
setting the lat/long or the utm of each corner of the time slice is available
in the Pixel Map menu (Figure 7). The user must set in order the
southwest, southeast, northeast and northwest corners in decimal
lat/long or easting/northing. To generate Google Earth time slices the
BMP and KMZ checkbox are clicked on. The 4 corner georeferenced time
slices can also be generated in batch for all the time slices displayed to
the dialog. (Georeferencing is also available with the rotate/translate
option in the Grid menu; 4 corner designations are also available in the
Pixel 2D menu for large survey areas for multichannel license).
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OpenGL Volume Overlay of up to 6 Bitmaps including : Google
Earth Map / or other ArcGIS Geo-Referenced Images, Site Plan
Bitmaps, Topographic Bitmap etc
GPR-SLICE can simultaneously show up to 6 bitmaps in the OpenGL
Volume menu. These can be geo-referenced images, site map bitmaps,
alternate geophysical data, photos of walls in a room or just anything the
user wants to insert into the volume.
In addition, GPR-SLCE can
automatically retrieve and store a Google map bitmaps for GPS datasets.
An executable which is shelled out to call googmap.exe, will read the 3D
volume and center a Google map on the grid. The zoom level of can be
set before storing the map (shown in the following figure). A value of 18
for instance will give a typical distance of around 450 meters over the
image. The pixel size can be increased to values just slightly less than
the full native screen resolution of the display. If higher resolution is
needed choose a zoom level of 19-20 or use a denser display monitor. A
zoom level of 10-17 can be used to make a bitmap overlay that shows
more of the surrounding area at the site. To generate the sitemap.bmp,
simply close the Google Map dialog to store the bitmap to the main
project folder. Animations on top of the image or various other displays
are all possible. Several examples of what can be accomplished with the
new map overlay are shown:
•
•
•
•

Saitobaru National Burial Mound in Miyazaki, Japan
A GPS radargram from the Strawtown Archaeological Site ontop of
a Google map
A topographic sitemap bitmap from the Bungoohno Burial Mounds
in Oita Prefecture Japan
And an example of a Google map with several other bmp included

In the BMP Overlay menu, the depth of the sitemap.bmp can be
adjusted in the import menu to place the google map on the top, on the
bottom or anywhere vertically. Time slices below the image depth will
be masked as will displayed radargrams.
The transparency slider bar
can be used to look through the sitemap.bmp.
In this example UTM
coordinates are used, but bitmaps of site plans with local grid coordinates
can also be used or any localized bmp – it does not have to be a map!
The Z scan time slice can be animated on top of the geo-referenced
bitmaps. To do this it is best to set a small transparency on the slider
bar and then to look directly down on the Z plane using the 2D – Z, X, Y
(off) button in menu.
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Note: For retrieving a Google map does require an internet connection, so
it is best to download your desired images before going to a remote field
site. The Google map dialog should not be maximized and the default
dialog size should be left stationary. Zoom levels should be set before
launching the Google maps bitmap storage.

120

121

121

122

Augmented displays in OpenGL
Augmented displays from a ground surface site map or Google Earth
map is available in OpenGL. In the BMP Image menu launch a new
checkbox is available called virtual 1 or virtual 2. With virtual 1 checked
on, the active overlay bitmap will automatically be placed on the ground
surface (top of the volume) and the XY start/end rectangular volume will
be opened for viewing the data "below" the ground surface. The new
option can also be viewed with object or utility drawings.
With virtual 2
engaged the outline of the surveyed areas and any null data will be
removed from the overlay bitmap to just show the bitmap where data
exists.
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Adjusting for GPS Antenna and GPR Antenna Offsets
In the GPS Plot menu the navigation files can be adjusted to account
for the X and/or Y offset between the GPS antenna and the GPR antenna.
The offset correction is dependent on the direction of the antenna. The
direction is estimated by looking at the two nearest surrounding points
and then using this to determine the angle and direction of the GPR
antenna with respect to the GPS antenna. The projections of the knownfixed offset of the GPS antenna and the GPR antenna into eastings and
northings values are then adjusted to the *.*.GPS Files. Clicking the XY
Offset button will apply the offset correction and display the corrected
GPS track (in a cyan color – the original track is shown in dark blue). To
store these changes the user should click the Save button. If the user
wants to recover any change from the beginning of a session, there is a
convenient Recover button located in the GPS Track Menu.
There is also an Info Offset button which will read the specific set
offsets in the information file for each radargrams and apply to the GPS
track. The offsets can be set different for every line collected on the site!

Note: For XY offset calculations the trend of the GPS track needs to be
calculated. The setting Npts Traj in the GPS track menu tells how many
GPS points on each side of the track will be used from the point on the
track to determing the trend of the GPS unit. Usually a setting of 1 meanin 1 point on each side of the local point is used to determine the
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GPS orientation wrt to the GPR antenna. Using a larger Npts Traj value
can help to smooth out small pertubations in the GPS unit trend and
better position the antenna when the offset (coordinate rotation is being
made).
Note: For all operation - the Del Double GPS, Del Bad GPS, Intp Bad
GPS, Intp Double GPS, and the Intp Time GPS operations will
automatically update the *.*.GPS files. If however, the Recover button is
clicked the original *.*.GPS files will be imported back.
XY Offsets
need to have the user click the SAVE button to update the new
updated track.

Conversion of WGS84 lat long to British National Grid OSGB36
using the OSTN36 lookup tables + Non WGS84 coordinate systems
For those users in the United Kingdom we now provide conversion for
the more accurate British National Grid using the OSTN15 lookup tables.
Our earlier conversion had the Helmert transformation which would get
one fairly close to their location but could be off 1-5 meters depending
the district surveyed. The new option requires a new dynamic link library
that also contains 4 different *.dat files for performing the coordinate
conversion from WGS84 to OSGB36. Interestingly enough, the OSTN15
tables have corrections for seafloor spreading and other phenomena.
Several other coordinate transformations provided for such as Irish
National Grid, etc are also now all executed in the GPS Track menu.
GPR-SLICE will store WGS84 coordinates upon conversion so that Google
Earth maps and sitemaps can be exported and retrieved in OpenGL. The
conversion menu is a one-way operation and you can not go backwards
to WGS84. Should one need these original coordinates they will need to
recreate those in the Edit Info File menu
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Operations for conversion of WGS84 to British National Grid or other
available (limited) coordinate systems
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IX. Plot Options Overview

The Plot Options menu is available on the GPR-SLICE taskbar and is
used to conveniently control all graphic displays of time slices, 3D
volumes and radargrams. In this submenu the user can either set output
for automatic labeling or they can manually adjust all labeling on graphic
displays, as well as assign color tables, font sizes etc.
In the Plot
Options menus controls are available for:
• setting GPS tracks overlay displays on or off on 2D time slices
• contour line controls for 2D time slices
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• font sizes/colors/background colours for all 2D graphic menus as
well as Open GL menus
• absolute or relative elevation labeling displays when topographic
corrected or topography warped displays are engaged
• depth + time axis labeling for radargrams and Open GL menus and
• reads velocity profiles and assigns corresponding variable depth
labeling on radargrams and Open GL display
• polar labeling options for tunnels and cylindrically adjusted
radargrams
• assigning color tables for time slices, 3D volumes, isosurfaces and
horizon surfaces
• setting 2 sided or 4 sided labeling of time slices
• shutting on/off user inserted markers display on survey wheel or
alternately navigated radargrams
• sets a 2nd depth label for horizon detection displays in the Static
menu
GPR-SLICE presently has 50 different color tables which are
preliminary color tables – the user is encouraged to create their own color
tables which will best fit their needs as well as for matching their
particular default printer. The color tables can be viewed by clicking on
the Edit button in the Options Menu. GPR-SLICE uses a color palette,
which is composed of 256 different colors. The color tables can be edited
and stored to new color table numbers. The Edit Menu works by the user
first clicking on a color, and then inserting that color into the palette
graph. After several locations are filled in, the user can then click the
“interpolate’” button which will create a continuous color table between
the inserted colors.
The interpolation is a simple linear interpolation
between the hue, whiteness and saturation between each color chosen.
Shown in the example on the next page is the color table. The user
has clicked on several colors and placed them in the palette locations,
which are shown as thin narrow lines. Clicking the “interpolate” button
then made a continuous gradation of colors between the inserted colors.
By clicking the “save table #”, the user can stored a color table, in this
case to table #21. By clicking the “replicate” button, a step-wise color
table, with color values being identical till the next inserted color is found
will be generated. This option is useful if the user wants to use say only
16 colors across the possible 256 color table.
The user can import a palette from the 50 different color tables by
clicking through the import + or import – switches provided in the menu.
The imported palette will appear on the top palette location. The user
can also change the hue, saturation and whiteness for any of the palette
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imported or for the master palette. The actual values for the hue,
saturation or whiteness in the range of 0-255 can be inputted in the
menu by the user. Slider bars allow the user to generate any conceivable
RGB color combination. Once a color is generated, clicking on the color
box with the box will store that color which can then be dropped onto the
color palette graph.
An external bitmap or color table bitmap can also be imported and
colors can be chosen via the mouse and inserted into the palette
development bar for complete color table interpolation (an example is
shown in the next menu screen shot).
Note: The user should make sure to place a color at the beginning and
end location within the palette to interpolate or replicate. The user can
remove a chosen color within the working palette by hitting the right
mouse button over the chosen color. In this case when the user wants to
create a replicated or stepped color palette, the last color chosen should
also be placed at the color position 255 and also at some lesser location
e.g. 240, and then the replicate switch should be clicked. This will cause
the last color chosen to be replicated from position 240 to 255.
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Render Colors
The color table to be used to display 3D volumetric renders. Currently a
convenient color located at color table #41 is provided. The shading of
this color table may or may not be sufficient for some computers and may
greatly differ even more after output to a printer is done. The user
should create their own ‘shadow’ color table which will best show light
reflecting off the 3D slope renders that they will be creating.
Note: An option to reverse the displayed color tables is available in the
Options Menu. The user should be careful about this switch and not
forget to turn it off after they have created their output maps.
Inherently forgetting about this switch could cause the user to reverse
their subsurface interpretations as well since weak reflectors would show
strong colors and strong reflectors would show weak colors.

Plot Labeling
Complete automatic labels for all graphic output are available. The user
can display the range information using either: cm, m, km, in, ft, yd, mi.
Tick marks, big tick marks, and the frequency of axis labels can be set in
the Options Menu. A checkbox for overlaying a square grid lines over the
maps can be turned on. The frequency of the grid lines follows the big
tick mark frequency for 2D time slices. Gridlines option will also turn on
a background for 3D isosurface displays.
For multi-plot time slice screens, the user may want to turn off all the
labeling and just have it on the very last pixel map to make the screen
‘less busy’ looking. In this case the user can set the label frequency to -1
to accomplish writing range labels only on the last plot. The number of
decimals to display for range and time/depth labels can also be adjusted.
A north arrow can also be plotted on the screen for time slices.
Contour Overlays
Several options for display of contour line overlays are available:
transform, linear, custom, only, off. For pixel overlays, a basic contour
map is overdrawn on top of the color pixel map. For a transform setting
engaged for contour overlays, the contours lines will follow the unique
data/color transform being used to display the individual time slice. For a
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linear setting, the contours separation will follow constant offsets between
contour lines. Custom is for the user explicitly setting the contours to be
shown. Contours are normalized between 256. For no contours, the “off”
setting is clicked on. The number of contours to draw can be set in the
menu.

Radargram Menus: Overview
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2D Radargrams
In the 2D Radargram menu, which can be launched at the Radar icon
on the main menu, the user can
•
•
•

create multi-radargram displays with any number or combinations
of radargrams drawn to the screen and that will appear in a single
dialog and from different processed folder combinations
launch the XYpoints dialog to choose anomalies across any
radargrams drawn to the screen
create 2d animations

To show the most customizable options in the 2D radargram menu, an
example screen shot in which the user is displaying radargrams #2, 10
and 19 from the information file is shown. These radargrams are checked
on while all the other radargrams are checked off. There is an easy
on/off button to check on all or check off all of the radargrams. Using the
customizable size option, the exact length and width of the radargram
plots in pixels is set (to 500 and 200 respectively). The radargrams plots
that are drawn to the screen will be shifted 550 pixels in x and 255 pixels
in y between adjacent radargrams. For this example, the user sets the
total number of radargram to 20 and the number of rows to 3, which
when drawn will show 3 radargrams drawn in column. In this example
because 3 radargrams are clicked on and 3 rows are set, there is no
opportunity for any x shifting of the radargrams. If in this example 2
rows were set, the 3rd radargram would be drawn to the right of the top
radargram, 550 pixels from the first radargrams origin.
In the radargram menu, some regaining of radargrams for graphic
display can be done several ways.
An overall gain factor, linear gain
with depth, and an exponential gain with depth, can be applied to the
display of the radargrams. The total gain, to a radargram scan is
total gain = (gain)*(1+irange*rlgain)+exp(irange*expgain)
where

gain
= overall gain factor
rlgain = linear gain factor
expgain = exponential gain factor
irange = (i-1)/(n-1), i=1 to n
n
= number of samples/scan

By setting the linear gain factor to 0, essentially shuts off linear
gaining across scan depth of the radargram. Setting the exponential
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factor will exponentially increase/decrease the gain with time/depth in a
radargrams.
(See 7.12 for the equation controlling gain with
time/depth). For example, setting the exponential gain to 2 will increase
the relative gain progressively with the value of bottom reflector gained
by e^2 (where e is the natural logarithm, 2.7818) compared to the top
reflector. Normally, if the user has converted their radargrams with gain,
they will not apply a regaining factor here, and will just keep the gain set
to 1 and the other linear and exponential gain set to 0.

Radargram Transform Control Menu
Adjusting transforms on 2D radargram displays has been improved
and follows similar operations available in the Pixel Map menu. After a
2D radargram display is drawn, the user can click on the graphic and the
Radargram Transform Controls menu will launch. The user can set lo-cut
and hi-cut threshold bars which are always active. An example of the
same radargram using different transform curves is shown in Figure 9.
Should a different set of radargrams be inserted, the transform controls
will normally need to be adjusted as this information is not stored in the
radargrams but is a separate generic file containing the transform and
colorization information.
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Radargrams can be displayed in either color scan, line, line with
negative pulse filled, line with positive pulses filled, line with +/- pulses
filled, or a color line mode The user can adjust the amplitude of the
wiggle traces by changing the overall gain factor in the menu. Usually a
low gain factor value like .1 or .05 is necessary to get the pulses to scale
properly. Wiggle trace displays normally require skipping N number of
scans to see individual traces more clearly, as shown in the following
screen shot:
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GPR-SLICE will automatically compute optimal plot size lengths to
show multiple radargrams on one computer screen. Custom settings can
also be made the will draw radargrams beyond the computer screen.
Scroll bars will appear for these displays.
Two settings for controlling the screen outputs are available: Last or
All. Checking the Last switch will cause a screen dump to be written only
after the last radargram is outputted to the screen. The file will have the
filename prefix given by the Screen Dump identifier setting.

Concatenating 2 or More Broken Radargrams
The Radar menu is capable of showing 2 more radargrams collected
along the same transect with different starting and stopping locations, in
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the same radargram display. Often in GPR surveys obstructions along a
line may require several broken line segments to be recorded. These line
segments can all be shown in the same graphic screen if the following are
done:
1) Use the Sort X or Sort Y buttons provided in the Edit Info File menu to
insure that the broken files are consecutively placed in the information
file.
2) Check on the Concatenate checkbox in the Options menu to tell the
Radar display to show broken consecutive files on the same graphic
display.
3) In the Radar menu, set the Range Start/End values to be inclusive of
the entire start and end ranges.
An example of 3 broken files along the same line are concatenated and
shown with a single complete radargram:
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2D GPS Radargram
GPS radargrams can be displayed in the 2D Radargram menu (see
the following figure). The user does not explicitly set the x and y starting
and ending values in terms of eastings and northings. In this menu the
user sets the number of GPS listings given in the information file. For
example, let’s say a GPS radargram has 200 listings (or 200 seconds) of
data. The user can then say set the range start to 0 and the range end to
19. The 2D GPR radargram will display from the beginning up to the 19th
GPS reading. The way GPR-SLICE works here is that every radar scan
that has an associated GPS reading is tagged (in the 2nd sample of the
scan – as is any kind of radargram is GPS or otherwise in GPR-SLICE).
The 2D GPS radargram will display the radargram up to number of GPS
readings desired as set by the range start and range end values in the
menu (see the following diagram).
The eastings and northings values
are conveniently written as labels on the displays of 2D GPS radargrams.
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GPS Full Scale, Equidistant Scale, 1scan-1pixel Scale,
GPS Constat Scan Scale

GPR-SLICE now has new options for multi- GPS radargram displays.
There are 4 choices called GPS full scale, GPS equidistant scale, GPS 1scan 1-pixel scale and GPS constant scan. GPR full scale will show GPS
radargams completely across the desired width of the graphic pixel length
chosen. If some radargrams have very few GPS readings or more scans,
regardless of the differences, each radargram plot will be shown with the
same horizontal graphic scale.
If GPS equidistant scale is chosen, the
radargram will be scaled by how many GPS readings there are for each
radargram and the GPS start and GPS end settings on the Radar 2D
menu. This display will help to better show the relative sizes of features
with the same number of GPS points per horizontal length. The option
GPS 1-scan 1-pixel scale will show one scan per pixel.
This display is
equivalent to the GPS equidistant scale option but will display whatever
number of scans there on each radargram horizontally.
For some
graphic cards, there could be a limit and probably radargrams with more
than 50k scans should not be used. If radargram with more than this,
the GPS 1-scan 1-pixel option can be used alternatively with the Segment
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option to show vertical columns of the same radargrams made in
segments.
The GPS constant scan labeling will place GPS labels at equidistant
scans irrespective of the distance between markers. These displays will
cosmetically look nicer on 2D GPS displays.
Additionally, a new scan
scale is also available to be shown on the top of the radargram. This
option can be used for regular or GPS profile displays.

Option menu showing locations where to engaged constant GPS scan
labels and to show the scan scale on top of the profiles.
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Segment Option to Show Consecutive Portions - Long
Radargrams Displays
It is possible in GPR-SLICE to automatically show consecutive
segments of a long radargram on a multi-radargram display. Using the
Segment button as seen in the following figure for example, 6
consecutive segments of a GPS radargram are displayed to screen. This
is very a effective display options for showing long radargrams or portions
of a radargram on a single screen. Although the example shown is for a
GPS radargram, this option is also available for regular surveys as well.
For GPS radargrams, the range start and range end values correspond to
total number of GPS readings to include in each separately display
radargram segment that is drawn to the screen.
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Parsing of long GPS radargrams
An option to break up a long GPS radargram into smaller GPS
radargrams is available in the Radar Edit menu. The user will set the
number of GPS points to parse the profile. Clicking the Parse GPS Profiles
button will make radargrams which have N GPS points each. The last
profile will contain the remainder GPS points. For an example, a
radargram with 330 initial GPS points is broken up into segments that are
100 GPS points long. A total of 4 GPS profiles are generated with 3 being
100 GPS listings and the last having 30 GPS listings. The segmented GPS
radargrams are all shown to be along a continuous track in the 3D
display. Breaking up long GPS profiles is not a requirement for processing
but it is available for those that may want to deal with shorter segments.

Location of the new option to parse a long GPS profile into independent
profiles with N GPS points each. The option can also be run in batch on
an entire list of profiles within the information file.
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An example of a GPS profile with 330 GPS points and is parsed into 100
GPS point sections generating 4 profiles – 3 with 100 GPS point and the
last with 30 GPS points.
The 4 parsed profiles display seamlessly in
OpenGL.
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Radargram Cylinder Warp (Binary Corrected - Non-Vector Method)
Cylinder warping of radargrams can be done to have radargrams
emulate profiles collected over cylindrical objects. One method describes
how to do this by actually creating a new binary radargrams that is
warped and written into it cylindrical shape. (Another menu for tackling
the same problem but graphically – without actually writing a new
radargram – is discussed in the Vector Imaging section of this manual).
The angle start and end values (see the following figure) are will wrap the
radargrams over and angle across the cylinder. Once the process is
completed, the cylindrical warped radargrams will be written to the \topo\
folder in the project. Automatically a message box will appear at the end
of the warping process which will indicate that a new information file
appended with the name “cylinder” was written

Cylindrically warped radargrams will have a new samples/scan that is
twice the original radargram. Thus in the example, the new scan length
143

144
of the warped radargrams is 2*(number of samples/scan – 0 ns offset).
In the example shown, the new samples/scan of 370 is written into an
information file called info-cylinder.dat.
To display the warped
radargram, the user must first make this information file active in the Edit
Info File menu. The next step is then to go to the 2D Radargram menu
and display radargrams in the \topo\ folder.

Radargram Tunnel Warping
Tunnel warping from a survey made on the inside or from the outside
of the tunnel can be implemented. The user can also set the starting
and ending sample values within the radargram to warp. A separate
menu called radargram cylinder warping is also available from the main
pull down menu. This menu is similar to the tunnel warping when the
inside radius of the tunnel is set to 0.
When the warping process is complete a message box will appear that
will indicate the name of an automatically created information file to
describe the warped radargrams. Tunnel warped radargrams will have an
information file appended with the word “tunnel”. Warped radargrams
have a new scan length associated with the radargram. The new tunnel
scan length for the radargrams is 2*(sample end - sample start + inside
radius in samples). This is written to a new information appended with
the word “tunnel”. The warped radargrams are written to the \topo\
folder. One will need to make the tunnel info file active in order to
properly display the tunnel warped radargrams.
In the example shown the tunnel warping was implemented from the
inside. Thus the ground surface reflection can be identified as the strong
reflection on the inside of the tunnel. If the tunnel warping – outside
button were pressed, the radargram warping will be generated assuming
the antenna is on the outside of the tunnel.
Shown in the next menu screenshot is the menu for radial tunnel
warping of radargrams where the survey was made from the inside of the
tunnel. A button for project the radargrams from the top of the tunnel
can also be generated using the Tunnel Warping Outside button. The
tunnel was surveyed from angle -60 to 240 as an example. The radial
warped radargrams are written to the \topo\ folder and can be displayed
from the \topo\ folder using the newly generated info-tunnel.dat file
containing the new samples/scan for the warped radargram.
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Tunnel warped radargrams can be displayed in the Open GL 3D Radar
menu as shown in the next menu screenshot:
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For re-display of the binary corrected - tunnel warped radargrams, there
is an option to set a flag in the option menu to generate polar labeling for
the 2D Radar menu. An example of a multi-radargram display using the
Radar menu is shown in the following screenshot:
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Split Screen: Radargram-Time Slice

A very useful feature that is similar to the split screen option in the
Pixel map menu is the radar to time slice split screen feature. In this
operation, the users will normally first set the desired display of a single
radargram as well set the display of a series of time slices in the 2D Pixel
menu. Then, entering the Split Screen: radargram-time slice pulldown
menu option (see the following figure), the user can click on any
radargram anomaly and have the corresponding feature be identified
within a series time slice map.
The time slice maps will appear
automatically once the radargram is clicked on with the bulls-eye. The
split screen option will read the appropriate time window on the
radargram and discover which single time slice in a series of time slice
drawn to the screen contains the corresponding reflection time of the
chosen anomaly. If the user has not drawn the full series of the time
slices to the screen, the bulls-eye may not appear since the search
algorithm will be unable to find a time slice with a corresponding depth.
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Storing Anomaly Locations on Radargrams – XYPoints Option
An option to choose anomalies on the radargrams with the mouse and
store the locations of these anomalies is available. To launch the option
the user simply right clicks the mouse over any radargram or multiradargram display. Then, using the left mouse button the user can store
anomaly points which are also written to a real time dialog to the screen.
A comment can be inserted in the on-line dialog which is also written into
a file called XYPOINTS.dat file on exiting the menu. On launching
the XYPOINTS option again, the user has the option to either append to
the current XYPOINTS.dat file or to start a new file. The process
also tracks multiple radargrams written to the screen so the user can click
on any radargram and store points in any sequence. All the anomaly
information is written to the XYPOINTS.dat file which is located in the
main project folder.
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An example of XYPOINTS option for storing mouse clicks over a multiradargram display is shown in the following screenshot:

XYPoints in 2D Radar Menu for OpenGL Volume import
XYPoints operations have been in GPR-SLICE for quite some time.
These operations have now been extended to allow the user to pick pipes
on the 2D radargrams and have these imported to 3D pipes displays in
OpenGL Volume Draw. The operations to export are:
1) Enter the Radar 2D menu and display the desired radargrams (Figure
1)
2) Right click the mouse on the graphic to start the XYPoints anomaly
menu
3) Left click the mouse on the first detected pipe across the various
radargrams, picking in incremental spatial order
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4) In the comment section of the XYPoints dialog type: pipe, radius,
color # - everything must be comma delimited. For drawing points that
will get imported into OpenGL Volume Draw rather than pipes, the
comment section should be assigned as: sphere, radius, color #
(Figure 1).
5) Enter the OpenGL Volume Draw menu and click XYPoints button
(Figure 2)

After step 5 the drawn points will be transformed into 3D pipes or point
sections. If any editing is desired the user can either re-enter the Radar
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2D menu for appending and adjusting the XYPoints file. Drawn sections
can also be removed in OpenGL by using the section and delete
buttons.
Currently, the XYPoints option can also accept 3D points which can be
imported into OpenGL Volume Draw. For this operation the user types in
sphere, radius, color# into the comment space. This only needs to be
typed in one time at the start of the first feature and then all other clicked
points can be left blank in the comment section.

GPS track sync with XY points operations
For XY points operations for GPS surveys, an option to sync the
chosen points on the radargrams with the GPS track location can be
launched. To launch this capability, one simply right clicks the mouse on
the radargram 2D display and the software will bring up the XYPoints
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dialog. Clicking on the “sync GPS plot” checkbox will open the GPS track
menu in its own dialog. Choosing any anomaly on any radargram in the
Radar 2D display will show the corresponding location of that anomaly on
the GPS track. The example shown below was generated from a single
GPS track survey and using the Segment option in the Radar 2D menu to
show portions of a single radargram in consecutive column displays.
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Radargram Editing

Radargram Editing has essential functions to:
•
•
•
•
•

detect time 0ns on radargrams and to automatically correct them
- scan-by-scan
- line-by-line
crop the radargram following a defined start and end samples on
the digitization of the pulse
crop the radargram from a defined start scan and end scan
resample the digitization on the radargram pulse
truncate to the first horizon defined in the Horizon Detection and
Mapping menu
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At the end of processing all the radargrams a new information file
called infoedit.dat will be automatically created which contains the new
samples/scan for the edited radargrams. The time window will also be
automatically adjusted in the infoedit.dat file. The edited radargrams are
written to the project \edit\ folder.
Complete descriptions of all the radargram editing operations are
discussed.
Time 0ns Auto-detection and Radargram Truncation
An option to detect the sample number for each individual scan where
the time 0 ns is located is available in the Radargram Editing menu. With
this process in GPR-SLICE, the user can automatically detect the 0 ns
scan-by-scan across each pulse or define time 0ns by the average
detection using the line-by-line operation across the entire radargram.
The software will truncate the radargram and generate a new radargram
with the variable 0ns offset truncated across the entire radargram. This
operation will run in batch.
One might ask why one would want to detect the 0ns scan-by-scan as
opposed to just finding the average or median time 0ns? Well, there are
some datasets, where the 0ns drift occurs dramatically within the
radargram profile. This situation can occur with any equipment that
undergoes some kind of electronic drift/noise.
An example dataset
where the time 0ns is variable is shown in the following:
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The 0ns offset in the top left radargram shifts by about 3ns suddenly
near the 10 meter range. The other radargrams also shows significant
changes in the 0ns offset between different lines.
Making time slices of
0ns offset uncorrected radargrams will produce inconsistent and noisy
time slices which will appear to have apparent mosaic, striping and other
problems, in addition to not showing reflections at equal depth across the
site.
Clicking the button 0ns Scan-by-Scan+Truncate will start the process
to detect the variable time 0ns location and correct for it. The process
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works by looking at a threshold change on the signal prior to the pulse
rising. Several options for detecting the 0ns position have been added to
the Radargram Editing menu.
The user can choose between 3 methods for defining the ground
surface reflection:
1. Breach of a defined threshold on the initial pulse
2. Detection of the first peak response – negative or positive – located
past the set threshold
3. Detection of the first 0 crossing after threshold breach
For all the methods, the user can set a number of samples from the
threshold breach or the peak detection level to back up the 0ns setting.
For instance, a setting of 0.2 for the threshold and 4 for the backup
Nsamp item will find the first sample where 20% maximum of the peak of
the pulse is breached and then will back up the 0ns setting to 4 samples
earlier than this.
After the operation, a message box will relay the smallest and the
largest 0ns offset across the entire set of radargrams first.
This
information is needed prior to adjusting and truncating a new set of
radargrams with a new sample length. For instance, in this dataset, the
minimum and maximum sample positions detected are the 26th and 44th
sample. When the process of radargram editing/truncation is finished, a
new set of radargrams will be written to the \work\ folder containing
radargrams which have the 0ns adjustment for each scan, and total scan
length of (N sample – 44). A new information file called infoedit.dat will
be written. To continue the data processing, the infoedit.dat file should
be highlighted in the Edit Info File menu to make it the active information
file.
Note: The radargram editing for 0ns offset, requires one to convert the
radargram with NO range gain curve set - e.g. all the gain points set to 1
- as one must correct for differing time 0 before adding range gain!!
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Similar operations are done for line-by-line 0ns detection. In this
operation, the average 0ns offset across each individual line is first
calculated and this is used to make the adjustment.
Note: Line-by-line operations for time 0ns radargram editing should
normally be used over scan-by-scan operations in the case when the time
0ns offsets are not changing across the individual radargrams. Line-byline will compute the median time 0ns correction and insure that small
vertical perturbations from pulse truncation on noisy radargrams before
the ground wave do not infiltrate the edited radargrams.
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Truncate Horizon#1 from Horizon Detection and Mapping Menu
The button, truncate horizon1, allows the user to truncate the
radargram to the first horizon defined in the Horizon Detection and
Mapping menu.
The first horizon in this menu can be automatically
detected as well as edited or manually drawn by the user with the mouse
to define time 0ns across the radargrams. The horizons are written as
*.hz1 files for each radargram in the project. The operation Truncate
Horizon1 will read these time 0ns profile written for each scan and will
truncate the radargrams to these sample numbers.
Removing the ground surface reflection that has a varying position per
scan has been available in the Radar Editing menu. The scan-by-scan
truncate option is usually applied for this operation. The scan-by-scan
operation looks at a threshold on the scan and will trigger a detection.
Sometimes, this simplified methodology does not work very well on very
noisy datasets and a more advanced methodology is needed to define the
time 0 location.
For this reason, the options available in the Horizon
Detection and Mapping menu are now available for importing the defined
horizon #1 for truncating the radargrams. This menu allows detection of
the peak+ or peak- of the pulse as well as having options to engage a
filter on the detection. For radargrams where the time 0 is quite variable
and not easily defined, the user can also manual adjust the detected
horizon#1 with mouse drawing options. Once the horizon#1 is defined
or auto detected in the menu, this horizon is then available for truncating
in the Radar Editing menu. An example of the location and settings for
this new operation for time 0 or truncation to any desired horizon is
shown:
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Displaying User Inserted Marks on Survey Wheel Radargrams
Often in GPR survey collected with a survey wheel, the user may
want to mark locations on the radargram with additional user-inserted
marks.
GPR-SLICE is able to display these additional marks. The
settings necessary to get the Radargram menu to display these are marks
are 1) negative big tick frequency in the Option menu, 2) User Marks
checked on in the Option menu, and 3) choosing the \radar\ folder for
display.

KMZ 2D radargram popup in Google Earth
A new option was added to the Radar 2D menu at the request of
a subscriber that wanted to deliver a KMZ image of a flat 2D
radargram on a site to their customer. The radargram shown of
course would not be a georeferenced radargram as the file can be a
GPS random profile, but the user wanted to be able to show the 2D
radargram profile and a link of the beginning of the line on the site.
An option was added to allow one to create all the popup radargrams
images in batch that will open in Google Earth. In the Radar 2D
menu one will first click the BMP checkbox, followed by the KMZ
checkbox and then the number of radargrams to display and their
pixel sizes. The naming convention of the kmz files will follow exactly
the radargram names with the .kmz extension. For those not familiar
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with the KMZ popup option, one must click on the yellow pin in
Google Earth to see the attached image (Figure 6). The size of the
radargram image will follow the pixel length settings set in the Radar
2D menu.

Settings in the Radar 2D menu needed to create KMZ popup
radargrams. KMZ popup files can be generated in batch.
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Example of a KMZ popup 2D radargram in Google Earth. The user must click
on the yellow pin to see the associated image appear.
Note: These projections are simple 2D radargram images. One always has
the ability to make GPS radargram animations with a Google Earth image
(or imported World File image) and show the random GPS tracks profiles
ontop of a georeferenced map inside OpenGL (screen shot 4). The
complete animation menu can be exported and given to a client without
the need of the USB security key, as the exported Animation menu is
unprotected and can be freely transferred.

Radar 2D menu option to show up to 3 information file which can
have different samples/scan and time windows
At the request of several users asking to look at dual frequency and triple
frequency radargrams in the same graphic dialog, a new menu called
2D+2D+2D Radargrams was developed (Figure 2). This menu will allow
displays of up to 3 different info files describing radargrams all of which
can have different time windows and samples scan.
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Example of a US Radar triple frequency dataset where all the different
channels with different processing, time windows or digitization are
displayed in the 2d+2d+2d Radargrams menu.

Basic drawing functions on multi-display radargrams via XYpoints
After receiving multiple requests for drawing capabilities on
radargrams, we placed in some very basic drawing capabilities. Launching
the XYpoints menu, and then choosing the line checkbox, one can begin
drawing lines on any radargram in the multi-radargram display. To end a
line and start another line, one simply toggles the line checkbox off/on
again to start a new line. Shutting off the line checkbox completely gives
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the traditional look of just showing the chosen points in the XYpoints
dialog on top of the radargrams. One can chose a color for each drawn
line as well as the line thickness which can vary from 1-100. With the
dots checkbox highlighted and the line checkbox off, the user can draw
dots on the profiles. Clicking the Save button is necessary to keep all the
drawn objects and update the XYpoints.dat file. The drawings can be
retrieved as all the drawing information resides in the XYpoints
information file and resized if needed.

Examples of using the XY points menus to perform basic line drawings on
the radargrams. Individual line thicknesses and point number displays can
be included in the drawings.
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FILTERING Menu: Overview

Radargram processing prior to slicing analysis can be done within this
menu.
GPR-SLICE version 7.0 currently provides for the following
radargram signal process:
•
•
•
•
•
•
•
•
•
•
•

background removal
Kirchoff migration and diffractions stack migration
Hilbert transform
boxcar smoothing
regain
bandpass filtering
spectral whitening
cepstrum deconvolution
spectral deconvolution
spiking deconvolution
fk filtering
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Background Removal
Probably the most commonly used filter on GPR data is the
background removal filter. The background removal filter is essentially a
process where the average scan across a radargram is subtracted from
each individual trace within the radargram.
The background filter is
used to remove banding noises that are seen across the radargrams.
Shown in the diagram on the next page is an example of a raw radargram
with the background removed. In the background filtering the user has
the option to apply the operation over a sample start and sample end.
Three kinds of background filtering can be implemented:
1. line-by-line - the average scan on each individual radargrams is
computed over the filter lengths and subtracted from the center of
the filter
2. grid-by-grid - the average scan over the entire grid and inclusive of
all the radargrams in the project is computed and subtracted from
each radargram
The user can set the length that the filter operates over for line-byline background filtering. Normally, the filter length should be set to a
number much larger than the total number of scans in the radargram.
One can simply place an artificially large number, e.g. 20000 in the filter
length menu slot. This will insure that the same average scan across the
radargram is subtracted from every scan. Using a value less than the
total number of scan in the radargram will apply a background filter that
subtracts a local average. There could be situations where a filter length
less than the total number of scans in the radargram may be useful in
simple 2D mapping of structures, by removing local averages along the
radargram.
Background filtering has an automatic option to set the
filter length to an artificially high value, e.g. 99000 prior to running the
filter. With the auto set checkbox engaged, the background filter will
automatically compute the average scan across the whole radargram.
For customized filter lengths, the auto set checkbox can be unclicked and
edited as desired. In the past, some users neglected to adjust the default
filter length on new projects and this new auto set option will negate the
need to manually place in a large filter length for computing the average
scan.
Note 1: Background filters are applied too often automatically without
much thought being given to its effect on data. The background removal
filter will take out the banding noises but it can also take out what
appears to be banding noises, but are actually strong linear reflection that
are parallel to the radargrams track. If a buried pipe were parallel to the
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antenna track over the ground, background removal would eliminate this
overall strong reflection recorded from the pipe. Background filters
remove banding noise and real reflections that are along the profile track.

Note 2: It is best to always compute time slices from raw radargrams in
addition to using processed radargrams. Time slicing is in itself a natural
background removal filter because only reflections above or below the
average reflection are being compared and visualized.
Background
removal should normally only be used to help see reflections in the
radargram profiles themselves, or to help remove extraneous line noises
which can sometimes infiltrate the time slice maps.
Migration
For those not familiar with the effect of surveying with GPR antennas,
cylindrical or round objects buried in the ground create hyperbolic
reflections patterns. Because GPR antenna have a broad directional
response function and send radar waves out of the antenna in many
directions, objects off to the side of the antenna can reflect energy back
and be recorded. When the object is directly below the antenna the two167
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way travel time is small, but when it is off to the side of the antenna, the
two-way travel is longer – the net effect – creating a hyperbolic pattern.
The shape of the hyperbola is uniquely determined by the microwave
velocity of the ground. Slower velocities will cause the hyperbolas to be
narrow, and faster velocities will cause the hyperbolas to be broader.
Shown in the following figure is GPRSIM Ground Penetrating Radar
Simulation (see www.GPR-SURVEY.com) for 2 circular objects buried in
the ground at the same depth, but in 2 different materials. Soil1, the
light green material, has a dielectric of 6, and the dark green has a
dielectric of 25.
The microwave velocity is given by
V= C/(Er)^.5
where c =speed of light 3*10^8
Er=relative dielectric permittivity

The velocity of the 2 soils are 12.2 cm/ns (for the light green soil) and
6.0 cm/ns (the dark green soil) respectively.
The shapes of the
hyperbola are thus quite different.
I like to liken the shapes of the
hyperbola as the “DNA of the ground”, which allows us to determine an
important physical property of the ground - the dielectric permittivity.
Migration is a geophysical signal processing filter which will remove
hyperbolas in the data. The process works by first fitting a hyperbola to
match the hyperbolas found on the raw radargrams. The hyperbola is
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then “applied” throughout the radargram and all the waves that fall along
the hyperbola are added up and the resultant wave is placed at the
vertex of the hyperbola. This is done for every point collected in the
radargram. When the hyperbolas on the field data lines up with the
hyperbola generated by the migration filter in the process, the resultant
pulse by adding up all the in-phase components along the hyperbola will
be very strong. When the computer generated hyperbola is slightly
shifted and not aligned exactly with the hyperbola located on the
radargram, the out-of-phase components when added up will tend to 0.
The net effect of applying the hyperbola filter will collapse the hyperbolic
reflections to point reflections.
This of course only happens in the
perfect world. Variable velocities and small errors in navigation can
create pseudo reflections.
There is a dedicated menu for searching the hyperbola in Filter Menu
(see next menu screenshot). The user can use left and right mouse
buttons to change the narrowness of the hyperbola to match a hyperbola
seen in the field data. Each click of the left mouse button will reverse the
direction of the fitted hyperbola. It is normally best to choose narrow
hyperbolic features, as these will be closer to point source reflectors and
give more accurate measurements. This enhanced menu also has options
to adjust the size of the drawn radargram in terms of x pixel and y pixel
to help best to show the hyperbolas. The user can also set the start/end
ranges to focus in on a particular location in the radargram to better show
just the desired area where hyperbolas are observed.
The Search
Hyperbola Menu will show the dielectric and calculated velocities and
depths to the object real time.
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For migration, the user must also set the migrator scan width. In the
above example, the migrator scan width is 70 scans and is represented
by the two red vertical lines. The migration filter will be operated over
just this length. The user can expand this or decrease the width by using
the migrator red slider bar in the menu.
Two kinds of migration are available: Kirchoff migration and
hyperbolic summation migration. Hyperbolic summation – also known as
diffraction stack migration – is a migration process where all the
amplitudes over hyperbola are added up and placed at the apex.
Kirchoff migration makes is a variation on hyperbolic summation where
the wave obliquity and spherical spreading corrections are included for
each of the summed amplitudes over the hyperbolic aperture.
Migration processes will run in batch until the last radargram is
processed. The user can click on the “processing graphics” switch to see
real time graphic results of the radargrams before and after migration.
Migrated radargrams are usually a bit weaker in gain overall. The user
has the option to apply an overall gain in the Filter Menu to the migrated
radargrams before they are written into the \migration\ folder. This is
usually needed for migrated radargrams as currently the data are not
renormalized after migration. An overall gain factor of 1-4 is usually
necessary to regain the migrated radargrams during batch operations.
The user will have to investigate manually what a good gain value will be
needed for process.
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Hyperbola Search for Large Cylindrical Objects
Migration discussed so far is for point sources. If large cylindrical
objects are in the ground, the effects of its size change the shape of the
hyperbola. The two-way travel time to a cylindrical object with a radius r
is given by:
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The hyperbola formula reduces to the familiar point source formula of T
vs X when r is set to 0. A series of hyperbola shapes for different size
radius is shown in the above diagram.
If the velocity is known for a site than an estimate of the size of a
cylindrical object can be made. Likewise, if the velocity is not known, but
the size of the cylindrical object is, the velocity can be determined by
fitting the hyperbola to the observed hyperbola on the radargram. The
radius in the Hyperbola Search menu is set on the top of the dialog:

If the radius is something other than 0, then the equivalent size of the
object will be shown overlaid on the radargram. Note, that the drawn
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cylinder may appear with vertical exaggeration because the y axis of the
circle is converted to time in nanoseconds. The user will click the left or
right mouse buttons to set the hyperbola velocity if this is known.
(Normally, a very discrete point source hyperbola should be identified
rather than large broad hyperbola, to obtain an estimate to the
microwave ground velocity – since often the sizes of cylindrical objects or
utilities may not be known at the site). Once the velocity is set, then the
user can manually adjust the radius until a good fit is made between
observed and calculated hyperbolas for cylindrical objects with large
radius.
Kirchhoff Migration for Fixed Transmitter-Receiver Offsets.
Many antennas have separate receiving and transmitting antenna that
are separated by a fixed distance. Although we normally refer to many
antennas as mono-static antenna, in fact, most antenna are bi-static
antenna with a fixed-constant offset. The constant offset for some of the
antennas from different manufactures is shown in the following table.

Table of Transmitter-Receiver Separation
Manufacturer

Model#

Freq (MHz)

TX-XR separation (m)

__________________________________________________________
IDS

Mala

Sensors&
Software

600
400
200
2300
1600
1200
800
500
250
100
1000
500

.15
.2
.25

.14
.18
.36

.0762
.1524
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GSSI

US Radar

52600
5100
5101
3100
3101
5103
3105
5104
5106
33200mlf

250
100
50

.2794

2600
1500
1000
1000
900
400
300
275
200
100

.04
.058
.11
.0762
.1524
.16
.3556
.24
.332
customized

2000
1000
500
250
100
100 bistatic

.54
.11
.22
.39
.637
1.444

The constant separation between transmitting and receiving antenna can
be used in generating a hyperbola to measure the velocity of a material
accurately. In addition, the separation can be used to get a more
accurate migration.
For hyperbola searching, the travel time for an
antenna with transmitting and receiving antennas separated by the
distance TxxR, is given in the following diagram:
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Plotting T versus X will give a description of the hyperbola for the
most general case of transmitter and receiver separation, and for a radius
of the subsurface object.
In migration operations with separation between transmitting and
receiving antenna, the radius of the object is not included in the
calculation - although the bi-static antenna separation is included in the
process. The radius is only used to assist in getting better description of
velocity if it is known. In general, the radius of subsurface objects is not
known, and the point source target is often assumed (e.g. r=0).
An interesting effect of having a separated transmitter-receiver is that
there are no subsurface reflections that can be recorded prior to the
ground wave time between the transmitter-receiver, e.g. no reflections
from the ground can be recorded before the time TxxR/velocity.
In a
graphical description of this in the software, we have the hyperbola going
flat at this cutoff time as shown in the following diagram:
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In this example, the TxxR separation is set to 1 meter for illustrative
purposes, and the velocity is set to 0.1m/ns. In this case the time for
the ground wave to arrive from the transmitter to the receiver is 10ns.
We can see that in the example the hyperbola has gone flat at this travel
time. In essence, no reflections can be recorded above this time (if we
believe Einstein is correct and velocities in the ground are less than the
speed of light!). These new options have also been inserted in GPRSIM
v3.0 software for those users of this application.

Variable Velocity Migration
Migration can be done in GPR-SLICE v7 using a continuously varying
velocity profile with depth. In the Hyperbola search menu, the user first
finds recorded hyperbolas in the radargrams. The hyperbolas are chosen
by left clicking the mouse and holding it down to match the hyperbola.
After a match is made, the right mouse is then clicked to save the
discovered point. The velocity of the discovered point will appear on the
location in the radargram chosen as well as on the velocity profile plot.
Three kinds of possible velocity models can be calculated from the
chosen points: constant, block or profile.
The Constant model will
compute an average calculation of all the chosen points. (For constant
settings, the average velocity and dielectric will appear in the Filter menu
items for migration).
The Block model will generate constant velocity
regions from the chosen point - till the scan depth where another velocity
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point is encountered. Profile, generates a linearly interpolated velocity
profile between the chosen points. For Profile velocity models, the user
should make sure to choose and set a hyperbola on the bottom of the
radargram to get a complete profile. A depth range axis also appears on
the velocity plot. This depth range is an integrated depth range which
corresponds to the velocity profile. Thus the depth interval between tick
labels can vary and is not constant when the velocity profile is variable.
An Example of a profile velocity model and its diffraction stack migration
and a comparison with Kirchoff migration is shown in the following
diagrams:
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3D/2.5D Volume migration
3D and 2.5D volume migration is available from the Filter pulldown
menu.
3D migration requires a 3D volume to have been constructed
from the radar pulse. 3D migration also requires tight spacing between
the radar antenna on the ground in order to be close to a ¼ wavelength
of the transmit pulse. For most operations, only multichannel users can
really take advantage of 3D migration since high density area
coverage of a site is available with these systems. Multichannel systems
are usually processed to create 3D pulse volumes. Single channel users,
should they take extremely tight radar profiles
over a site, they can
then also create a 3D pulse volume and use the new migration routine.
In general, 3D migration also requires extremely good accuracy in the
navigation. 3D Kirchoff migration works by summing all the radar pulse
samples found along the surface of a 3d hyperboloid. Because the pulse
is being summed over this surface, any small errors in navigation of the
location of the radar pulses in the volume can cause noise and lack of
good collapse of radar diffractions.
Multichannel systems have the
advantage of fixed antenna elements and thus have much better
navigation in the volume then usually can be achieved from a single
channel system survey over a typical site. 3D migration for all filtering
operations should be used in on appropriate sites when navigation
confidence is very high. If navigation is poor, 3D migration will degrade
the diffraction collapse and lead to more destructive – rather than
constructive - interference in summing the raw pulses over diffractions.
To allow for further streamline processing an angle juncture setting
has been opened up in the Filter3D menu. The angle juncture describes
the density along the 3D hyperboloid that will be used in the migration
process. The angle can be set from a variety of angles
(90,60,45,30,20,15,10,8,6,5,4,3,2,1) to perform migration. Comparison
examples are shown with the angle juncture over which migration is
performed at 90, 45, 10 and 5 degrees. With an angle juncture of 90,
which is identical to 2.5D migration, one can see from the imagery for
this small multichannel test site, that the 2.5D migration looks insufficient
in properly migrating the 3D diffractions. Halving the angle to 45 degree
also does not show much improvement. However, at 10 degrees the
migration looks good and the 3d hyperbolas seen in the raw data are
properly migrated. At 5 degrees or lower, there is no major visible
improvement. A 10 degrees angle juncture will make 36 cuts into the
volume to add up those portions of the hyperboloid. For a narrow
migrator aperture (cell widths), a 10 degree angle juncture can
essentially sample the entire hyperboloid in the migration. For larger
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migrator aperture widths, less of the hyperboloid would be sampled, but
having a larger angle juncture can still significantly reduce processing
time without a large loss of resolution.

Angle juncture setting to sample the hyperboloid in 3D migration is
shown above.
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Hilbert Transform

Hilbert Transforms will convert radargram pulses to pulse envelopes.
The sinusoidal pulses are converted to positive domain envelopes. (The
mathematics to do this is beyond the scope of the presentation for the
manual, however, it basically involves taking the Fourier transform to
convert the radargrams to the frequency domain first, then shifting
imaginary frequencies by 90 degrees, and then doing the inverse Fourier
transform).
Hilbert Transforms are all rectified signals in the positive. Thus slicing
a Hilbert Transform signal is similar to slicing of the squared amplitude
signal which is also a rectified signal. Hilbert Transforms are particularly
useful in the case when the user might like to perform very thin slices
less than the size of antenna wavelet. Creating time slices from raw
radargram pulses where the time slice window is shorter than a wavelet,
can yield noisy looking slices which may not be useful for some
applications. This is because the slicing window may be located over the
phase of the pulse where it is near 0. Hilbert Transforms of a raw pulse
signal near 0 phase would show a strong reflection, close to the signal
peak, since the envelope of the signal is being used.
Note: In our time slice method discussed in the Quickstart section, when
we do not use the Hilbert Transform, we normally use the square
amplitude but with a time window which is several pulse widths long. In
this instance the phase of the signals are not critical because the slicing
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thickness is larger than the wavelength of the recorded reflections. Time
slices of radargrams made with or without the Hilbert Transform are very
similar when the slicing window thickness in time is larger than the
antenna wavelet.

Boxcar Smoothing

To smooth GPR radargrams which have hi-frequency random noise, a
boxcar filter is available in the Filter Menu. The boxcar filter asks for the
user to insert the width and height of the boxcar in samples. The filter
lengths are lengths of the samples on each side of the radar scan value to
be smoothed. Thus if one enters 3 for the width and height of the filter,
the actual length of the filter looks 3 scans to the left and 3 scans to the
right, plus the scan to be examined, or a total of 7 scans, e.g. 2*3+1.
The boxcar filter simply averages the values which are equally weighted
and then writes a new radargram to the \boxcar\ folder. An example of a
boxcar smoothed radargram is shown in the following diagram. In this
example a boxcar filter is applied that is 2 by 2 (which is effectively 5
scans of averaging.
Note: Radar scan stacking can be achieved in the Boxcar filter by setting
Height to 0 and then the Width to any number of scans to stack.
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Regain
A "regaining" of radargrams using a user defined gain curve versus
scan depth can be implemented in the Filter menu. This menu is similar
to the operations available in the Convert Data menus.
The only
difference here is that the wobble removal options are not required here.
In the submenu the user can choose to regain a single radargram or
regain an entire dataset and write the results to a separate folder called
\regain\. The menu operations allow for customized gain curves to be
saved as well imported into the menu.

Regaining a radargram is often necessary when raw radargrams with no
bandpass filtering are recorded in the field and 0ns offset positions errors
exist in the data. In these instances, radargrams should be:
1. converted with Batch Gain - Wobble to remove the DC drift
2. radargram edited for 0ns
3. regained in the Filter menu.
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Radar Scan Gain Normalization Filter

A new option was added to the Filter menu to normalize the gain of
the radar locations that are affected by antenna coupling (Figure 1). The
application of the normalization process requires one to first use the
Horizon Detection and Mapping menu to discover horizon 1. When horizon
1 is detected, in addition to the horizon location files written, the
amplitude of the horizon is also recorded. These *.amp1 files for each
radargram in the project are recorded in the \topo\ folder and are used to
normalize the radar pulse gains. The user will have a lot of flexibility to
discover the best horizon which represents the changes in overall
amplitude. Usually choosing some portion of the ground wave signal on
either peak plus or minus pulses will serve best to represent the
amplitude changes. The normalization process added to the Filter menu
will read the horizon 1 across all the radargrams and normalize scans
based on the gain function 1/((amp-ampmin)/(ampmax-ampmin)). A
simulated example is shown in the figure where the overall scans are
diminished in one area and are re-normalized using the new filter.
The motivation for this filter came from discussions with Dr. Gianluca
Catanzariti at (www.3DGeoimaging.com). Gianluca has data at
infrastructures sites and they found that when the radar system was
slightly elevated off the ground due to obstructions, that at these
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locations the ground wave and overall amplitudes were reduced. He
wanted a method to compensate for amplitude problems caused by the
antenna coupling with the ground. For their infrastructure sites it is
important to look at relative amplitudes to predict corrosion - and
correcting
first
for
amplitude
changes
caused
by
antenna
elevation/coupling effects is paramount. This new normalization option
may be the first step in assisting at sites where antenna couple problem
exists and has created variable amplitudes of transmitted radar waves
through the ground surface.

New gain normalization filter based on detected horizon 1.
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Amplitude Equalization Filter
A new option for regaining radargrams based on the inverse root
mean square across a moving sample length has been added to the Filter
menu. The method works on every scan individually and creates a unique
gain based on a sample window length centered on each pulse value on
the radar scan. The gain value applied to the pulse is the binary
resolution of the radargram divided by the root mean square of all the
data values in the sample window. The effect of the filter is to equally
amplify all parts of the radar scan. The gaining even works in areas where
there is no data essentially seen. Here the application of the filter is made
on a dc/drift - wobble removed radargram only without any range gain or
bandpass.
The sample length has a strong influence in the outcome of the filter.
The longer the filter the closer a bandpassed+agc radargram looks like
the amplitude equalized radargram. A 2nd figure following shows
comparison of an original radargram, and equalization lengths of 20, 120,
and 220 samples. From a dataset provided by Aero 360 from the
Philippines for a drone GPS survey with zig-zag lines, the initial areas at
the beginning and the end of the original bandpassed+agc radargram, no
measurable reflectors can be seen; the amplitude equalization filter
nonetheless "discovers" and amplifies even the smallest digital reflections
recorded. (These areas may be where the drone is way above ground and
flying to and from the start/end programmed GPS path and thus do not
have subsurface reflections recorded). The effect of the filter on time
slices can be dramatic. In the example shown amplitude equalization can
highlight weaker features as well de-amplify features which are dominate.
The motivation for this filter was primarily developed for the seismic
industry in which mapping all the stratigraphy horizons is crucial to
discover all the horizon layers where reserves are present. The filter
might be used to enhance imagery made for large multichannel dataset
areas where significant ground changes between large areas show
significantly different soil contrasts from simple amplitude maps.
Amplitude equalization filtering can help to equalize contrast across the
entire datasets. With all filtering some benefits and detriments will always
exist even with the most common filters we apply to GPR data including
background filtering, migration etc.
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Location of the new Amplitude Equalization filter. An overall gain
value and the scan sample length can be set to create an RMS gain
curve that is unique to each pulse.
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A comparison showing different sample lengths used for the
amplitude equalization filter. The larger the sample length, the
closer the filtered data can look similar to a single AGC gained
radargram.
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Bandpass Filtering – Spectra+Gain menu

Radargrams can be filtered to reduce noise from oscillating
components that have a regular frequency. Bandpass filters can be
implemented to remove unwanted frequencies in the radar pluses.
Before this filtering can be implemented, the frequency ranges over which
to remove frequencies as well as the spectral curve to apply to Fourier
transformed pulses needs to be set with the Spectra+Gain menu. The
first operation is to first set the gain curve which can be done by clicking
the AGC Gain button for generating an automatic gain curve. This can
also be manually adjusted as desired.
The raw pulse along with the
bandpass filtered pulse are displayed in the graphic dialog. One can
move the mouse over any scan in the radargram (up to the first 400
scans) and show the pulse and the bandpass filtered pulse real time. The
raw pulse shows DC Drift/wobble noise - the bandpass filtered pulse
shows this noise removed. This can be seen since the pulse oscillates
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around the 0 line for the bandpass filtered pulse. The lo-pass and hipass frequencies are set with the left and right mouse clicks made over
the spectra plot (shown as green bars). Clicking the Help Set button will
automatically generate the bandpass spectral curve based on the lo-pass
and hi-pass frequencies set.
In the example radargram spectral components in the low
frequency range are seen to be significant and dominate the power
spectra plot. The low frequency noise causes DC-drift in the signal,
resulting in the raw pulse floating away from the 0 line. Using bandpass
filtering, one can remove these DC components in the GPR signal which is
necessary before useful time slices can be generated. After the bandpass
settings are made in the Spectra+Gain menu, the Bandpass button is ran
in the Filter menu on all the radargrams in the project.

Notch Filters
The bandpass spectral gain curve can also be drawn with the mouse
to generate a notch filter. An example of a radargram with severe and
isolated transmission noises is shown in the next figure.
The
transmission noises are concentrated near 50Hz. Drawing a spectral
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curve to remove all the frequencies around this gives a notch filter.
Running the bandpass filter with this customized notch filter design
effectively removes the transmissions noises infiltrating the raw
radargram.
Note: For bandpass filtering for digitized scan lengths of non-base 2 (e.g.
scan lengths other than 128, 256, 512, 1024…etc.), scan lengths are
zero-padded to the nearest base 2 binary length before filtering is done.

Bandpass filtered radargrams are written to the project in the
\bandpass\ folder.
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Compilation of the frequency at max amplitude per pulse
An option is available in the Spectra+Gain menu to map the
frequency at the peak spectral amplitude across a site. The changes
in the peak frequency can be interpreted as a possible indicator of
areas with more moisture content. Areas where the frequency is
relatively lower or depressed than other areas might be correlated
with higher moisture content or can be related to subsurface material
changes in conductivity in those locations.
To generate this new data file for gridding, one enters the
Spectral+Gain menu and clicks the button "compile frequency @
maximum amplitude. This will perform a Fast Fourier Transform on
each pulse and look for the peak amplitude over all the frequencies.
When discovered the x,y location of that pulse (GPS or non GPS) is
compiled along with the corresponding frequency. A file called
peakfreq1.dat is written to the \dat\ folder of the project. This file can
then be gridded over the site by highlighting the peakfreq indentifier in
the Grid menu. The units on the plot legend are MHz which can be
set and customized in the Options menu.

Location of the new operation to compile the frequency at maximum
amplitude in the Spectra+Gain menu.
It can also useful to apply this calculation on data that has been
bandpassed to remove peak spectra which might dominate on the low
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or high end frequencies. The user may also want to experiment with
different narrowed bandpassed cutoffs to empirically see which
frequency range may hold the most information.
The frequency at
maximum amplitude may have a variety of causes not related to
moisture or even conductivity and might simply be a result of
structural features. There is possibility that this gridded data may
illuminate features in the ground that might not otherwise be detected
with simple amplitude mapping.

Example of gridding the peakfreq1.dat file containing the frequency of
the peak spectral amplitude.
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Spectral Whitening
Spectral whitening is a filter process to equally weight all the spectral
components with the same magnitude.
The filter is implemented
operationally by taking a Fourier Transform, adjusting all the +/frequencies to have a magnitude of one, while preserving the spectral
phase of each frequency. An inverse Fourier Transform is then executed
to give a spectrally whitened pulse where the energy at all the
frequencies is equal.
Operationally, spectral whitening also has bandpass components,
however, the spectral gaining curve is NOT used – only the lo-cut and hicut frequency settings. All the frequencies within the bandpass are set to
a magnitude of 1 – and all the other frequencies outside the bandpass are
globally to 0. Spectral whitening is implemented with a sharp notched
filter.
In the following example, the lo pass and high pass are set to
1032 MHz and 140 MHz respectively.

Spectral whitening can amplify the entire range within the radargram
and illuminate depth regions which may have not been optimally gained.
At the same time, it can amplify areas which may or may not have any
strong reflection contrasts in the raw radargrams. The example shows
removal of low frequency noise and at the same time the ability of the
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spectrally whitened radargram to have more detail/gain in regions where
lower amplitudes exist in the raw radargrams.
Spectral whitening
process requires manual setting of a gain factor to divide the spectrally
whitened pulses. Values in the range of 10-100 can be used and it is
common to try several values to see how the subsequent filtered
radargram appears.
Note: to set the low-cut and hi-cut bandpass, the right and left mouse
clicks are set in the graphic region where the power spectra is drawn.
(These settings are only used to assist in drawing the spectral curve and
are not used specifically in the bandpass filter. These settings however
are used directly for the spectral whitening filter where only frequencies
within these settings have magnitudes set equal to 1 – preserving the
spectral phases. Magnitudes outside these bandpass settings are set to
0.)
Note: Spectral whitening can be a useful filter for multi-channel array
data since antenna pair matching can be achieved by implementing this
filter.
Cepstrum Deconvolution
Deconvolution is a signal process which can be valuable in removing
multiples or echoes in GPR return pulses. Often, GPR pulses contain
many reflections which are simply multiple reflections of radar waves
from the same reflector. One example of a multiple reflection is a wave
that travel downs to a reflector, back up to the ground surface to be
reflected by the air-ground interface, and then back down into the ground
only to bounce off the same reflector again. One method for reducing
the energy from multiples is the cepstrum deconvolution process. In this
signal process, the GPR pulses are converted to the spectral domain using
Fast Fourier Transforms, the logarithm of the spectral components is
computed, and then the inverse Fourier Transforms is made to convert
back to the time domain - deconvoluted pulse. Taking the logarithm of
the spectral components has the effect to smooth out amplitude
undulations in spectral frequencies, and reduce the influence of multiple
reflections. Cepstrum deconvolution requires the user to discover a gain
factor to bump up the filtered radargrams to recordable thresholds.
Cepstrum deconvolution is available in the FILTER menu as shown in
the following example. In this example, the raw radargram was
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converted without the wobble – low DC drift noise be removed, to see
some effects of the filter.
Cepstrum deconvoluted radargrams are
written to their own unique folder called \deconv\.

Spectral Deconvolution
Another deconvolution signal process is spectral deconvolution. In this
method, the impulse response function of the transmitting antenna, call
I(w) as a function of frequency, is divided out from the spectral
frequencies of the pulse, called it P(w). The deconvolved signal in the
frequency domain D(w) is:
D(w) = P(w)/I(w)
The beauty of working in the frequency domain is that what is normally a
convolution in the time domain, is a simple division in the frequency
domain!
196

197
GPR-SLICE has a menu to accomplish spectral deconvolution. One
menu called Impulse will help the user to set the impulse response
function by either generating a synthetic response, or by cutting a
“probable” response from the top regions near the ground surface of a
real radargram:

In the Impulse Response menu, the user can import any single
radargram and use the right mouse to set locations on the pulse to cut
the ground wave response. Clicking the Cut button will cut the response
between the set boundaries on the pulse, after which the Save button is
clicked. (Note: this is an approximation, and may not represent a good
description of the real – transmitted response from the antenna).
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Once the impulse response function is set the spectral deconvolution
operation can be run. An example of spectral deconvolution is shown in
the next figure:

If the proper impulse response function or a reasonable candidate for the
response function is not set, very wild results in the impulse deconvolved
radargram can result.
There are many other kinds of deconvolution
algorithms, however, none of them are a perfect medicine for removing
multiples.
Future updates may provide for additional deconvolution
algorithm.
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FK Filtering

FK filtering is implemented by transforming the radargrams into 2D
spatial frequency space and then allowing specific frequencies to be
blanked out before transformation back to the time domain is made.
Removal of specific spatial frequencies – much like discussed with 2D FFT
filtering of time slices in the Grid Filtering section – can enhance features
or reduce observed noises. An example of FK filtering is shown in the
above screen shot. Using either a paint mode with a user set brush size
or capturing the FK components, the users can blank out the desired
frequencies.
Sloping or diffraction components in the radargrams are
suppressed by choosing frequencies components in the FK transform
which are normal to the observed features time domain.
FK filtering
would be useful for also removing some kind of observed directional noise
that might be observed in the radargrams.
Batch processing can be
implemented as well as options to store customized FK filters that are
designed. (Beta designation is applied to the FK filter since it is currently
limited to radargrams with limited scan density under a few thousand).
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Multi-Folder Radar Display
Showing multiple processed folders for radargram displays can be
done in the 2D Radargram Menu by clicking on the desired radar folders:

Radargram Appending
All the radargrams written into an information file can be appended to
a single radargram file using the new Append All Radargrams button in
the Radargram Edit menu.
The option is provided in the menu
traditionally used for just time 0 editing. After the appending option is
completed, the user will need to create a customized information file to
display the appended radargram name.
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ASCII to *.xyz *.xyza, segy and segy3 radargram export
Several buttons in the Filter menu were added which will allow the user
to export any processed radargram into several requested formats:
•
•
•
•

.XYZ is a simple asci file written one pulse after another
.XYZA is a 4 column file (see screen shot) with each radar pulse
written as x,y,z and the amplitude
SEGY is the standard seismic format
SEGY3 is the standard 3d seismic format
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X and Y are the horizontal position of each sample value recorded in
the radar pulse; the Z value is the depth of pulse sample based on the
time/depth axis chosen in the Options menu. If nanoseconds is chosen Z
will be in nanoseconds – if a depth unit is set then Z will be converted to
that depth unit using the active velocity.
Once the operation is run, the processed folder that was set will have
ASCII files with the extension *.xyz, *.xyza or segy written. Note: The
size of ASCII files are significantly larger than the binary format used for
radargrams so don’t be surprised to see the converted radargram in
*.xyza format being 5-10 times larger on disk.
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Analytics Menu
Radargram Threshold
A new menu called Analytics was added under the Filter draw down
menu (screen shot). The first operation added to this new menu is a Rad
Zeroing button. Often on a radargram display one might only want to
show data above and below certain amplitudes on the pulse. Trying to set
this with just the color transform can be accomplished visually, however
the displayed data are only colorized and not actually changed in the
radargram. With this new threshold option, the user can independently
set the negative and positive threshold below which all recorded radar
values will be shown as zero. The operation will also write the radargram
with threshold applied to the \work\ folder. The filtering operation will
set all pulse values less than the set min/max values to binary 0.
Note: For the Hilbert folder the negative threshold is idle as no negative
values exist from this filtered radargram.
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Combining multi-frequency antennas
A new option is available in the Analytics pulldown menu to combine
low frequency and high frequency antenna (see following figure). The
operation will combine either dual frequency or triple frequency
radargrams. For some manufacturers, the time windows are different
between the low and high frequency channels.
For dual frequency
operations, the high frequency and low frequency information files must
be named infoa.dat and infob.dat with infob.dat being the low frequency
channel (the channel with the longest time window). For triple frequency
blending (such as for data from US Radar’s Quantum Imager system or
from UTSI Electronics), the software looks for infoa.dat, infob.dat and
infoc.dat with infoc.dat being the low frequency channel having the
deepest time window.
To accommodate for the variability in time window and pulse
digitization between the different antennas, the software operation will
automatically scan resample the high frequency channels and make
separate channels with equal time windows.
The bottom of the
resampled channels will have null – 0 data.
The filename for these
generated channels is appended with the name “comp-“ to signify
compression – which is essentially the mathematics that is applied to
match the digitization of the time windows for each channel. These scan
resampled radargrams with the “comp-“ identifier are written to the exact
same processing folder highlighted.
After the operation is run 2 separate information files are written. For
combining just 2 frequencies the software will generate the infoant3.dat
and the infoant123.dat files. Infoant3.dat has just the name of the
combined radargram which is appended with the name “ba” on the
blended radargrams. The information file “infoant123.dat” will contain
the names of the low frequency resampled channel, the high frequency
channel and the combined radargram name. Similarly, for combining 3
antenna frequencies, the info file names generated are infoant4.dat and
infoant1234.dat which will have the combined radargrams and the
separate 3 frequencies and the resultant radargram. The infoant123.dat
and infoant1234.dat files will make it easy to examine all the separate
frequencies and the combined radargram for viewing in the Radar 2D
menu.
Note: Currently the operation assumes that time 0ns is the same between
the different antenna.
If time 0ns is significantly different, then
radargram editing operations should be run prior to combining the
different antenna frequencies. Each antenna can also be blended with
204

205
their own multiplier constant.
If the constants are set to 1 for each
channel, there is a potential for the combined radargram to have clipped
pulses that go beyond the binary resolution of the data recording. In this
case, one might opt to set each antenna multiplier to 0.333 for the
combining operation.
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Hilbert Transform - peak response inversion
A new filter was added to the Analytics menu that can identify the
peak +/- pulse response of the migrated hyperbola - that on viewing from
a Hilbert space - will invert the signal to classify those responses. This
new filter operation is called Hilbert Transform – peak response inversion
(for lack of a better word). On Hilbert transforming the migrated
radargram for example, the software will test a set threshold placed in
the menu and look for the sign of the peak pulse response on each
individual scan. The Hilbert transform pulse will then be inverted should
the signal waveform have a stronger negative pulse for that scan. The
signal inversion will be done only on the signal above the set threshold.
For this example, a 0.5 threshold worked best. A 0.5 threshold means all
signals above 1/2 the maximum binary resolution of the radargram
recording, e.g. for 16bits is 0.5*32768 and for 32 bits is 0.5*32768^2.
This filter might possibly be used as a diagnostic for estimating phase
inversions and to distinguish reflections from subsurface locations that
have lower dielectrics (or even possibly voids) in the ground. The criteria
currently used is just the peak signal responses so some care should be
given to the interpretations.
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N segment interpolations of adjacent radargrams
A new option was added to the Analytics menu under Filter to allow
the user to make N (linear) interpolations between adjacent radargrams
in a survey (Figure 1). The adjacent radargrams in the info file should
have the same number of scans currently. If adjacent radargrams do not
have identical scan lengths, then one can use the Resample option in the
Slice menu to ensure that the total number of scans between markers are
identical. The interpolated radargrams will be named into the same folder
that is highlighted and appended with the naming convention 1-, 2- … N-.
A new information file will be written with the ending identifier info-N.dat

The option can also be applied to GPS/Vector surveys and the
navigation file between the adjacent radargrams will also be linearly
interpolated including vector columns in the *.*gps nav files.
Interpolating radargrams for vector surveys with identical line lengths but
with insufficient areal coverage can be accomplished. One example is
shown for a radial tunnel survey. In an example following, 20 initial
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radargrams at 0.5 meters were interpolated 9 times to make higher
density coverage. Interpolated radargrams were generated at 5cm
intervals. Using the Direct Vector to 3D volume menu under the Radar
pulldown menu, a solid 3D volume was created at 5cm cells without the
need for further cell interpolation.
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3D OpenGL Volume Menu Overview

In this 3D volume menu the user has a host of possible display options
including:
•
•
•
•
•
•

X, Y, Z plane displays
3D radargrams
Isosurface rendering
Horizon surfaces
Netplots
Transparency displays

The requirements of the user to access the 3D Volume menu is to
have created a 3D binary file within the Grid menu. If the user has not
created the 3D binary file from the desired 2D grid dataset or from direct
radargram insertion into a 3D volume with multichannel options, a
message box will appear that the 3D binary header file (with the *.hed
extension) was not found.
Open GL is the primary visualization tool for
examining 3D volumes of GPR data.
There are 3D and 2D Open GL menus for display of time slices and
volume elements. To access the 3D displays, there are currently several
Open GL menus to choose from listed on the 3D Volume pulldown:

•

Open GL Volume – is the main Open GL visualization display.
Opacity/transparency options are not included. XYZ fence displays
are drawn as vertex quads in the volume.
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•

Open GL Volume + Draw – is the main Open GL Volume display
with the added option toolbar for placing pipes, 3D rectangular
shapes, or spherical/ellipsoidal objects into the volume.

•

Open GL Volume XYZ-2D - is a 2D viewer of the 3D volume showing
X, Y and Z cuts of the volume with controls on choosing Z anomaly
locations for instantaneous showing on separate X and Y plane
displays.

•

Open GL Volume XYZ-2D + draw - is the same 2D Viewer but will
also launch the drawing tools menu.

Open GL Volume Visualization
OpenGL (Open Graphics Library) is a standard specification
defining a cross-language and cross-platform API for writing computer
graphics applications.
The Open GL consists of over 250 different
function calls which can be used to draw complex three-dimensional
scenes. OpenGL was developed by Silicon Graphics is widely used in CAD,
virtual reality software, video gaming software, scientific visualization,
information visualization, and a host of other industries. OpenGL is
managed by the non-profit technology consortium, the Khronos Group,
Inc. Open GL for Power Basic which is the language that GPR-SLICE v7
is written in is also supported in Open GL.
In order to effectively run Open GL one will need to have a
computer with a separate graphics card with at least 512 MB – but the
more the merrier. Any computer with just an integrated graphics card
will not be able to interact with GPR volume in a very instantaneous realtime experience. We recommend NVDIA graphics cards providing the
best performance for Open GL applications in GPR-SLICE v7.
OpenGL Volume has been developed and built-in directly to GPRSLICE V7 which allows mixing and matching of the following elements in
the same graphic dialog and volume:
3D volume slices
3D radargrams
horizon surfaces

topography
isosurfaces renders
chair cutaways

Shown in following diagrams are examples of various displays that can
be accomplished in Open GL Volume.
The user can store any element
to the screen using the "Store" button and then toggle through to other
desired displays by clicking the appropriate buttons – Radar, X Y or Z, or
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Horizon.
In the following pages there are some examples of the kinds
of visualizations that can be achieved with Open GL:

In this example several GPS radargrams along with a single z slice are
shown simultaneously. First the radargram folder was set, followed by
clicking the R button, then the store button to save the desired
radargrams to the screen. After that, the z button was clicked and the
slider bar adjusted to scroll to a desired z plane.
An interesting view for the OpenGL Volume display is to see the
radargram side-by-side with a fence diagram in the exact location (as
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seen in the following diagram). One can visualize the GPR-SLICE volume
image with the raw radargram to see how reflections are
imaged/transformed by the slice operations. One will be able to discover
that some anomalies, in which no coherent reflections are seen in the
radargrams, are clearly illuminated in the 3D amplitude volume, when the
volume is generated from normalized and interpolated time slices.

OpenGL Volume also has angled cuts through the volume. Clicking on the
XY button the user can control the angle of the cut with the XY slider bar,
and also advance the cut through the volume with the 2nd XY client slider
bar as shown in the next screen shot:
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A solid 3D cube volume can also be obtained in OpenGL Volume by
clicking on the Z solid (beta). This is given the designation of beta since
real 3D voxels are not be shown – the software detects the outside edges
of the level slices and renders the sides only. This saves on memory. An
example of a solid look of the display volume is shown in the next screen
shot:
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Isosurface Rendering
Isosurface renders are displays of surfaces of equal amplitude in the
3D volume. Shading is used to illuminate the surfaces to give an
appearance of a real 3D image in the ground. The Marching cube
algorithms with lookup tables were implemented in GPR-SLICE since
June, 2010. Marching cube algorithm provides unique drawing orders for
illuminating the triangular vertex planes that intersect a voxel. The result
of implementing marching cubes is significant increased speed for display
of isosurfaces.
GPR-SLICE v7 rendering calculates possible surfaces within the 3D
volume and will display any surface the user sets between 0 and 100% of
the maximum amplitudes in the volume.
The 100% surface represents
the strongest surface in the volume and 0% isosurface represents the
weakest reflector. If for instance 0 were inserted in the isosurface setting
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in the Open GL Volume menu, then the entire 3D volume would be
illuminated and nothing would be seen within the volume. Likewise,
setting the surface to 100 would only show a single spec in the volume
which would correspond to the maximum reflecting surface recorded.
Using transitional values such as 50 would illuminate a surface which is
50% of the maximum value in the volume. Most projects will default to
an initial value of 75% for the isosurface.
A static isosurface option
called ISO in the Open GL Volume menu has a predefined “shaded” color
table which is set in the Color menu in the Options menu. The colors or
shading do not change with rotation of the 3D volume with the ISO
display. Here is an example of the isosurface threshold set to 42% for a
concrete structure:

Open GL lighting of isosurfaces
True real-time lighting of isosurfaces is now available using the ISO-L
button in Open GL Volume. If this button is clicked Open GL lighting will
engage. Rotating the volume one can see the shading on surfaces realtime. Open GL volume currently uses a two light source hardwired in the
display which gives a nice real-time shading to the isosurfaces.
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The advantage of ISO-L is that it will follow the color table of the
corresponding isosurface threshold, in the 3D volume. The color will have
lighting applied to give it a real time depth appearance with shading.
This will better help to show anomalies that are colorized within the
volume feature. Several examples are shown in the next diagrams.
In the diagram on the previous page, an example of post tension
cables and rebar are illuminated with an isosurface (shown at colors
corresponding to green threshold reflection amplitudes in the 3D volume).
This dataset is from the Kistachie Advanced Users notebook available to
all users on the ftp site (www.gpr-survey.com/practice)
Open GL Transparent Displays
Transparent displays in Open GL can be achieved using the Open GL
Volume Texture Method – Beta method menu. In this example an opacity
slider bar is used to set the amount of transparency. Completely opaque
elements can be placed in the Open GL volume and these should be done
first before transparent images are drawn. With the slider bar completely
to the right 100% opaque drawing is done. The example shown has an
isosurface within an isosurface by first storing an iso-l isosurface at
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(85%) then using the opacity slide bar and drawing a weaker isosurface
(at 42%) on top of the previously displayed isosurface. Any element can
be placed into the volume including XYZ fences or radargrams as well.
Note: As a requirement of Open GL, opaque elements should be placed
into the volume before transparent elements are stored!!

Another possible combination display with transparency is shown in the
next figure:
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Negative/Opposite Isosurfaces
Isosurface displays in GPR-SLICE have typically been used to render
the 3D surface of the strongest amplitude thresholds in a volume.
Sometimes, the low amplitude surface has more pertinent subsurface
information that is needed than just the strong amplitude portion. For
this reason, the isosurface displays have been extended to render the
weak reflection portion of the volume. To implement this option, a
negative value for the isosurface percent threshold in the OpenGL Volume
menu can be set (Figure 6). An example for the Nutubaru burial mound
is shown. A weak circular reflection is seen which represents a
subsurface moat. The moat reflections are weak at this level since the
radar waves have not yet encountered the bottom of the moat and are
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just transmitting through the homogenous soil fill within the moat. Using
a negative isosurface, the weak - blue portion of the volume and the
moat can be illuminated. In this example, the top portion and surface
reflection in the volume are removed by setting the top time z level at
15ns to remove all reflections to this level (see upper left hand menu slot
items in the OpenGL Volume screen shot).

Isosurface Statistics and Export
Open GL Volume has an option to provide statistics on displayed
isosurfaces. A new button called stat (for statistics) located below the
isosurface options, will generate a dialog giving the number of grid cells,
and the volume of these grid cells associated with the isosurface. The
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calculated volume is a function of the nominal velocity of the site (set in
the Options menu).
An example of isosurface statistics is shown in the
next menu screenshot. The focus option can also be engaged to only
show a desired portion of the isosurface volume to the screen.

Several export formats for the drawn isosurface can be exported in the
OpenGL window including:
*.txt – csv 9 column format with the xyz vertices of the isosurface
triangles
*.dxf – an autocad readable format for triangles that form the isosurface
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*.stl Standard Stereo Lithography CAD software export format
An example of a *.stl format isosurface and read in a freeware in
Windows is shown in the following figure:
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Open GL Volume XYZ-2D Menu

The Open GL Volume XYZ-2D menu allows for simultaneous displays of
the X, Y and Z planes in the volume as well as the radargrams from any
folder. Clicking the mouse on the Zscan plot will simultaneous show that
cut in the volume along the X and Y planes real time. A mouse pointer
will be displayed simultaneously in the X and Y that is lock onto the
clicked anomaly location on the Zscan. If the bouncing of the Zscan is
engaged, the pointer will cycle up on the corresponding location on each
of the planes. The pointer size/colour can be set in the Open GL Volume
XYZ-2D+Draw menu. There are also style settings that will make the y
cut rotated as well as a style setting to rotate the z plane 90 degrees.
The Style a+r setting will include the display of the nearest radargram
that is detected from clicking the Zscan anomaly for an XY survey. (GPS
radargrams displays are not available in this menu).
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Time Slice Area Statistics
The stat button in OpenGL Volume can also provide 2D area statistics
based on the isosurface percent setting. Just clicking the Z plane and
showing it to any level in the volume, then clicking the stat button in the
menu will give the total area on the time slice greater or equal to the
desired isosurface threshold (Figure 10). If you just show the Z plane,
you will not really know the exact location of the area. The best way to
see the area is to show the isosurface first – store it - then display the
desired z plane – followed by clicking the stat button. One can also first
place the isosurface – then place a z plane – followed by adjusting the
slider bar to match the isosurface – followed by clicking the stat button.
The focus option can also be engaged to only provide the area statistic
from a selected part of the volume. It is common for geotechnical firms
to provide estimates of the areal size of anomalies such as for
delamination on bridge decks, void sizes, measurements of fill areas etc.
The stat option will make reporting this information easier.
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Open GL Volume Drawing Tools

GPR-SLICE is equipped with Open GL drawing tools to assist in the
interpretation of 3D volumes. These options are found by using the Open
GL Volume Draw menu on the 3D Volume pulldown menu. The drawn
objects inside the 3D volume can also be exported to DXF file format for
input into AutoCad software
Currently 4 objects can be inserted into a 3D volume: cylinders/pipes,
spheres, rectangles and lines/lines+pts. The user has keyboard controls
to adjust length, width and height of these objects as well as to
rotate/tilt.
All the control keys also have reverse keys to undo
rotation/tilting width/height/length etc.
Repositioning is handled with
the arrows keys along with the page up/dn keys or also the mouse.
There is a section button which allows the user to go to any inserted
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object and delete it from the mix. All the drawn objects are stored in a
file called openglobjectdraw.dat, which is an ASCII text file with
various columns of information. The user can take their own data and
modify these files to insert information from external sources as well.
Pt-line sections can be added to the drawn tools by clicking the line
tool, then clicking the desired location on the Z plane. The section will be
closed off when the line button is clicked a second time. Clicking the line
button again will start another line section. Different colors as well as
options to number of the points using the annotate
checkbox are
available. An example is shown in the following screen shot:

The drawing tools will sync to any X,Y, or Z plane as well as any xy or
GPS radargram . The drawn object will get locked to that chosen plane or
radargram. During drawing the plane or radargram can be changed and
the newly stored object will lock to the newly drawn plane. A simple
example of just drawing 2 points connected between to cross radargrams
is shown in following screenshot:
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Open GL Volume - Anomaly Picking + Conversion to Pipe Features
Open GL Volume + Draw menu has options to store handpicked
anomalies. by launching the TSPoints button in the menu. The points
clicked on will be stored in an online dialog and also written to two user
files:
•
•

TSpoints-GL.dat file - containing all the information in the
online dialog
Tpoints-xy.csv - containing only the xy points of the chosen
anomalies.

An annotation checkbox is available to turn on numbering of the chosen
points.
Different X, Y, or Z planes or XY radargrams (not GPS
radargrams currently) can be drawn to the screen and the TSPoints will
follow the desired plane and output points in these planes when clicked
on. The size of the drawn pt. can be controlled with the Set Size button
and the desired width, height, length of the pointer. On reentering the
TSPoints option the original data will be uploaded to the online dialog. A
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space will be placed between new points that are added to the anomaly
file.

TS points chosen can be easily exported into pipe features directly in the
OpenGL Draw menu. This operation can allow easily identifying pipes via
point mapping in 3D and then quickly get them into a 3D look. Drawing
pipes with tilting and rotation etc., can be done but is less efficient then
using point drawing initially. TSPoints operations in OpenGL Volume
Draw allow collecting chosen anomaly points on either X, Y, Z slices of the
volume as well as on any non-GPS radargrams. These connected points
can then be converted to pipe features. The procedures are:
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1) Click TSPoints on any X, Y or Z slice of the volume and at any level.
Points can be chosen anywhere in the volume as well as along X, Y
radargrams. (Figure 5)
2) After defining the lines, the comment section of the TSPoints dialog
can be modified with the word pipe, radius, and the color #.
3) The TSPoints button is clicked to convert the drawn points into a
continuous pipe features.
Points or utility features chosen on the time slices can also be imported
into OpenGL Volume.
The steps here are to choose anomalies on the
times slices. If the anomalies chosen are just points to import, then the
comment section of the TSPoints dialog is left blank (as shown in the
following example. For pipes, identify these in the TSPoints dialog in the
comment section). Once the anomaly points are chosen, then in Open GL
Volume, one then clicks the import TSPoints button to get those features
to appear. The size of the points and the desire color can be changed
after import or after clicking the Read TSPoints button in the OpenGL
Volume draw menu.
Similar operations are available in XYPoints using the radargram and
then clicking the Read XYPoints button to import these to OpenGL
Volume. In addition, another button in OpenGL Volume called Import
Points will simply read and x,y,z comma delimited file to show these
points in the volume. The color and size of the imported points can also
be adjusted by clicking the Import Points button and after editing to the
desired settings.
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Conversion of Line Objects to Pipes for Quick Drawing
For drawing pipes in 3d can be time consuming to connect all the
sections as the rotate and tilt keys need to be used. To help speed up
the process, the user can draw the pipes quickly as a continuous line
function in 3D, and then press the new L to P (line to pipe) button (seen
in the next screen shot). The operation will read the current radius set in
the OpenGL Draw menu and apply this to the current drawn pipe section.
Before the button is pressed, the Section button will need to be toggled to
get to the first desired drawn line section to apply the conversion.

DXF Export of Depth from the Local Topographic Surface
In the OpenGL Volume Draw menu a variety of DXF export files are
made to accommodate user requests. The latest export option provides a
DXF export file that will report the local depth from the local topography
for the drawn object (Figure 9). For this option to work, there must have
been a topographic grid created that was used to generate the binary
corrected topographic radargrams in the project. Anomaly points are
then chosen in the 2D radargram menu on the \topo\ folder (in the
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following screen shot). With import to OpenGL Volume Draw using the
XYpoints button, DXF export will write the absolute depth as well as
display the local depth as labels from the ground surface for the anomaly
points in AutoCAD.

2D Perspective Switch in Open GL 3D
2D perspective switches are available for X, Y and Z planes to shut the
perspective off the 3D volume and allow for 2D flat perspective displays
for any volume element, including radargrams, to be shown. This option
is useful for making 2D output from the 3D volume display. The 2D
perspective button should be clicked to toggle to the desired X, Y, or Z
perspectives.
An example of using the Open GL Volume (Topo Warp
Volume) menu to display a radargram warped from topography in a 2D
perspective is shown below:
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The 2D on/off button is toggled till the desired X, Y or Z plane flat
perspective for the desired projection on the currently drawn element.
The 2D projected volume is rotated in the Open GL Volume display, it will
show a non-perspective/orthogonal 3D display which will look a touch
strange. Clicking the prsp+/- button one can manually place perspective
back into the graphic. Clicking the 2D button till 2D off appears will also
automatically place perspective in the graphic as well.
The 2D perspective allows easy generation of topographic
radargrams or regular radargrams without having to do binary corrections
(see the Static section) for display.
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Overlay Analysis in 3D

Overlay analysis provided in GPR-SLICE allows the user to overlay the
relative-strongest-reflectors onto a single time slice map.
This
functionality has been available in the 2D Time Slice menu since the
inception of the GPR-SLICE for DOS. The 2D time slice menu was the
only location one could apply this very useful imaging technique. The
overlay analysis is now available in the 3D Open GL Volume menu as well
(although you have more flexibility in the 2D time slice menu). The “O”
button will add the relative-strongest-reflectors onto consecutive time
slice levels. To start the overlay one can click the “Z” button, step or
bounce to the desired level, then click the “O” button to start overlaying
the reflections from below the current level onto a single – overlay image.
An example of the “O” button to make 3D overlay displays is shown
below. In the 3D display the individual transforms for each level cannot
be adjusted as they can be for 2D overlay analysis operations in the T234
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Slice menu, as a global transform is applied across the entire volume.
Nonetheless, visualizing the overlay analysis options in 3D provides
another way to present, observe and report adjacent and continuous
reflections that are variable reflection depths - onto a single 2D image.
An S button for skipping z levels in overlay analysis in Open GL
Volume is available.
This operation requires clicking the 0-overlay
button, clicking the step+, then clicking the S button, followed by any
number of step+ clicks which will skip these levels in the overlay.
Subsequent clicking of the O button will continue the overlay process.
Display and compilation of all user marks in OpenGL Volume Draw
menu
A subscriber uses GPR on historic cemeteries and asked if it was
possible to have all the user marks he inserted during his survey be
shown in OpenGL. During the survey he stores user marks in front of
known burials with headstones, and he wanted to be able to see these to
better help him interpret all the data and particularly how the unmarked
burials look in comparison. Currently, one can show the user marks on
individual radargrams using the User Mark checkbox in the Options menu.
An option was added to the Grid 2D button in the listbox called User
Marks which will compile all the user marks to sphere objects and display
them in the OpenGL menu. The user can set the size of the spheres
(diameter) as well as the desired color before importing the users marks
into the drawing menu. Remember, one can always back up their current
drawing with a unique name so that user marks or other drawn features
can be imported into the menu as separate layers.
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New option to compile all the user inserted marks into sphere objects
using the Grid2D function and the User Mark listbox item.
Scrolling of GPS radargrams in OpenGL with a user set scan length
GPR/GPS surveying is becoming more commonplace and users are
often collecting longer and longer single-track GPS datasets.
An
example of a super long GPS (drone) track collected by Aero Solutions
360 in the Philippines is shown. One issue in displaying GPS radargrams
in their full 3D extent is zig-zag single track surveys are difficult to look
inside the track as front or rear portions block the visualization. For this
reason, a new scrolling 3D option was developed in OpenGL for GPS
radargrams. The user can set the number of scans to examine and then
clicking the r+/r- buttons one can increment and display that number of
scans into the single track. The Store button can also be used to keep
display lists of any number of desired portions of the track. The Bounce
button can be engaged and will allow an "animation" of the GPS track.
The animation will reverse itself after getting to the end of the track.
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Location where to set a user defined scan length for GPS radargrams and
using the r+ and r- buttons to scroll that many scans into the profile.
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BlueBox Batch(c) Processing

GPR-SLICE v7 has complete batch processing for single channel as
well as for multi-channel GPR systems. BlueBox Batch processing is a
complete data operation stream from conversion of raw data to building a
final 3D volume - all via a single click of one button! Launching the
BlueBox, the software will automatically run through and show all the
different menus and real time processes in the those menu as the batch
run is operating.
BlueBox Batch processing includes complete
customized radargrams signal processing (RSP) as well as 0ns editing
operations.
The concept of “BlueBox” is introduced since the user - not
software - is required to set the necessary information in each of the
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menus, before running the complete batch process – it is not a
completely blind “blackbox” process!
GPR-SLICE menus in v7.MT can record all the settings the user makes
even if no operations were run in all the menu. Once all the desired
settings are made, the BlueBox Batch run can be launched. For single
channel equipment there are 13 BlueBox processing streams available:
•
•
•
•
•
•
•

BlueBox: Basic
BlueBox: Basic+edit
BlueBox: Basic+RSP
BlueBox: Basic+edit+RSP
BlueBox: XY decoupled gridding + RSP
Bluebox: XY decoupled gridding+edit+RSP
Bluebox: XY decoupled volume+edit+RSP

The Bluebox designations
- Basic – refers to all basic processes to make time slices
- Edit – includes automatic 0ns corrections to the radargrams before
time slice operations
- Resample – adds resampling of radargrams during slicing
operations
- RSP – includes a set of user defined geophysical signal processes to
be applied to the radargrams before slicing operations commence
- XY decoupled gridding – refers to separating x and y lines and
applying elliptical gridding operations before grid math
- XY decoupled volume – refers to pulse volumes where elliptical gap
interpolation is applied independently to x and y volumes before
volume math is executed
The Bluebox operations are given fuller descriptions in the following pages:
BlueBox Basic
Basic processing includes all the steps required to make 3D volumes
of GPR reflection data from raw data.
This basic BlueBox process will
make time slices and 3D volumes all the way from raw data with one
button click.
The 10 steps outlined in the BlueBox Basic batch run
include:
Step 1: conversion
Step 2: reverse
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Step
Step
Step
Step
Step
Step
Step
Step

3: navigation
4: search 0ns
5: slice/resample/xyz
6: grid helpset
7: gridding
8: grid smoothing
9: 3D file
10: Open GL

Prior to running the BlueBox the gain curve can be drawn in any of the
Convert menus and the software will now record and remember the
settings upon exiting this menu. Convert gain menus are still required
for most GPR equipment such as Mala and Sensors and Software since
these equipment are recorded with 16 bit ungained radargrams. Other
manufacturers’ record with gain, but these can also be optimized on
conversion.
Settings in all the other menus such as the # of slices,
should be set and the desired time slice identifier placed in the
Slice/Resample menu.
You do not need to set the 0ns as this can be
automatically found.
All the operations are indicated with checkboxes which the user can
set for their customized datasets. In general all the checkboxes will be
clicked on before running the BlueBox. For instance, if the radar lines
were collected in a zig-zag survey in the field, then the Reverse checkbox
would be clicked on. The user will also need to pre-define which lines
are reversed before starting the BlueBox run.
If the lines were all
collected in the forward direction, then the Reverse check box would be
unchecked. For GPS datasets, the Reverse checkbox will be disabled to
insure these lines are never reversed since they are defined by the GPS
track.
Navigation for BlueBox operations currently has only 2 available:
Artificial Markers or GPS Trace# options. Field marker options are not yet
provided for BlueBox runs because these datasets often need user editing
to adjust the number of recorded markers to match the information file.
Navigation operations will automatically check the *.GPS files to see if the
5th column of the files contains scan numbers or is just set to 1. “1”
indicates that there is no corresponding scan numbers with the listed
navigation and simple artificial markers are generated based on the total
number of scans and the total number of GPS listings in the information
file. Trace # navigation is only read if *.gps files have scan #’s in the 5th
column of the navigation files. All other surveys are assumed to be from
survey wheel collected datasets.
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Slice/Resample/XYZ is run on the \radar\ folder where the navigation
was applied. Prior to running Slice/Resample/XYZ the user can have the
Search 0ns detection run all automatically as well. Next the Grid Helpset
operation followed by Gridding and Grid Smoothing will be executed.
Currently, the Grid Smoothing will use the 3x3 lo pass matrix or another
filter should that have been highlighted in Grid menu.
After gridding is completed and grid smoothing, the Pixel Map menu is
launched and grid interpolation and 3D file compilation are done. The
user can have any number of interpolations compiled. In addition, the
normalization can be set to whatever is desired. For most archaeological
applications, relative normalization is useful. However, for stratigraphic
(geologic mapping) or even engineering applications, sometimes the
Absolute normalization that follows the gaining in the radargram pulses
can be used with some success.
Finally, the 3D volume can be
automatically opened in Open GL.
Note: The user can make successive BlueBox basic runs and change any
items they want, such as identifiers and other items. However, if they
use helpset buttons, then the defaults from these operations will prevail
and reset what the user may have adjusted. For instance, ones wants a
specific customized grid setting in the Grid menu, they could manually set
these, then click "Grid Helpset checkbox to "off" in the BlueBox run,
insuring that there customized settings are used in gridding operations.

Bluebox Basic + RSP
BlueBox Basic + RSP batch runs include all the Basic operations
previously shown along with radargram signal processing. The desired
radargram signal processes are set in the Filter menu first under the RSP
batch heading. In the following example bandpass, background filtering,
migration, and Hilbert transforms are the RSP to be applied to the
radargrams. There are checkboxes next to the bandpass filtering as well
as the migration operations. If the checkbox is highlighted this means
that during the batch operations the software will prompt the user to
either insert the bandpass cutoff frequencies manually for bandpass
filtering. For migration, the checkbox on will prompt the user in the
Hyperbola Search menu to set the velocity curve or value to be used in
migration. For Regain operations, checkboxes for prompting for the gain
curve can also be engaged.
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The Basic + RSP BlueBox Batch run will generate time slices of the
final RSP radargrams, and then starts back in the Navigation menu (e.g.
Blue 7:) to set markers and then continuing on to slice/resample/xyz
operations. Initially the \radar\ data is resampled to the \resample\
folder. The final filtering operation that is completed on the radargrams
in the Filter menu becomes the input directory for running the navigation
operation.

Note: For Basic+RSP runs, the time slice grids will automatically be
appended with the extra identifier “rsp-“ on time slice creation.
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BlueBox Basic + Edit (Ons correction)
Many datasets often have varying time 0 offsets. The varying 0ns
offset might have been caused by the user making variable settings or by
drift within the equipment. Also, multi-channel systems almost always
have variability in the 0ns position between channels. For this reason,
radargram editing and truncation to a common 0ns position and scan
depth is required. BlueBox operations are predefined included time 0
editing of radargrams.
Shown in the next diagram is the
Basic+radargram editing menu detailing all the necessary steps:
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BlueBox Basic + Edit + RSP
The Basic + Edit + RSP BlueBox run provides all importation steps for
full processing from raw radargrams to final 3D processed volume. This
BlueBox operation can be used for most sites that are collected with
coarsely spaced profiles in either x, y, xy or ang surveys or for GPS
surveys and that require time 0 editing and radargram signal processing.
This example has RSP set to background filtering, bandpass, Kirchhoff
migration and Hilbert transform.
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BlueBox XY decoupled grid generation (concrete imaging)
Concrete imaging where we want to enhance linear features in the X
and Y directions of the grid can be easily accomplished in GPR-SLICE
using the BlueBox XY decoupled gridding menu.
The method of XY
decoupled gridding is where X lines are separated from the Y lines and
grid maps are made with differential search radii (see diagram below).
An example of differential searching is depicted where the search radius
transverse to the profile direction is large and conversely made narrow
along the search direction. The separated X lines and Y lines grids are
then added back mathematically. The method of decoupled gridding is
very useful for geotechnical surveys and particular for concrete and
infrastructure imaging where linear features such as rebar and piping are
buried.

A BlueBox Batch menu is available to completely run this data
processing flow all the way from raw data conversion to a volume made
from processed radargrams used in decoupled gridding calculations.
(The user can also do this completely manually but the BlueBox is more
efficient).
Before starting the BlueBox XY decoupled gridding operation the users
will want to have several things set:
1) There should be an infoxy.dat file generated which has both x and y
lines navigation defined.
2) In the Filter menu the RSP (radargram signal processing) should be
set (as shown in the next diagram). For this data the processing is
set to i)background filter ii)bandpass iii) kirchoff migration iv)
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Hilbert transform.
It should be noted, if the objective of the
concrete survey also involves mapping the thickness of the
concrete, then background filtering should most like not be included
in the BlueBox operations as it will have the effect of erasing this
feature if it is relatively of constant thickness.

3) Several other BlueBox settings to make sure are engaged are in the
Radar Edit menu that line-by-line time 0 correction is being made.
Also, in the Convert menu there is a BlueBox setting to apply
wobble removal or not to apply wobble removal. This should be
based on your equipment and recording. If there is DC drift or
wobble in the raw radargrams then wobble radio button should be
engaged.
Also, for some manufactuers that record 32 bit
radargrams but the true resolution is closer to 24 bit (such as GSSI
equipment), one may want to set a constant gain in the Conversion
menu before starting the BlueBox operation
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4) The next step is to launch the BlueBox Run: XY decoupled
gridding+editing+RSP menu (as show in next diagram):

The user will need to check on all the appropriate checkboxes.
For this example all the checkboxes are on except the Reverse
checkbox as this data had all the line collected in the same
direction.
If the data were collected in a zig-zag method in the
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field, the user must set the info.rev file in the Reverse menu first
before starting the BlueBox operation as well as have the Reverse
checkbox turned on. The user will need to set the differential
search radii that are to be used. The BlueBox operations will
automatically sift through the information file and generate
separated info files (writing work files infoxx and infoyy along the
way) where differential grid search radius is read from inside the
BlueBox menu. For X lines, the user might set the x search to less
than .2 or .1 the profile spacing or even smaller; and the y search
to maybe about twice the profile spacing. For Y lines, the user can
set the x and y search radius to just the opposite. For this example
the search radii are set to .2,4 inches for the elliptical gridding
settings for x lines and just the opposite of 4,.2 inches for the y line
gridding. This BlueBox operation (blue 10) also has the option that
in Grid Math operations to use the Maximum between the X and Y
grids and not to use Grid Math where simple addition is applied. (It
has been found that often using simple addition of X+Y grids can
cause the intersections of the rebar in both direction to be more
strongly weighted, whereas the Max(x,y) setting will give equal
amplitude weighting at the intersection and slightly sharper
imaging. The users can try both and compare for themselves. If
the Max(x,y) radio button is set the ultimate time slices will have
the maxxy identifier added; for grid math the time slices will have
the indentifier x+y applied to differentiate)
5) One of the key settings in the XY decoupled grid operations is also
to use a high number of bins per mark set in the Slice/Resample
menu. The binning can be set to just encompass a few scans as
well. In this example the bins per mark are set to 5. As this data
is collected in inches that would have bins being made at 0.2inch
which is sufficient for this data. For data collected in cm the bins
per mark might be set to a similar value or slightly less, e.g 2-4.
(Note, if ones data for instance only has 1 scan per cm and the
units are in cm, then there is no need to have bins larger than one
since you can not make more bins between just 2 scans)
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6) After all these settings are made the BlueBox operations can be
started.
As the prompt for Bandpass and Kirchoff Migration are
clicked on in the BlueBox will allow the user to make AGC and
bandpass settings as well as adjust the velocity and test the
migration as operations are continued.
The final BlueBox
operations will automatically create a 3D volume and finalize
operations by opening up in OpenGL.
The user can of course
return to the T-Slice/Pixel Map menu and review all the individual
time slices in 2D, as is shown for this example dataset in the next
diagram. (This example data is also available on the Tutorial page
of the website and is a GSSI concrete project)
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BlueBox XY decoupled volume generation
A specialized BlueBox operation XY decoupled volume – will
independently generate separated X and Y volumes using elliptical
volume generation and then add back or take the maxx between the
decoupled volumesvolumes together.
This macro is used only for
surveys which are normally collected on concrete or high density profiling
in both directions
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Note :
BlueBox runs also have several standalone settings in several
menus including the
•
•
•

Slice/Resample menu
Radar Edit Menu
Convert menu.

The Slice/Resample menu has settings for telling the software to compile
the XYZ as regular, 0 mean line, 0 mean grid etc. Radio buttons are
shown in this menu for the user to define what XYZ compilation they
want.
The Radar Edit menu on BlueBox runs has settings to tell the
software to run scan-by-scan or line-by-line 0ns truncation during
BlueBox batch runs. The Convert menu also has a setting to let users
convert 16 bit native data to either 8 or 16 bit during a BlueBox batch
run. Normally all operations on conversion should be done with 16 bit.
BlueBox Run: Load/Save
BlueBox operations allow the user to save any customized settings
and menu items and to recall these settings. The BlueBox Load/Save
menu under the File pulldown menu.
The user can give a customize
descriptive name to all the settings for their BlueBox runs.
These
settings are similar to the complete installation files, and are saved under
a new folder called called \slice\v7.MT\bluebox. The BlueBox macros
have the extension *.blu. Up to 100 different BlueBox scenarios can be
saved and/or recalled at the click of the mouse. The various runs can
have different RSP engaged or different gridding parameters etc.
Any
customized setting or operation can be stored and recalled with the click
of a button.
Note:
The options are endless for generating various processed 3D
volumes in batch using the BlueBox operations in GPR-SLICE v7.MT.
BlueBox operations however, should really only be used after the user
has familiarized themselves with all the manual operations in every menu
in GPR-SLICE. The potential for errors in running the software blindly
through the BlueBox menus, without properly setting all the relevant
parameters in each menu, is highly likely and remains a drawback for
complete automated processing for beginning users.
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STATIC Menu: Overview

This Static menu can currently be used to do almost any kind of
topographic adjustment to data in GPR-SLICE. There are 5 pulldown
menus and various submenu procedures below the Static pulldown:
•

Static - Topography
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•
•
•
•
•
•

Static - Horizon
2D Time Slice + Topo Contours
Make 3D File + Topo
Select Topo File
Open GL Topo Volume Warp
Open GL Topo Volume Warp + Draw

Static - Topography
The Static - Topography has 3 operations available to the users to
make topography corrected radargrams:
•

draw topography with the mouse and perform
topographic correction, writing new binary radargrams

•

import a topography.dat external file that is x,y,z
comma delimited, grid it, extract the topography for
each profile over the topography grid file, and batch
correct for topography making new binary radargrams
for all the files in the project

•

extract topography from the *.gps navigation, grid the
compiled topography, extract the topography for each
individual GPS radargram, and batch correct for
topography making new binary radargrams for all the
files in the project

These methods, explicitly written in the Static menu are shown in the
screen shot (previous page), and are all designed for implementing
topographic corrections.
However, it is no longer necessary to go all the way through these
steps to explicitly make new binary radargrams which are topographically
corrected. The preferred method is to generate the topography grid file
(called topo1.grd) and graphically warp the volume and the associated
radargrams using the Open Gl Topo Volume Warp menu! This does not
require running the batch operations to all the way through to make new
radargrams with the topography - this can all be done graphically without
rewriting new radargrams! This is why in the menu there is written after
the topography grid file is made and before all the optional steps before
binary corrections to ">exit to Open GL Topo Volume Warp".

255

256
Nonetheless, in this manual we will describe all the original options to
also make binary topographic corrections to the radargrams as well as
detail making the corrections via graphical warping.
Draw topography and correct:

The first steps to do are to set the velocity of the site, the new
samples/scan to make corrections over.
The new samples/scan
recommended will be made if a known topographic dataset is imported,
however on first drawing the topography with the mouse, the
recommended new samples/scan is not yet know. You can set this value
so that entire radargram will appear in the correction menu when
topography corrections are being run. Or you can calculate what will be
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needed. For instance, if your total elevation change over a site is 3
meters, and the velocity is 0.1 m/ns, and given the digitization of the
radargrams is 512 and a 100ns time window, the recommended new
samples/scan would be:
new samples/scan

=
=
=
=
=

512
512
512
512
819

+
+
+
+

elevation/(penetration depth)*512
elevation/(TW*V/2)*512
3/(100*.1/2)*512
3/5*512

Because we always want to preserve the original digitization of the
radargram, the extra samples/scan to account for the total change in
elevation in terms of its equivalent scan depth is added onto the
corrected radargrams.
Shown below is the topography for a radargram that was drawn with
the mouse, and after being corrected with a standard topographic
correction. Once the topography is drawn, it will be saved to the project
is after the topographic correction is run. If the topographic correction is
not run, the active drawn topography is lost on exiting the menu. On
reentering the menu, if the topography had previously been created and
stored by running the topographic correction, it can be imported back into
the menu by clicking the Import Topo button. The “standard topographic
correction” simply shifts the radar scans vertically to account for
topography.
This is the most basic way to account for topographic
variation along and to generate to corrected radargrams.
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Topo + Tilt Correction

Another possibility for correcting the radargrams, is one in which the
tilt of the antenna over a site with topography, is also accounted for
(Goodman et al, 2006). Shown above, is the effect that topography can
have on the angle of radar waves going into the ground.
In the
topography menu, an option called “topo+tilt” correction is available.
This correction algorithm will determine the direction of the normal ray to
the topography and insert the radar scan at the appropriate angle in the
binary file. If the data is not sampled sufficiently enough, e.g. the scan
density is low, blank values or region can appear in the topo+tilt
corrected radargram. A del-angle setting is available. Making this value
1 or 2 degrees will sweep the radar scan over a small angle to fill in blank
areas over the radargram.
The del-distance setting is used for
determining over how many scan lines – distance – over which to
estimate the slope of the topography. Using a very small number of
scans, can give yield estimates of the topographic slope that are very
abrupt.
An example of the same radargram being corrected for tilt of the
antenna is shown in the next figure. This radargram was for a velocity of
7cm/ns and a del angle of 2 and a del distance of 10 scans.
(An old
radargram that had meter markers stored in the radargram was used to
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show how the tilt correction gets implemented and is easy to see how the
scan change there location.

Note: In the tilt correction process the tilt of the antenna is measured
from a derivative of the given topography. The user must set a nominal
microwave velocity for the radargram in order for the software to correct
for the antenna tilt across the ground surface. The appearance of the
radargram for topo+tilt correction can change significantly depending on
the nominal velocity used. If the slope changes abruptly along the
ground, it is possible that blank areas can be created in the radargram
binary file during the topo+slope correction process. (See the figure in
the next page). To alleviate this problem, 2 interpolation settings: delangle and del-distance are provided. Del-angle is the angle over which a
radargram scan will be swept or rotated into the binary radargram to fill
in any gaps. A setting of 3 for instance will sweep the radar scan over an
angle of 3 degrees. The radar scan will fill all values that are blank in the
binary radargram (see the following diagram). The del-distance setting is
the number of scans (distance) over which to estimate the topographic
slope.
Using a larger value for this setting will have the effect of
smoothing the topographic slope calculation out. One would not want to
make this setting very large, but using a value that may correspond with
about a meter or so, or some value that gives a good local topographic
slope calculation without having extremely abrupt slope changes is
desirable.
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If the user still any holes in the radargram after running the topo+tilt
(or batch topo+tilt) correction, then the del-angle and/or the del-distance
setting should be increased slightly. The topo-tilt correction with large
values of del-angle will solve some large changes in the topography
however, processing time goes up exponentially. Also, for very severe
topography changes, even with radar scan sweeping, there can be gaps
in the radargrams. To partly help in the reconstruction of these kinds of
sites, it is useful to have more density of the scans per unit distance
resampled during the slice/resample process. The resample scans per
marker can be adjusted in the Edit Info Menu followed by rerunning the
slice/resample process to get denser resampled radargrams.
For purpose of illustrating the importance and the effects that tilt has
on a radargram with different nominal velocities of 0cm/ns, 6cm/ns and
12 cm/ns being used, is shown (after Goodman et al, 2005) is shown.
For higher velocities some
subsurface features can be projected to be
much smaller or larger depending on the topography profile. When the
velocity is 0 - the typical standard topographic correction will ensue.
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Import topography and batch correct

Topography can also be automatically developed for radargrams from
a digitized contour map, a digital elevation model or any file describing
the topography. The name of the file to import must be:
•
•
•

called topography.dat
exist is in the \dat\ folder of the project
must be 3 columns, comma delimited file x, y, t where x and
y can be any distance unit but the t must in the depth unit
set in the Options menu (usually m)
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Once this file is placed in the \dat\ folder, the velocity of the site is set,
and the desired new samples/scan is placed into the menu (see previous
section) the user clicks the button Import \dat\topography.dat button
which will read the file, report the zmax and zmin in the file as well as the
total number of elevation points (see screen shot). Absolute elevations
or relative elevations can exist in the file. (GPR-SLICE can also report
absolute elevation in terms of relative elevations by setting the desired
display of data in the Options menu).
Explicit steps are:
Step 0.1) Set the radargram directory to the desired filtered directory
Step 0.2) Set the microwave velocity in meters/ns that was discovered in
the Search Hyperbola process in the Filter Menu.
Step 0.3) Set a New Samples/Scan length for the set of new radargrams
to be written into the \topo\ directory.
For instance, if the total
topographic relief of surveyed site is 2 meters and for example the total
penetration depth was by chance also 2 meters, then the user should set
the New Data/Scan to twice the recorded data/scan. (See previous
section for more discussion on setting the new samples/scan)
Step 0.4) Click the Create Info Topo button to make a secondary
information file appended with the name topo. This new information file
will contain the updated samples/scan for the static corrected radargram.
This new file should be made active on display of all corrected radargrams
– but it should not be active in the Edit Info File menu while the initial
corrections are being done. If binary corrected radargrams are not
needed since only Open GL Topo Volume Warping displays are needed,
then skip this step.
Step 1) Import a topography.dat file by clicking the Import Topography
button, which creates a topo1.dat. Note that the topography.dat file
should have 3 columns that are comma delimited and without any
header. The columns are x, y, and z where z is elevation in meters. The
elevation can be relative or absolute as the import option will convert
absolute elevations to relative measurements.
Step 2) Click the Grid Topo1 button which will open the Grid Menu. Grid
the topo1.grd file. Make sure the xstart, ystart, xend and yend values for
the grid are all inclusive for the radargram locations in the information
file. Exiting the Grid Menu will bring the user back into the Static Menu.
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Step 3) Click the Create Topo button, which will extract the individual
topography profiles for each radargram (and write them to the \topo\
folder).
Step 4) Click on the Draw Topography submenu and choose between the
batch buttons for either standard topo correction or the batch operation
in the Static Corrections menu. If you are going to work on just a single
radargarm, don’t forget to click the Import Topo button to get the
topography profile read in. If it is not read in, then whatever the active
topography - even if it is set to 0 - will be overwritten. On Batch
operations, the software will automatically read in all the topography
profiles before running the correction.
Note: To view the topographically adjusted - binary radargrams in the
Radargram Menu, the user must click the Create Info Topo button in the
Static menu. This will create a replica information file (e.g. infotopo.dat),
with two different settings - the samples/scan is adjusted to match the
New Data/Scan value used when correcting for topography and a new
time window will also be computed. The new time window reported in
the infotopo.dat is given by:
New time window=Old time window*(new samples scan)/(old samples/scan)

Extract GPS/NAV/Vector Topography and Correct
Automatic elevation correction for GPS radargrams can be
implemented in the Static menu.
GPS elevation corrections using the
elevation information stored in the 3rd column of the standardized GPRSLICE *.*.gps files that are generated from the raw gps log files. This is
done for all manufacturers log files converted to GPR-SLICE that are
recorded.
There are 2 main steps in doing batch corrections for GPS
surveys. The steps are outlined under the heading of Extract GPS/NAV
Topo and Batch Correct.
Clicking the button Extract GPS/NAV/Vector
topo will cause GPR-SLICE to read all the *.*.gps files and store the 3rd
column into work files. (As is done in typical elevation correction, GPRSLICE uses a file generated called *.ctm located in the \topo\ folder for
the project which has the elevation converted to equivalent scan depth
for each recorded scan in the radargrams).
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If the GPS is recorded every second or every constant number of
scans, GPR-SLICE will interpolate the GPS elevation to generate an
elevation correction for each individual scan when the Extract GPS/NAV
Topo button is clicked.
The next step is to run the Correct operation
which will launch the Static Correction menu. From here the user can
either do batch processing or single line processing, in addition to topo +
antenna tilt or corrections without compensating for the tilt of the
antenna. An example of automatic GPS elevation correction is shown in
the following diagrams along with the complete orientation of the GPS
radargram in 3D space.
Note: Just like normal topographic corrections, the user needs to first set
the velocity and the new samples/scan in the Static menu.
In the
example below topography over a GPS radargram is drawn. Note that
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the bottom of the radargram is cutoff in a few locations. Should bottom
part be desired or if more of the bottom part of the new radargram is
desired to be cutoff, the new samples/scan must be adjusted first in the
Static menu.

Topography smoothing
The user can also use grid smoothing on the Topo1.grd to create a
filtered-smoothed topography grid.
Or directly in the Static Correction
menu, the user can click the Smooth Topo or Batch Smooth button.
The user should make sure to use enough grid cells so that when the
corrections are implemented into the radargrams, that the topography
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looks continuous and not blocky. If it looks block on extraction, then it is
useful to use the smoothing button in the menu.

Topography smoothing can be implemented in batch operations in the
Static Menu. These operations can be done on regular or GPR/GPS
surveys.
Particularly for direct GPS elevation profiles, topography
smoothing prior to correction is sometimes necessary since these direct
files can often be noisy.
An example of a topography smoothing
operation using a filter length of 32 is shown in the diagram above. Data
of this quality is very subjective on whether to actually use it or not.
However, in lieu of poor elevation recording with the GPS equipment,
using highly smoothed elevation profiles may be preferable to no
corrections being done at all.
Note: Batch correction for standard topographic corrections are very
quick - however topo+tilt corrections can take 5-10 time longer to
execute.
Absolute elevation in Open GL and Radar 2D menus
Time slices, radar menus,or Open GL Volume menu with topography
warping can show relative or absolute elevations. The flag is set in the
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Options menu for the desired elevation display. Setting the option to
Absolute will show depth labels with Z decreasing downward and starting
at the true elevation either detected in the topography.dat files imported,
or from the NMEA strings and the elevation in the *.*.gps log files.
An example of a GPS data warped into topography and labels with
absolute elevations is shown.
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Horizon Detection and Mapping

An option to automatically detect and map 8 subsurface horizons has
been implemented in the Static Menu of GPR-SLICE v7. The StaticHorizon submenu can now automatically discover the peak reflection
within a user specified scan-sample window. Shown in the following is an
example of the operation of the menu. The sample start/end is the range
for discovering the peak reflection. Running the Auto Detect will
discover and display the peak response. There is an auto filter switch
which is available in the menu. The auto filter switch will compare a
moving average with the discreet profile to try and remove noisy points
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real time along the profile. In the case when the filtered profile still has
problems, the user can click the Import/Edit Horizon button and fix the
profiles with the mouse very quickly. A N-scan wide mouse cursor is used
to help quickly re-draw bad points along the profile that are not well
predicted. The automatic horizon detection can be run in batch as well
using the Auto Detect Batch button.
To start the automatic horizon detection the user should
1. set the sample start/end over which to search the peak response
2. set the Nbackup which will back up or move forward a desired
number of samples of the digitized scan on the detection
3. set to search the peak + or the peak - part of the pulse over the
sample window
4. set the Horizon # to assign for detection
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5. Click the Auto Detect button to start the horizon search and
mapping
Once the horizon is detected it will be drawn on top of the radargram with
the assigned colour for that horizon that is set in the menu. Once the
horizon is drawn, the user can either engage a filter to smooth the
detected horizon.
The filter works by taking a scan length and a
threshold. A moving average of the detected horizon is computed. If
the local point is N threshold samples different than the moving average,
then the filter will reset the local horizon to the moving average. Shown
in the next figure is an example of a noisy detection which is easily fixed
by run the Auto Detect with the filter engages (in this example the filter
length is 10 scans and the threshold is 7). The user can also highlight
any detected or drawn horizon by clicking the Draw/Edit button and then
modify this horizon with the mouse if desired. Clicking the Save button
will update the active horizon.
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In addition to mapping the horizon depth using set velocities for each
layer, the /amplitude of the horizon can also be shown. The previous
diagram shows the amplitude of each detected horizon. (All licenses are
given access to these options. Metal plate calibration layer thicknesses
shown in the section after Auto Horizon Filter Settings are only available
for licenses for GPR-SLICE v7.MT that include the full road license
option).
There are options to have all the detected horizons to be displayed on
multi-radargram displays in GPR-SLICE by using the flagged checkbox in
the Options menu (as shown in the following figure):

Horizon Reporting
Once horizons are detected they can be compiled in several formats.
The Compile Horizon#+Horzamp#+Exp#
+ Recompile ExportHorzXYZ# operations (where # is the desired horizon) will write 4 files:
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There are several options available once the horizon profiles are
created. The user can compile (step 2 in the previous screen shot in the
Static menu) all the drawn/detected horizons to 4 different files:
horizonN.dat – A file written that contains the x,y and depth of the Nth
horizon based on the velocity model used in the Horizon Detection and
Mapping menu. The depth of the horizon is written in equivalent samplescan depth corresponding to the radargram.
horzampN.dat – A file containing the x, y and amplitude of the Nth
horizon, where the amplitude is the actual binary recording on the
horizon.
export –horzxyz.dat – A file for export that is x, y, zn, zns, zd, where
zn is the depth in digitized samples on the pulse, zns is the depth in
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nanoseconds, and zd is the depth based on the velocity model and for
every scan in the radargram
re-export-horzxyntz.dat – A file for export that contains statistics and
x, y, zn, zns, zd, where zn is the depth in digitized samples on the pulse,
zns is the depth in nanoseconds, and zd is the depth based on the
velocity model. Export is made at the desired linear density along the
radargram.
(For GPS radargrams the linear density is found by
integrating along the track for reporting).
Export horizons can be recompiled to any desired linear density along the
GPR track using the Recompile Export-HorzXYZN operation. This
operation will create a Re-export file on the desired horizon that will also
contain the median, average, maximum and minimum in the file. An
example of the file is shown in the previous diagram.
All the horizon
reporting files are written in the \dat\ folder of the project.
Either of the horizon.dat or horzampN.dat files can be gridded (step
3) in the GPR-SLICE Grid menu to create a 3D horizon slicing surface or
2D horizon amplitude maps. These files are all written to the \dat\ folder
in the project. The 3D horizon surfaces can be shown in Open GL Volume
menus. The horizon surface grid files can also be processed or smoothed
just as any normal grid files are processed.
Sometimes when the horizons are drawn by hand, a small 3x3 low
pass filter is often useful to smooth out the bumpiness in the hand drawn
or auto-detected horizon profiles that were detected without a filter
engaged. The horizon profiles can be “re-extracted” from the smoothed
grid file for all the radargrams by clicking the “Create Horizons” button
(Option B). Making the horizon correction followed by time slicing the
horizon corrected radargrams, essentially give one horizon slices as
opposed to our normal 2d "flat" time slices.
Another option (C) that is available in the Static Menu for horizon
operations, is the ability to create “inverse – horizons” or apparent
topography profiles from the horizon profiles. In the case when a known
stratigraphic reflector at depth is flat across a site and that site also has
above ground topography, horizon correcting this layer to be flat, the
apparent topography of the site can be detected.
The topography is
simply the inverse of the horizon profile. Clicking the “Inverse Horizons =
Topo” button, will generate *.ctm files from the Horizon1.grd file, for
each radargram contained in the survey. (Note: The *.ctm files can then
be compiled to the topo1.dat file and gridding options here can be done
to create the topo1.grd file if desired).
274

275
Import of external layer horizon data for OpenGL
An option was added to the Import 2D Geophysical Data which allows
gridding of any dataset into GPR-SLICE. If the output file name has
"Layer" in it on import, this data will be recognized as a flag to add into
the Horizon listbox in OpenGL. The new option also has additions of
several menu slots to adjust the import data either for scale or to change
depth data imported into elevation data. Other recent additions in the
Import 2D Geophysical Data menu are the option to translate imported
data with a logarithm such as was recently needed for a recorded
resistivity dataset.

Example of importing an external layer dataset into OpenGL.
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Overlay of horizon profiles in OpenGL for GPS radargrams
A request was made by Professor Allen Gontz at the Geology and
Geophysics Dept at San Diego State University, in addition to being able
to show horizon surfaces, to also just show simple horizon profiles on top
of GPS radargrams in OpenGL. This new option was recently added. To
launch, the overlay horizons must first have been detected and the
checkbox switch – overlay horizons – turned on in the Options menu.

Example of horizon profiles shown on GPS radargrams in OpenGL.
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Metal Plate Calibration – Automatic Dielectric Calculations for
Layer Thickness
GPR-SLICE has been programmed to do automatic dielectric
calculations of the surface layer using air launched – horn antenna. In
this highly practiced technique in road surveys, a metal plate is used to
measure reflections back to an air launched antenna. These calibration
amplitudes are then compared with ground surface reflections. The
dielectric of the top surface E1 can be found using the formula (after:
E1= [(1 + A/Am) / (1 - A/Am)]

2

where A=Amplitude reflection from top surface
Am=Amplitude reflection from metal plate
(after Saarenketo, 2009. NDT Transportation p395-444, in Ground
Penetrating Radar Theory and Applications, ISBN 978-0-444-533487).
The method can be extended down to the next layer yielding the
dielectric of the 2nd layer interface as (after Saarenko, 2009)
E2 = E1 (1 – (A1/Am) 2 + (A2/Am) 2)2
(1 – (A1/Am) 2 - (A2/Am) 2)2
With these automatic measurements, layer thicknesses of the top two
layers can be generated. To use this feature, a file called metal plate.*
must exist in the \resample\ folder of the project, and the Horizon
detection must have been run on it. Clicking the button “Calibrate Metal
Plate”, the average amplitude reflection across the first detected – ground
surface reflection – will be computed and stored in the menu item slot on
the left side of the menu
Shown in figure on the next page is an example of the Horizon
Detection and Mapping menu displaying 1) detected horizon profiles, 2)
set layer thicknesses determined from velocity settings for each layer, 3)
horizon amplitudes plots, and 4) layer thicknesses computed
automatically using the metal plate calibration formulas.
In this
particular example some dispersion can be seen between the 2nd and 4th
plots, but some correspondence is seen. Neither layer thickness plot is
absolutely correct since attenuation is assumed to be nil in the metal
plate method, and the constant velocity assumption for the 2nd plot could
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be an over simplification of the actual velocity variations in the subsurface
layers.

In the above diagram a screen shot of the Horizon Detection and
Mapping menu launched from inside the Static menu is shown.
With
typical licenses, automatically detected horizons and the layer thickness
plots are available (top 2 figures).
With expanded Road license
capabilities, surveyors can report horizon amplitude plots as well layer
thicknesses computed from metal plate calibrations.
The Caltrans
Standard button for generating the California Dept of Transportation
required data reporting is also accessed from this menu.
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The Horizon Detection and Mapping menu is quite flexible in
generating displays of very large datasets and placing these in to any size
screen. In the above example taken from a 20km survey of downtown
Dallas using horn antennas, a total of 88457 GPS pts were collected. The
horizon detection can be shown for all 88457 pts or any portion thereof.
By setting the range start/end and clicking the Scroll button any portion
of the super long radargram profile can be displayed to the screen. The
scrolling length of the window can also be changed to any desired length.
This example was made to show on a single screen, however, the X pixel
length setting in the menu could easily be set to 3000 or 5000 pixels for
example and 3-5 screen lengths for showing the desired horizon mapping
could be generated. The dialog can also have a jpg dialog dump which is
not limited to the size of the computer display – but is set to the length
chosen in the menu by the X and Y pixel length. Any portion of the data
– and any size of output can be easily generated with GPR-SLICE v7!
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Drill Core Information Overlay

Information from drill cores on a site can be displayed in the Horizon
Detection and Mapping menu as well as in OpenGL Volume Draw menu.
The information from the drill core are written to files that must begin
with core*.dat and are stored directly in the main project folder. The
format of the core file should be
Core***
Range along profile, x, y,core radius
1,thickness,”material name”,,color number (1-10)
2, thickness,”material name”,color number (1-10)
Etc
N, thickness,”material name”,color number (1-10)
Core*** repeat
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An example is shown in the previous screen shot with 3 cores in the
Horizon menu and the same data in OpenGL Volume Draw menu along
with a screen shot of a core file format below. The radius of the core can
be customized in the file. If it is not set the default radius in the OpenGL
Volume Draw menu will be used.

Depth Radargrams
Almost always, radargrams that are displayed are usually shown in
time. Often a depth scale is provided which is based on a nominal
velocity across the site. These radargrams are usually though just
referred to as “time” radargrams as they do not account for laterally
varying velocity layers. Using the Horizon menu and detecting up to 8
horizons including the ground surface, an actual depth radargram can be
converted using the layer velocity model and the horizons detected.
GPR-SLICE will adjust the depth the binary values in a radargram based
the actual velocity between chosen layers and using their interval
velocities. If some layers have very slow velocities, these regions of the
radargram will look much narrower in actual depth then as seen on a time
radargram. Likewise, layers with much higher velocities will be adjusted
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to their true variable thicknesses across the radargram and these regions
will be much thicker than in the time radargram display.
To make a depth radargram, the user will first set horizon 1 – the
ground surface horizon, followed by the next horizon #2 and so on in the
Horizon Detection and Mapping menu found under Statics (see next
screen shot). Once the horizons are set along with their respective
velocity, a z cell size along with the maximum depth desired to convert
the radargrams is chosen. The cell size will determine the digitization of
the depth radargram in the vertical.
One should currently choose a
value - along with a maximum depth setting - that will generate a depth
radargram that is slightly lower in the original time radargram
digitization, such that no null cells are created.
Clicking the Depth
Radargram button, will start the conversion from time with the final depth
radargram being written to the \topo\ folder. After execution, a new
message box detailing the info-depth.dat information file and the
corresponding samples/scan of the depth radargram will pop up to the
screen. The depth radargram can then be independently displayed in the
Radar 2D menu (see screen shot following pages).
A special radio
button in the Options menu will force the y axis display to be just in
depth.
For depth converted radargrams, the time window is replaced
with the depth in the profile information file!
Note: Depth radargrams will not be flat on the bottom depth range if
velocities are different between the layers.
Null binary values are
recorded in the radargram on the bottom.
One can adjust the end
sample display if they wish to cutoff the variable bottom in the Radar 2D
menu and not show the null data.
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Figure 1. Depth radargrams, converted using the layer velocity models,
are now available in the Auto Horizon Detection menu.
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Figure 2. Converted depth radargrams can be displayed with only depth
labeling using the “depth” radio button in the Options menu.

Horizon Correction
The Draw Horizon Menu has options for drawing a horizon profile
across a radargram following a stratigraphic layer. The horizon correction
will “back correct” the horizon to be flat and write a horizon corrected
radargram.
All static corrections for both topography and horizon
operations on radargrams are written to the \topo\ folder.
Horizon
corrections are useful when time slices that are not level across the
radargrams is desired. Once the radargrams are horizon corrected, then
regular time slice processes are applied to this dataset. In essence, a 3D
slicing surface can be generated in order to create “horizon slices” – slices
that follow the 3D surface.
Shown below is an example of when horizon slices are more useful the
level time slices.
If one wants to find anomalies within an undulating
subsurface layer, then making level slices in time will create anomalies
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which are more sensitive to stratigraphic changes. A horizon slice which
follows the undulating layer will have a better chance of imaging
anomalies which are buried within the undulating layer. Horizon slices
have been used to map pit dwellings within undulating living surfaces
from the Jomon period in Guma Prefecture.

Level Slice

Horizon Slice

In the Draw Horizon Menu, the user can draw a horizon profile across
the radargram and then run the Horizon Correction process. The process
can also be run in batch by importing an xyz horizon file following the
steps similarly given for the batch topography operations.
The
microwave velocity and an appropriate new samples/scan need to be set
in the Static Menu before beginning horizon operations.
Horizon corrected radargrams are also written to the \topo\ folder.
Running the standard slicing procedures on the \topo\ folder (making
sure to create a new info file, e.g. infotopo.dat with the new
samples/scan included), horizon slices will be generated. Horizon profiles
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are stored as *.hoz files in the \topo\ folder for each radargram.
An
example of a horizon correction made on a is shown below for the 3rd
Horizon detected.

Horizon Slicing
Horizon surfaces which are generated in the Static menu can be used
to slice the Open GL Volume using the new “H” button. To access this
feature, the desired horizon detected is highlighted in the Horizon listbox.
Clicking the “H” button will display the horizon surface and the amplitudes
within the volume. Horizon surface amplitudes are particularly valuable
in finding amplitude changes following variable subsurface stratigraphy.
In archaeological applications, non-level ancient living surfaces can be
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mapped and reflection changes following this ancient surface can yield
areas where pit house or other archaeological features may be hidden.
Simple level time slices would have imaging artifacts associated with
slicing through subsurface topography which would usually hide buried
features.
An example of horizon surface mapping is shown below. This horizon
project is part of the Kisatchie Advanced Workshop folders available on
the ftp site (www.gpr-survey.com/practice).

Another example of a horizon mapping image was developed by Jason
Herrmann from the University of Arkansas and used in his study of
ancient living surfaces beneath sand dunes in the United Arab Emirates.
Jason’s has used topographically corrected radargrams and then detected
horizon surfaces using the automatic features in the Draw Horizon menu.
He then compiled and gridded the horizons from the Static menu and
displayed these surfaces in the Open GL Volume menu.
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Note: The horizon surfaces displayed are made from the time windowed
- and spatially averaged reflection amplitudes for generating the 3D
volume.
An alternative horizon dataset can be generated which
represents just the peak response of the detected horizon – using a single
value of the peak response.
When the auto detection process is run in
the Horizon Detection and Mapping menu, in addition the horizon profile,
the amplitude of the detected horizon is output to a file in the \topo\
folder called horzampN.dat as previously discussed. These horizon
amplitude files can be gridded and displayed in the regular 2D Pixel map
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menu. These values represent just the peak response of the detected
horizon and do not represent windowed horizons which are generated in
the 3D volume. Either the peak + or peak – response can be detected
and reported in the output files.
Note: To get the best horizon slices it may be necessary to increases the
number of interpolations to generate rather denser 3D volumes in the z
direction for import to Open GL.

2D Time slice + Topo Contours

Time slices can be overlaid with the topographic contours. This option
is entered through the Static pull down menu. An active topography file
which has the exact same starting and ending locations as well as the
same grid cell size as the time slice must be used. The topography file
will normally be imported in the Static correction menu and then gridded
over the same area and grid cell size as used for the time slice maps.
Level plane time slices made from either topography corrected
radargrams or even extracted from topography adjusted 3D volumes can
be displays with the topo contours. Even imported data (e.g. from mag
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or resistivity or em) can be overlaid with topo contours as long as the grid
sizes and cell sizes are the same.
Note: The number of contours to use for the topo map is set in the
Options menu along with the contour pen thickness.
OpenGL Topo Volume Warp menu – real time topography

“Real time” level slices can now be shown along with topographic
slices on the Static pulldown menu. Real time nomenclature is used
since the topography adjustments are applied by topographic warping
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of the OpenGL Volume by reading the active topography grid file.
Before, the only way to get a level plane time slice from a volume with
topography was to generate the topographically corrected volume first
and then display level slices in regular OpenGL (discussed in next
section). The new option will allow for displaying level plane slices very
efficiently particularly for sites that have significant elevation changes.
Some users were unable to make a corrected topographic volume
when elevation changes were on the order for 20 meters or more as
the binary corrected volume would be too large to render in OpenGL.
This new option to generate level slices real time without creating a
new volume will add a lot of efficiency for looking at topographic
volumes. When entering the OpenGL Topo Volume Warp menu a new
button called ZL will appear which can be used to set the level slice
plane. The original Z button is there to and called ZT to indicate that
this is for a topographic Z slices.

Level Plane 3D Slices – via Making a 3D Binary File + Topo
An option exits in the Static pull-down menu to create a standalone
3D binary file which has been adjusted for topography. The requirements
are that the X and Y dimensions of the 3D binary file and the topography
file must be the same.
The new topography adjusted 3D file will have a
Z dimension which is the addition of the 3D file Z dimension plus the
effective sample depth of the topography. One should be careful in
creating these topography files as the size of the 3D topography adjusted
files can be quite large. In this case, just doing level slices via the
OpenGL Topo Volume Warp menu in the previous section is
recommended.
The new filename for the topography adjusted 3D file is automatically
written automatically as “topo- + original 3D filename.dat”. This filename
can be entered into the Select 3D File slot in the 3D Volume menu and all
the 3D volume display options are available. The advantage of using the
3D topo adjusted file is that the user can make 3D level plane time slices
in the normal Open GL Volume menu.
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Animation Menu: Overview
Creating a Stand Alone Animation Folder

The user can create a stand-alone folder which contains all the
animations created in their GPR-SLICE project. The animation software is
available to GPR-SLICE users and they can give this portion of the code to
their clients free of charge without a license. To create a standalone
animation folder, do the following:
1. Create your animations, currently up to 30 per project
2. Click the “Export Animations” button at the bottom of the
Animation List Menu (see menu picture below) …. that’s all
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The action on step 2 will create a separate folder in the project called
\animation\. This folder contains the GPR-SLICE Animation.exe and the
necessary dlls (dynamic link libraries) for the exportable animation to
run. The folder will also contain a copy of all the JPGs (BMPs) that the
user created for the animation.
GPR-SLICE has the capability to show 2 animations running
simultaneously on the computer screen. Whatever animations are kept in
the Animation list, will appear as button on the left side of the animation
menus. To get an animation to run, first click the desired animation
button, then click the Bounce button. The animation will run from the top
down. The user can pause, or step through the animation one-by-one by
clicking the appropriate menu buttons.
A convenient scaling button is
also on the menu. Scaling the animation can degrade the picture for the
animation since raster graphics are being used.
An example of 2 different animations that the user can generate and
have run simultaneously as different threads is shown:
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AVI creation
Via the Animation menu, a button called export to AVI video will
read jpg animations and create an AVI. It is recommended that the Full
Frames (uncompressed) setting be used so that no loss of resolution in
generating the avi file occurs.
The avi file will be written to the \jpg\
folder of the project,.

Special Topics
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OpenGL Volume + Gridblock menu: Composite Zscan imagery
generated from individual block volumes
One of the major obstacles in OpenGL for multichannel users has been
to render large sites. For most sites, reading in a single volume of 200500 mb which might comprise about 1-2 hectare of data was about the
maximum capability. To increase the sizes of a site that can be rendered
in OpenGL a new option to create a composite of all the gridblocks
generated for a survey is now available.
In the Multichannel 3d Radar Pulse Volume menu on completion of
creating block volumes, a new file with the append identifier
“gridblock”+3D volume name will be generated. Selecting this file in the
Select 3D File menu will allow the user to open the abbreviated OpenGL
Volume + Gridblock menu which will tell the software to compile Zscans
from all the available individual blocks comprising the survey. The new
option is currently limited to just the Zscan imagery at present and
memory is conserved by just reading in the individual blocks one at a
time and then releasing this memory to insert the next block. Because of
these memory conservation considerations, isosurfaces are not available
for the composite render.
With the new option, users should be able to display significantly
larger sites surveyed that are created with block gridding. OpenGL
Volume Gridblock + Draw menu is also available for interpreting and
drawing objects on top of the composite Zscan image. An example of a
survey made by our subscribers Socotec in the UK along with our newest
distributor Allied Geophysical in the UK, a survey on a road that
comprises 450m x 1300m (next figure). Gridblock operations were set to
50x50m blocks and generated 234 blocks. About 49 blocks of the total
234 blocks are actually compiled as the blocks in red are empty blocks.
Each 49 blocks is about 75mb or 3.7 gb for the volumes. The individual
block volumes can actually be even higher resolution and up to about
500Mb. For the xy grid cell size and volume data were compiled at the
antenna channel spacing of 0.085 cm. There is no limitation on how big
a gridblock site can be since none of the blocks are read into memory
except the active block to composite the image together. The ultimate
limitation on a site may be the graphic card. But sites several square
kilometers and more should be accessible now for imaging with the new
menu.
The response of step down in the volume is also reasonably
responsive.
Recently another subscriber made nearly solid imagery on a site that
had 266 gridblocks. Most blocks were filled and the total volume which
was made at a higher resolution of 4cm cells using multichannel
equipment had a total of 70gb of volume rendered in the new menu!
Survey sizes up to several kilometers are no longer a problem to render
296

297
in OpenGL! We are waiting to hear from users that may need to provide
surveys to see how the software responds for 5-10km of kilometers and
what limitations there could be?

Gridblock operations were also modified to allow an overlap between
the discreet volumes. One user found that when drawing utilities on a
single gridblock it helps to see the continuation of anomalies slightly into
the surrounding blocks. The overlap settings is available in the volume
generation menu. For volumes created with overlap, the recompositing
all the gridblocks back into a single image that have overlap is integrated
into the OpenGL display.
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Mosaic Correction
Ground Penetrating Radar (GPR) radargrams can be subject to a host
of noises, including mosaic noises.
Mosaic noises represent abrupt
changes in background reflection strengths recorded between adjacent or
nearby survey fields. The abrupt changes can be a result of equipment
noises, geological noises, and/or varying field conditions caused by
weather. In addition, untrained operators of GPR equipment can also
accidentally insert mosaic noises into the data if inconsistent radar control
unit settings are used to study a site. GPR surveys which occur over
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several field days will often lead to inherent mosaic noises in GPR
datasets, since soil conditions can vary significantly day-to-day.
Whatever the cause for mosaic noises, their removal during post
processing is essential to detecting continuous subsurface features across
a site. In GPR-SLICE v7.MT Software, several methods currently exist for
removing mosaic noises. Some are in the stand along Mosaic Correction
menu and others are located in the Slice/Resample menu with corrections
made to the ASCII time slices. The most time consuming corrections but
which can always give the best results involves making subgrids,
adjusting the transforms individually and appending the subgrids to
combined grid in the Pixel Map menu.
Among the mosaic corrections available are:
•
•
•
•
•

Screen capture and gaining (Mosaic Correction menu)
A variation on screen capture with regridding (Mosaic
Correction menu)
0 median grid/ 0 mean grid (Mosaic Correction Menu)
Transform matching and grid appending (Pixel Map menu)
0mean grid/ 0mean line/ Edge matching /Histogram matching
(Slice/Resample menu)

The first method involves capturing rectangular areas which have
different gains and then adjusting real time.
A variation on the first
method where the gains used in the real time adjustments on blocks are
then used in the re-grid calculation. The other methods involve breaking
a large survey grid into numerous sub-grids where mosaics are identified
and then applying some kind of data transforms to best match all the
sub-grids. A composite grid containing all the transform adjusted subgrids can then be synthesized.
Another method involves simply
capturing individual mosaic regions from within the large image
containing mosaic noises, and applying gaining to individual areas real
time.
Some statistics can be applied which can match the median or
background values between sampled areas automatically.
Mosaic corrections have been successfully applied in many GPR
surveys, including a survey at the Irebaru site in Chatan City, Okinawa by
the Geophysical Archaeometry Laboratory. Severe weather conditions
caused extreme noises in the time slice datasets. Shown in the diagram
in the next page is a time slice map with a mosaic problem. The mosaic
was caused by rainy conditions that altered the background reflections
above y ranges of 20m
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Mosaic Correction Method:

Screen Capture and regaining

The easiest way to fix mosaics is too launch the Mosaic Correction
Menu located on the Pixel Map pull down menu (see diagrams on the next
page). In this menu the user has the ability to capture areas with a
mouse and then apply or decrease the gain in the area. Clicking the
gain+/- switches will add or decrease the reflections in the captured area.
The user can use their eyes to determine when a good match is made. If
they like the correction, by clicking the “Write New Grid” button, a new
grid with the prefix “m” will be written. The time slices displayed in the
menu are chosen from the setting in the Pixel Map menu. The user can
import other grid numbers in the dataset in this menu. Also, a button to
add, rather than multiply grid values over the captured mosaic region is
available. Clicking the DC +/ will add or subtract values. Adding values
rather than multiplying will bring colors up gradually across the whole
map ( In future versions, some statistic will be available which will
automate some of the processes in the Mosaic Correction Menu).
The user can also use the Div +/- buttons in the Mosaic Correction.
In this application, the user must first set the division file in the Edit Info
File menu where the radargram blocks begin. The first radargram will
always need to be checked on in the Division file followed by checking
every radargram where a new block of data with noises exist.
Once
these are set, clicking the Div +/- will automatically discover the
rectangular regions across the grid corresponding to those different subgrids that have mosaic noises. As the Div +/- button is incremented the
online box will increment to different blocks.
The menu options can also be used to highlight an individual area
within any chosen part of the time slice map, as is shown on the mosaic
corrected image in the following page where a small rectangular block is
emphasized.
Note1: In implementing mosaic corrections, it is often better to work with
the unsmoothed grid set. After mosaic corrections are made, the user
can apply a lo-pass filter to the corrected grid, e.g. either a 3x3 or 5x5 lopass filter, to better blend the edges of the mosaic regions.
Note2: In correcting for mosaics, it is best to gain the area of the time
slice maps which have either real weak colors or too strong of colors
contrasts. For instance, in the example in the following page, the region
above the line y=20m has overall weak colors in the map – e.g. too much
blue and reflections are weak overall. The area below y=20m shows a
well balance in color contrasts across this region. It is thus best to adjust
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the top region to match the bottom region in order to create maps with
more “equal” contrasts in them.

Variation on Screen Capture with Re-gridding
The Re-grid option can also work very effectively in the menu to adjust
mosaic noises. In this operation, the user sets the desired block with the
div+/- button, adjusts the gain or the dc offset to balance the data with a
nearby block, then uses the Re-grid button to re-grid the *.dat using the
adjustments. While applying the gain or dc adjustments to the actual
grid, edge effects will be seen in the drawing along the block edges. This
is to be expected since the gridded data at the edges were generated
with unmatched searched data from both nearby blocks. However, on regridding, the original *.dat is used to recalculate the grids and those edge
effects will not be present after the operation.
For 0 median and 0
mean grids, new *.dat and *.grd data are generated with the "0m"
appended identifier. For the Re-grid option, the *.grd is overwritten with
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the original name. For 0 median and 0 mean operations and the Re-grid
option, the original *.dat must exist for the corresponding displayed grid
file. Direct gaining on the *.grd file real time with writing to the
"m*.grd" file is available and does not require *.dat data to exist.
Mosaic noises (top) and a mosaic corrected time slice (bottom),
method #1. A highlighted area is also shown as an option for display in
this menu.
Mosaic Correction Method:

0 MedianGrid/ 0 Mean Grid

An algorithm to try and automatically correct mosaic correction is
available in the stand-alone Mosaic Correction menu.
The operation
works by calculating the median value of each defined grid division (set in
the info menu) and then normalizing all the blocks by their median
value. For certain kinds of surveys noises the median grid algorithm
may work to balance the different survey blocks. This method is best
suited to surveys where the distribution of data is similar in each of the
blocks. e.g. the same number of weak, medium and strong anomaly
areas are about the same density in each of the blocks.
0 mean grid
operations are also now provided in the stand-alone Mosaic Correction
menu. To properly view the 0 median corrected grids, the user should
run the operation on grid #1 so that this grid set will appear in the Pixel
Map for further viewing an display.
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Mosaic Correction Method: Transform Matching + Grid Appending
One of the problems with the first method for correcting mosaics is
that sometimes non-rectangular areas have mosaics.
Currently the
Mosaic Correction Menu only provides for capturing rectangular areas to
correct. Also, even with making a good match between areas along with
lo-pass smoothing, there may still be a significant looking streak at the
edges of the mosaic regions. A more involved method which can give
similar if not better results is to break the grids with mosaics up into 2 (or
more) different grid sets. For instance, the radargrams up to an including
the first mosaic can be used to create the a*.grd files, and the second set
of radargrams can be used to create the b*.grd files.
Once these are
generated the user can type by hand, the grid names a1.grd, b1.grd into
the 1st and 2nd positions in the Pixel Map menu. The next step is to
display the time slice maps and then one can adjust the individual
transforms to get a match in color between them. Once a good match is
made, clicking the “Append” button will write a new grid, in this case
“ab1.grd”.
Both time slices for this example had the same initial color transform
applied (square root). To match the maps a transform which lowered the
overall reflection in the bottom time slice was manually drawn (bottom
diagram). An example of showing the two grids with different mosaics
broken into an “a” and “b” grid set is shown in the following diagram.
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Mosaic noises in two adjacent grids (top) and mosaic adjusted maps
showing the transform used on the 2nd grid to match colors with the first
grid (bottom).
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An example of the appended grid from using transform matching is
shown in the following screen shot:

This method of transform matching can be expanded for more than 2
areas where mosaics appear in a large site that surveyed. In this case
the a,b,c, …. Gridsets are created and then transform adjusting and
finalized by appending all the grids to a single grid.
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Automated Mosaic Corrections: 0mean grid /0mean line/ Edge
Matching / Histogram Matching (Slice/Resample menu)
Automated mosaic corrections are also available during compilation of
the time slice data in the Slice/Resample menu. 0 mean grid, 0 mean
line, edge matching, and histogram matching have been developed to
automatically correct for mosaic.
The automatic mosaic correction
involves several steps which the user must implement in order to use this
new options.
As an example, we shall show some data courtesy of Dan
Elliot of the Lamar Institute. Dan collected about 35 kilometers of data
at a site on Ossabaw Island, Georgia as part of his studies into remote
sensing of features associated slave dwellings on the island. Dan and his
group were very meticulous and recorded a total of 58 GPR survey grids
across the site, as is shown in the next diagram:

1) To set the grid divisions, the user can click on those radargrams in
the Edit Info File menu that are at the start of each new block as
shown below in the following menu screen shot:
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When the divisions are chosen, the individual grid blocks will be drawn in
red as was shown in Figure 1. Note, the user must click on only the first
radargram in each block as they first appear in the information file. In
the above example we can see that the 1st file and the 17th file are start
of different grid blocks and are thus clicked on.
2) Next, the user proceeds as usual in time slice analysis, e.g.
reversing profiles, applying navigation, and slicing. The user can then
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create several optional time slice datasets that can effectively remove
mosaic noises:
•
•

0-mean-grid XYZ time slice – XYZ datasets where the mean
from every individual grid block is subtracted from data in that
block to create a “0 mean” for every grid block.
0-mean-line XYZ time slices – XYZ datasets where the mean
along every individual profile is subtracted from the time slice
data on that profile to create a “0 mean” for every profile.

Several options for creating mosaic corrected time slice maps are
available in the Slice/Resample menu. Each of the options may be
more appropriate than the other depending upon the nature of the
recorded data and the mosaic noise appearance. The options are
found just below the normal XYZ time slice creation. For the 0-meanline time slice dataset, in the case where linear features parallel to the
profile and large reflective features are not present, the 0-mean-line
data can provide a useful method for matching overall reflections
across a large dataset. If horizontal features are present that were
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parallel to the profiles, they could be effectively removed from the
time slice images. In this case, the 0-mean-line XYZ dataset creation
should not be applied. The 0-mean-grid time slice dataset will remove
the average within each block. Thus, if a single line or two is parallel
to a profile in the image, these reflections will be preserved since only
a single mean value is being subtracted across the whole separate
grid. Seeing several plot examples will better help the user to see the
effects of these 2 essential and important time slice calculations.
0-mean-grid and 0-mean-line calculations for the Ossabaw Island
Georgia dataset are shown in the following pages. The top time slice
is the raw time slice, the middle is the 0-mean-grid time slice, and the
bottom is a time slice using the grid math option in the Grid Menu to
subtract the raw and the 0-mean-grid images. The 0-mean-grid
image shows very good matching in overall reflections between the 58
different grids. Mosaic noises are much more prevalent in the raw
time slice. The subtracted image shows the overall gains subtracted
from each of the different grid blocks. If there were no mosaic noises
existing between the separate blocks, then the difference image would
be solid – in this case we can see that mosaic contributions are
prevalent and could be effectively removed by using the 0-mean-grid
time slice creation.
Examining the 0-mean-line time slice, we can see that the
difference image on the bottom shows mosaic noises are removed – in
addition – streaks parallel to the profiles can be seen embedded within
the mosaic components. The streaks are reflections from line noises
that were running parallel to the profiles. These are also effectively
removed from using the 0-mean-line XYZ time slice creation.
One
horizontal utility running from about the range 990-1060m in the time
slice image, can be clearly seen in the raw and the 0-mean-grid,
however, the 0-mean-line time slice shows this horizontal reflection
significantly decreased and nearly invisible.
The 0-mean-line and the 0-mean-grid calculations can be assisted
using the %max Cutoff and the %min Cutoff settings residing next to
these processes in the Slice/Resample menu. The cutoff settings are
to help in making better estimates of the mosaic noise background
levels. The plots in the examples for Ossabaw Island Georgia, were
made with the %max Cutoff set to 75% and the %min Cutoff set to
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0%. The 75% setting will include all the data in the grid which is the
bottom 75% in strength – e.g. the top 25% reflectors are not used in
determining the average of the block. Similarly, the settings are also
active for the 0-mean-line XYZ creation, and will throw away the top
25% strongest time slice values found on the profile and will only use
the bottom 75% values to determine the average reflection strength.
The reason that this works is that the mosaic backgrounds are usually
not the strongest reflected energy recorded. Mosaic noises are usually
at the lowest reflected strengths in the time slice images. If the entire
data were used in determining the filter, then areas that had a strong
reflection would overweight the filter and when the mean were
subtracted from either the line or the grid calculation, the overall
average reflection or the median reflection would be much weaker
than the 0 mean. A median calculation in addition to the mean might
also work, and this may be examined in the future.
XYZ Edge Match requires the user to set the division file in the Edit
Info File menu. Edge matching will adjust the block of data based on
the reflections between two adjacent radargrams in each of the two
different blocks.
XYZ Histogram Matching
Another mosaic correction method examines the histograms of
different blocks of data and will try to match the histograms for solving
mosaic noises. The operation will look at 3 standard deviations away
from the average time slice value and will apply a gain factor to
datasets to stretch or shrink the histogram so that the junctures where
the 3 standard deviations on each side of the mean matches. The
junctures on the histogram are defined in the Transform menu by the
lo-cut and hi-cut thresholds. The process will also shift the means so
that these also line up. This process is available in the
Slice/Resample operation and is operated on the data before the ASCII
time slices are generated.
Note 1: Remember, the divisions need to be set in the Edit Info File
menu to define blocks of radargrams from different grid sets where
mosaic noises exist.
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In all data processing steps, it is always useful to compute the raw
time slices without any processing. Raw time slice XYZ datasets are
compiled at the XYZ button in the Slice/Resample Menu.
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Grid Math Option: Adding x+y grids to create xy grids
The user has several options in GPR-SLICE to create time slice grids
from data collected in both the x and y directions for a survey site. In the
traditional method, the user can create a comprehensive information file
containing the names of all the radargrams and their location within the
grid. The user would normally create an infox.dat file and then an
infoy.dat file and append these together to the infoxy.dat file for
example, in the Create Info File submenu.
Often, the data collected in the x or in the y direction may have been
recorded at significantly different times than the other orthogonal
direction. Also, some investigators often will change the control settings
after collecting in one direction to improve the appearance and gain of the
raw radargrams. This is not recommended for creating useful time slice
images. In any event, from either diurnal variation in temperature or
other factors, the overall gain of either the x or the y dataset over a site
may be slightly or significantly different than the other set of data normal
to it. In doing gridding using the comprehensive dataset, digital noises
can arise, particular for kriging gridding operations if significant amplitude
changes are recorded nearby or in the same locations from the x and y
datasets.
The time slices computed from those radargrams which are
only going in the same direction and examining these datasets, are
sometimes more useful and less noisy than the combined xy time slices.
In the case when digital noises can arise from gridding different
overall gains between x and y datasets, and the user would like a
comprehensive map, it is useful to combine the individually computed x
and y time slices using grid math. Grid math can be done between two
time slice grid sets in the Grid Menu. The user inserts the identifier the
x*.grd dataset and y*.grd dataset, and sets a new output identifier. In
the case below, the x and y grids will be added with equal weight (e.g. a
multiplier = 1) to a new set of time slices called the xplusy*.grd.
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Shown in diagram on the next page, is an example of a dataset
collected along both x and y directions and comparison with, gridding
using the complete xy dataset, and another dataset created by physically
adding the individually computed x and y time slice grid maps. The site
shown is provided by Steve DeVore of the National Park Service. The
area surveyed in orthogonal directions is a grave site. The x3 and the y3
time slices were computed individually, and the xy3 time slice was
computed using the regular xy kriging gridding. Some spotty digital
noise can be seen in the xy3 time slice map.
Some hi-resolution
anomalies can be observed on the xy3 time slice map, amongst the
digital noise.
Because there is more spatial coverage using xy comprehensive
datasets, a smaller search radius allows for getting more reliable higher
resolution maps from these datasets. Nonetheless, the digital noise is
apparent and some of this noise might be erroneously interpreted as
reflections from rectangular burial pits. The time slice map xplusy3 was
computed by adding x3 and y3 grids directly using the grid math option.
This dataset has more structures combined into the final image.
Nonetheless, even with the noise, it is up to the user to determine which
of the datasets is most useful for their researches and is more
representative of the suspected subsurface structures.
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GPR Monitoring: Volume Math Option
GPR-SLICE can be used in volume monitoring of a site to measure
changes between recorded reflections collected at different times. Just as
single time slice grids can be differenced, since Jan 2011, 3D binary
volumes can also be differenced (or added) using the volume math option
in the Grid menu:

The multiplier allows the user to either difference volumes (with a=-1)
or to add volumes with different weights between them if desired. The
user must explicitly write the entire name of volume 1, volume 2 and the
name of the output volume in the menu slots here. After clicking the
(vo1)+a*(vol2) button, the math operation which show the % processing
completion on the Windows title bar. An example of differencing 2
volumes is shown in the next screenshot:
In addition to volume math, grid differencing - rather than grid addition can also be run in the same location using the Grid1+a*Grid2 button and
a value of a=-1
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Staggering Correction

Staggering errors can occur in doing zig-zag data collection. The
staggering error can see in an example time slice images made for the
Hopewell Indian site that was collected during the National Park Service
Archaeological Prospection workshop in Chillicothe, Ohio. The staggering
can be seen between adjacent lines in the top time slice map above which
shows a jagged reflection (caused from a straight earthen wall that is
buried).
The staggering can be caused by several factors including operator
errors or from small delays in the radar control systems which create the
staggered effect. Staggering is not always apparent in every collected
zig-zag dataset so it is not going to be a universal approach to processing
all GPR datasets. Recently, one user created a staggering error because
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they forgot that the center of the antenna is where navigation should be
tagged. They were using the back wheels of their equipment as the start
and endpoints for profiles - thus they created a staggering which was
about the length of the cart system they were using since the antenna
was
in
the
center
of
the
cart.

To correct for staggering there is an input in the Grid menu called
"stagger length".
The user must manually set the distance they
estimate exists between the staggered lines. In the example above an
estimated stagger length of 0.9 meters is used. The staggering is applied
to the xyz *.dat datasets that are read in and is used to shift lines that
were collected in the reverse direction. The grids are then calculated
using the shifted lines. The bottom image is a time slice corrected for
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staggering.
The Grid menu will look at the active info.rev file in the
Reverse Menu to see which lines were collected in the reverse direction.
When the user creates grids when the staggering is set to something
other than 0, a log will be kept in the Grid menu to let the user know
which lines were staggered.
Differential Staggering
In some images it is possible to have staggering that is not always
present in some of the reverse lines. An example of an image is shown in
the following diagram.
Ranges greater than about x=12 m shows
staggering noises in the image, however, ranges<12 m do not show
staggering.
The causes for the differential staggering noises across
the radargram is not completely known, however, in this case it may
have been because of the result of some ground disturbance caused by a
trench surveyed over on part of the site. Whatever the cause of
differential staggering, to correct this image one does not want to simply
apply staggering to all the reverse lines in the file, but only to those files
that the staggering appears in.
To implement a differential staggering correction the user must return
to the Reverse menu and clicked off those radargrams that do not appear
to have any staggering problems (e.g. up until x=12 m in this example)
The edits are then saved to the info.rev file using the Save Edits button noting that the radargram reversing operations are NOT run
again. After redefining the info.rev the user can return directly to h
Grid menu, set the staggering length and then recalculate the grids. The
stagger corrected image looks significantly better than the raw
uncorrected image.
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Note: One must be careful if they are using multiple information files for
a project and to make sure that the active info.rev file corresponds to the
xyz *.dat files which are going to be gridded. There is a button option in
the Reverse menu called "Save Edits" to allow the user to click on files to
reverse and then save to the universal info.rev file without actually
running the reverse process. This may be necessary to use when
multiple information files and subgrids exist in a project folder and then
one decides to re-run grid creations with staggering.
Customizable staggering file for correcting imported data
Import of outside geophysical such as magnetics, resistivity or EM
profiler dataset, was placed into the software from many years ago at the
request of users that wanted to show time slices along with other
geophysical data and also to take advantage of the gridding capabilities in
GPR-SLICE. The Grid menu in GPR-SLICE was enhanced to allow for
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correction of imported geophysical data that has variable staggering
navigation issues.
Shown in the following example is the importation of GSSI Profiler
data into GPR-SLICE via the Import 2D Geophysical Data menu. This data
has significant staggering/navigation issues which can be seen in the
data. On import, the option to apply a constant stagger length is
available. However, this data has several areas with different apparent
staggering.

To provide a solution for non-constant staggering, a new flag value is
available in the Grid menu to allow the user to import a
customized_stagger_file.dat and to apply custom stagger lengths on each
line. The customized_stagger_file.dat should have 2 columns: line#,
stagger length to apply to the ascii data before gridding is done (see
screen shot). To assist the user in making this customized file, choosing a
blanking radius that narrows the interpolation radius (shown in the
bottom of the next figure), the line data can be identified within the
image.
Although it could be time consuming to generate a proper file to apply
customized staggering to, the benefits of correcting for this navigation
error are clearly seen in the comparision between figure 1 and 2.. With
this customization on the stagger length, severe errors in navigation from
imported data can be fixed.
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Note1: This correction is only available to data collected in a single
direction, either x or y.
Note2: The new option is available for GPR time slices as well should
constant staggering operations be insufficient
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Tunnel and Cylindrical Warping
GPR-SLICE has options to “warp” 3D volumes into cylinders or
tunnels. Cylindrical warping is useful for examining radar data collected
on timber or pillars. Tunnel warping is useful for showing radar surveys
made on the inside or outside surfaces of tunnels or in mines.
To implement these new imaging features the user will proceed in the
normal method to create a 3D dataset. For cylindrical or tunnel surveys,
the axis of the cylinder or the tunnel should be along the x axis. After the
rectangular 3D volume is created, the user then enters the 3D Volume
menu and can choose the "Cylinder Warp" or the "Tunnel Warp" menu.
A new volume which will append the word "cylinder" or “tunnel” to the
volume name. This example was made for a start angle of 150 degrees
(1’oclock) and an actual ending angle of -230 degrees (12 o’clock). To
make a solid volume warp with 360 degrees, there is one imaging “trick”
that one can apply: Add the first profile onto the end of the information
file and then for this example, change the ending angle to -260 which
corresponds to +60. This will help to smooth out the warped volume and
better match the connected edges (as shown in the following figure).
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The data in this example is simulated for data collected along the axis
of the tunnel. The possibility of collecting data along the circumference
is also easily implementable - in all cases the x axis is the axis along the
tunnel or cylinder. One would enter data taken along the circumference
as radargrams in y with constant x0,x1 starting and ending locations;
radargrams parallel to the cylinder axis, would be entered as radargrams
in x with constant y0,y1
starting and ending locations.
The
circumference would be the length in the profiles for y profiles, e.g.
2*(3.1415926535)*RADIUS; along the x axis, the profile length is simply
the length of the tunnel or the cylinder. The separation in the profiles
parallel to the cylinder axis should be set by their distance measured on
the outside circumference of the cylinder.

Zig-Zag Information Files - No Reverse Menu Operations
In the creation of the profile information file one is always required
to insert line start and endpoints. If one uses the Reverse menu, then all
the radargram start and end points in the information file are typed in as
though the radargrams were collected in the forward direction. The
reversing process in the Reverse menu flips the binary radargrams in the
\radar\ folder and effectively makes the radargrams look like they were
recorded in the forward direction.
The possibility also exists for the user to avoid using the Reverse
menu and to write the information file with the actual start and end
points of the surveying. The Reverse menu should be skipped for
information files inputted with reverse information.
An example of an information file with reverse lines identified with x1
ranges less than x0 is shown in the next diagram. In this zig-zag survey
done parallel to the x axis of the grid, every other line is recorded as
going from 10 to 0m.
There is also a quick button that one can use
called “rev file” which will read the reverse files clicked on in the Reverse
menu and will interchange the start and end points in the information file
in the Edit Info File menu. So, one can create a rectangular grid and then
reverse all the information using what is stored in the Reverse menu.
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Note 1: Radargrams displays in the Radar 2D menu will appear reversed
in the display with axis labeling going from higher to lower values.
Note2: The user should be careful in using the reverse information file
designation. This potential for some to get confused and believe they
need to write the profile information file with reverse information, and
then also to run the Reverse process as well - this would be a mistake!
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The ANG survey definition

Angular line surveys can be created and processed just as regular
surveys.
An example of an information file designated as an ANG file
and the corresponding grid plot is shown in the above diagram. The only
detail that is slightly different from ANG surveys compared to an x, y or
xy survey is that the line length may be a fractional length. In this
instance, GPR-SLICE will compute tagged markers across the radargram
to a rounded up number of markers. For instance, a 10.43 meter length
radargram, will have 12 tags placed across the radargram – 1 at the
beginning plus 11 more tags equally placed across the radargram. All
angular lines which are of fractional length will have the rounded up
integer lengths for the line plus one extra marker for the beginning.
The markers are actually not placed at integral locations. The marker
tags are needed for the binning process in creating time slices as well as
defining navigation. X, Y or XY surveys which have fractional line lengths
are actually treated similar in generating tagged scans. The only display
issue from fractional line lengths are that native x axis labeling will not
normally show integral labeling unless a marker tag “override” flag is
engaged. An extended discussion of the implications for ANG surveys or
even X,Y or XY that have fractional line lengths is given in the next
section.
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User defined labeling - scan header labeling override for ANG or
other surveys
GPR-SLICE has traditionally only outputted labeling on 2D radargrams
that comes from the scan headers where navigation tags are stored in the
2nd sample of the digitized pulse. This has been a double check on
navigation - as only tagged scans can force a label in the radargram
displays. Even if a radargram is defined as some length in the info.dat
file and there are no navigation tags in the radargram scan header that
were applied through the Navigation Menu, no labels will appear on
displays.
For ANG surveys, where there can be fractional line lengths,
the navigation tags may not be at integral lengths in the radargrams.
Navigation tags for ANG surveys can be at non-integral lengths. The
reason for this is in the process of creating time slices and a need to
properly include and equal weight all portions of the radargram in the
time slice binning process, tags are set at non-integral locations. For
instance, a 10.0 meter radargram, would get tagged with 11 navigation
tags but a 10.43 meter radargram for would get 12 navigation
tags (including the scan #1). The user would be able to break down the
12 tags in the radargram with the Cut Per Mark option to generate
additionally smaller bins for time slice operations. With that said,
because of the non-integral location that can occur with ANG survey for
the tagged scans, on displays, the labeling will show at fractional
numbers. This also requires that the # of decimals in the x axis display
be set to something other than 0. Several users complained that they
could not get out equidistantly labels at a desired graphic increment. For
this reason, an old option that was taken out of the software has been reinstated (Figure 6). The Big Tick frequency, if set to a negative value in
the Options menu, will override the scan header navigation - and provide
a completely graphical labeling where the user can control the interval
between labels.
An example of a traditional scan header labeling for an ANG survey
line that is 10.43 m and what can be achieved with a negative Big Tick
frequency option is shown in the following figure. In the traditional ANG
survey, the labels have fractions in them. With the override engaged the
user can achieve any integral display on the tick labeling. The tick
labeling interval can also be sub-integral if desired by clicking off the Auto
marker labeling checkbox in the Options menu.
Note: Scan marker override option is only available for X, Y, XY or ANG
surveys and is not applicable or available for GPS surveys.
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Assisted Auto-Hyperbola Detection (Bridgedecks)
GPR-SLICE now has options to automatically detect hyperbolas and to
output these detected hyperbolas for mapping. These options were
developed at the request of companies involved in infrastructure
evaluation. Evaluation of bridge decks or sites constructed with rebar or
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reinforcements can be assisted with GPR surveying. For these surveys, a
method to quickly discover the XYZ location as well as the amplitudes of
the reflection are needed for evaluation purposes. (Amplitude reporting
can be used in advanced empirical theories to estimate weathering and
deterioration of structures).
Two primary search methods are available:
Method 1:
directions
Method 2:
directions

3-point threshold detection - vertical and horizontal
5-point threshold detection - vertical or horizontal

(The preferred algorithm is the 3-point detection which has been found to
perform better than 5-point original detection operation of looking along
the entire hyperbola.)

3 & 5 Point Auto Hyperbola/Anomaly Detection
The first hyperbola detection algorithm provided in GPR-SLICE
involved searching all the points along the hyperbola and counting the
number of samples that breached a user defined threshold.
This
algorithm, although founded in good “science” did not provide for
hyperbola detection in the case of variable velocities or noisy datasets so
well.
3-point and 5-point search was implemented and improved
detection and was placed in the menu some time later. On further
testing, a simple 3 point search is found to work even better than a 5
point search. To run the 3 point search the button 3 point horizontal or
3 point vertical is clicked on and the aperture width is adjusted such that
the middle point and the two adjacent 2nd and 3rd points are on a different
+/- legs of the hyperbola (see the following screen shot).
The plus
minus legs can be in the horizontal or vertical direction depending on
which operation is pressed and desired.
Left clicking the 3 point
detection in the desired location will get the amplitudes and the x,y
sample locations for each point. This information will be filled out in the
dx1, dy1 and aN slots in the menu. (The 4th and 5th points will be set to
the first point values which will institute a 3 point search; a 5-point
search will have all independent values and sample x,y locations). An
example detection for rebar on a bridge deck is shown:
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Note: Auto hyperbola and anomaly detection capabilities requires the
GPR-SLICE bridgedeck license and is not available for standard licenses.
To implement the search algorithm, several additional settings are
required:
N1 - The top sample in the scan to begin searching.
N2 - The bottom sample in the scan to end searching.
N Skip - the number of scans to skip in the radargram after detection is
made, to begin a new search.
N Nearby - the number of sample points on the digitized pulse or scans
to search around the detected point to find the largest peak response on
the hyperbola
N Backup – the number of samples to place the detection above the
located binary values set, allowing the user to detect the peak response
of the hyperbolas but then reposition the detection at the weaker first
arrival amplitudes from the rebar or anomaly to be detected
The options in the menu allow for using the peak+ or the peak–
response of the scan pulse. In addition, cosmetic options to show or not
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show the hyperbola tails beyond the N-threshold range is available in the
menu, along with scrolling options to target just a portion of the
radargram are available.
Note: The search algorithm is not perfectly perfected nor will it ever be.
Most sites require some user editing of automatic hyperbola search
tabulations. Also, it should be noted that the search algorithm is very
sensitive to the threshold settings as well as the number of scans that
have to breached with the threshold before getting detected. The user is
advised to “play around” with differing combinations of these setting to
get the best desired results from automatic detection for method 1. This
may involve actually adjusting the amplitude thresholds in the slots by
hand to reduce/increase them as well as the location of detection on top
of the radargram.
Compilation of rebar deterioration maps
The peak amplitude responses of the hyperbola from rebar are
important for estimating deterioration of concrete and rebar (for bridge
deck). As a further development of auto hyperbola mapping and bridge
deck analysis, the detected hyperbola amplitudes can get compiled and
gridded in GPR-SLICE.
Shown in the next menu screenshot is the
gridded hyperbola amplitude using Compile Hyp Amp button in the
Hyperbola Search menu, followed by gridding in the Grid menu:
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Bridgedeck module improved with up to 5 multiple layer
detection/retrieval/editing /compilation
The Bridgedeck module was enhanced in 2020 to store up to 5 user
defined layers. One can set the descriptor for 5 layers, and using the
radio button next to the descriptor, begin the autodetection. The software
will remember all the autodetection settings used to discover the desired
hyperbolas or anomalies for each layer independently. The editing dialog
has also been improved by allowing either insertion or deletion of the
shown picks by clicking the desired action button, then right clicking to
insert or delete the hyperbolas.
To get all the detected layers to appear in the dialog one checks on
those layers desired to overlay and then the Import Layer button is
clicked. On compilation of the detected layer the customized descriptor
name is given to all the output filenames. In the example, the XYZRebarA1.dat file made is the detection for layer 1 of the depth to the
rebar. These files and for every unique layer can then be gridded in the
Grid menu.

Improved Bridgedeck module showing up to 5 layers detections with
unique naming and compilations.
The menu will also remember the
detection settings for each layer that is active.
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Removing Shielding Noise
A specialized noise has been identified in GPR radargrams that we
can best describe as “shielding line noise” (see the following diagram
designated as “all lines”).
Very often zig-zag surveys will show
alternately strong weak overall recorded reflections between adjacent
lines. This may be a result of some external and directional outside
microwave source which may affect the overall recorded reflections. It
may also be a result of some change in the configuration, perhaps the
location of cables or some other field setup that changes slightly between
forward and reverse lines. Whichever the case, such effects should not
be in the raw radargrams unless the antenna is not perfectly shielded.
We know that perfect shielding is not possible - thus this newly identified
noise has been called shielding line noise.
There are useful processing steps to remove this noise. One of the best
ways to do this is to create 2 separate grid maps of forward and reverse
lines and the do grid math to add these time slice maps separately. The
general operational steps are:
1)
2)
3)
4)
5)

create info1.dat which are the forward lines
create time slices of just the forward lines
create info2.dat which are the reverse lines
create time slice of just the reverse lines
go to the Grid menu and use Grid Math to add the 2 time slices
together

The time slices can be added with constant to try and match the overall
reflection strengths between the forward and reverse lines. An example
of applying these operations to a Mala Geoscience dataset that exhibited
the shielding line noise is shown in the following diagram (data courtesy
of Geoview, Florida). The individual forward and reverse time slices, the
original time slice, and the time slice computed by adding the forward
and reverse grid together indicates that this line noise has been
effectively removed. One artifact of applying these filtering processes is
that the resulting reflections anomalies look a touch more smoothed out
than on the original time slice map.
Nonetheless, the line noises
associated with shielding problems have almost been completely
eliminated.
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Super Fine Time Slicing
We have discussed in the 2D Quickstart section an effective way of
generating time slices as well as interpolating between time slices. For
many applications, these data processes will suffice for solving many
subsurface problems. There are those that may not find the process of
interpolation appropriate for GPR data and do not want to recreate or
estimate any data between depth slices. In addition, these GPR users
may find the time slice thicknesses that are recommended, such as 1-2
pulse wavelengths to be too large. Another point that these users may
disdain is the normalization process that is a byproduct of interpolating
time slices. Remember, the interpolation process will create interpolated
time slices which are normalized to 8 bit following the color changes
between different levels and not actual reflection values.
Well, for users that want to explore GPR data in its full glory without
any interpolation or without any normalization, the following data
processing steps are recommend:
1) Do all the regular steps through slice/resample operations.
2) Compute the Hilbert Transform of the resampled radargrams or of any
processed radargram to be used in slicing.
3) Slice/resample the Hilbert Transform folder using a very thin sample
thickness (of 1 or perhaps 3-5 without too much loss of depth
resolution). The number of slices one can make can be as much as
the number of sample/scan (up to a limit of 1024 slices). It is
recommended that the number of slices be kept under 200 though
because of memory requirements may get exceeded if one will be
compiling 3D binary volumes.
4) Display and process the (multitude of thin) time slices in the Grid or
Pixel menu as desired.
The Hilbert Transform is recommended since this will give one the pulse
envelope (or energy when the squared amplitude of it is taken). Applying
the Hilbert Transform will eliminate phase components of the radar pulse
which we believe distracts from making using time slice images that show
continuity in strong and weak areas of reflectivity.
If these (raw) time slices that are not interpolated are compiled
directly to a 3D binary file, this binary file will more or less emulate the
exact reflections energy in the recorded radar pulses versus depth. One
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situation which can occur with these absolute amplitude 3D volumes (or
2D time slices) as well is flexibility and dynamic range in applying color
transforms may be lost since some strong reflections may completely
dominate the data spectrum.

Concatenating Two or More Grids Collected with Different Time
Windows
GPR-SLICE can be used to make comprehensive time slice maps when
several grids to a large survey were collected with a different time
window then other grids.
To merge these data together into a
single ASCII time slice dataset to be gridded the following steps can be
implemented:
1. Create info1.dat containing the names of all the radargrams that
were collected at the same time window. Go all the way to
slice/resample, choosing the slicing thicknesses, number of slices
and locations you like.
2. Create info2.dat containing the names of all the radargrams at the
other time window used in the survey. Go all the way to
slice/resample, choosing the slicing thicknesses, number of slices
and
locations
to
be
identical to
those
used
in
processing info1.dat files. In general you will be reducing the
end sample and the thickness in samples to get a similar match to
the slicing windows for the radargrams data collected with
shallower time window.
3. Create a comprehensive info12.dat with the all the profiles for both
recording time windows
4. Skip right to the slice/resample menu and click XYZ!!
Step #4 will make comprehensive time slice ASCII files for gridding which
contain the equivalent time windows from each of the two datasets. The
reason this can be done in GPR-SLICE is that the slice/resample operation
simply stores the time slice parameters for each line in the (transparent)
subfolder called \sqwave\ which exists for every project. The XYZ
process simple collects all this information and merges it with the
navigation described in the information file. As long as both information
files are processed with exactly the same number of slices and the
same number of bins per mark, the merging of the 2 time windows
can be done. The settings in the slice/resample button must also not
have changed before the XYZ compilation button is clicked.
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Appending of maps with different time windows can also be done in the
Pixel Map menu where the different grids with different time windows are
processed independently and then Append operations are run.
Data compiled from two or more different time windows will most likely
have some amount of mosaic noises that need to be removed. This can
be handled very effectively in GPR-SLICE using several methods, the best
of which is a little more time consuming and involves using transform
matching options for concatenating and matching the grids (this has a
pretty good write up in the manual).
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Extracting Individual X or Y or Z Planes from the 3D Volume to 2D
Grid Files

X, Y or Z planes can be extracted to individual 2D grid files using
options in the 3D Volume pulldown on the main menu. Clicking the
Extract 3D Volume XYZ planned to 2d *.grd format will open up a menu
allowing the user to click any plane to be extracted.
The extracted
planes will be appended with ex-, ey, or ez- depending on the desired
direction.
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3D Volume (XYZ, XYZIRGB, XYN trace) Export
GPR-SLICE v7 provides 3 different ASCII formats for export of the
3D volume generated in the Software:
•

XYZG is a comma delimited ASCII file with x,y,z, and the
value of the radar refection or squared amplitude or whatever
volume element was compiled.

•

XYZIRGB is a 7 column ASCII export format with x, y, z the
location in 3D space, I the intensity of the radar reflection
recorded in the volume, and RGB are the colors from the
current active color table for the display of the 3D volume.
This option complements the simpler XYZG ASCII format,
where G is equal to I and is the intensity of the recorded
reflection at the given XYZ point. This format is useful for
users involved in combining GPR-SLICE 3D volume images
with Laser Scanning software. (Note: Z is made negative
going down).

•

XYN Trace is an ASCII export where the vertical cells in each
location are written consecutively. When a pulse volume is
generated, XYN Trace represents individual traces along the
volume written one after another. If the Z cell size is 200 for
instance, then each line of the file will be x1,y1,Trace1...200
followed by x2,y2,Trace2...200.

An example of a laser scanning image merged with a GPR-SLICE
volume is provided by James Clay of Land Air Surveying, and Dr. Kent
Schneider, US Forest Service shown in the next screen shot. The image
was merged with point cloud software Cyclone which read the XYZIRGB
export file.
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Radargram Differencing
The radargram differencing option in GPR-SLICE has been improved to
look at any two folders. The folder can be a processed folder or raw
(\radar\) folder to compute the difference between radargrams.
The
input directory folder and the list of folders next to the Rad1-Rad2 button
should be selected before running the operation. The radargrams must
have exactly the same number of traces as well as the same
samples/scan. The output from radargram differencing is written to the
\work\ folder.
Radargram differencing is an important operation to
examine 4D measurements over the same profile and can indicate areas
that have changed in time.
Radargram differencing is also useful to
see just the noise content that is being removed from the chosen filtering
process.
An example of differencing a raw radargram with a
background filtered radargram is shown:
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Vector Imaging

Figure Graduate student Michelle Mellon of McMaster University under the
direction of Dr. Joe Boyce in the Geology/Geophysics Dept, is shown
surveying a site with an accelerometer device that measures yaw, pitch
and roll of the GPR antenna. The survey is being conducted to evaluate
the biomass volume at the site.
GPR-SLICE is equipped to handle complete random antenna
navigation in 3D space considering both the xyz location as well as the
antenna orientation.
GPR-SLICE can display a GPR radargram in any
position and orientation in 3D space and from any possible geometry or
path that an antenna is used to survey. Showing radargrams collected
along a tunnel, along a meandering tunnel, on the surfaces of walls or
even non-rectangular surfaces is all possible. Any orientation is possible!!
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The navigation formats for doing what we have termed “Vector
Imaging” - to distinguish it from other imaging where the antenna
orientation in 3D space is not considered, is already provided for in the
expanded *.*.gps. The geometric description is shown below:

The *.*.gps files are the most generalized formats available, when
using the 9th, 10th and 11th columns of these navigation files which hold
the antenna orientation in 3D space. The antenna orientation is entered
as a vector normal (rather than the roll, pitch, yaw). The vector normal
is the direction the GPR scan has in 3D space as x, y and z corresponding
to the 9-11th columns of the *.*.gps file. The vector normal does not
necessarily have to be a unit vector as unit vector normalization is done
within the software.
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Roll/Pitch/Yaw included
Multichannel Licenses)

in

Generating

3D

Volumes

(for

In the future, roll, pitch and yaw measurements may start to become
standard field procedures for some surveys where extra precision is
needed for example in utility mapping. There are currently no standards
on the recording formats as the manufacturers have yet to incorporate
these measurements into their control units and to monitor the
orientation/attitude of the surveying antenna. Several organizations are
independently recording these values externally and need to include
these measurements in the analysis.
Recently, a flexible import
operation of roll, pitch and yaw were modified and generalized to read
either individual files associated with each recorded radargram, or to read
a single global file (screen shot below).
For surveys with specified
individual files for each recorded radargram, the GPS Get Yaw button has
flexible reading of a comma delimited file specifying the roll/pitch/yaw
columns to be imported. For surveys where just a single – global
roll/pitch/yaw file is recorded, the NMEA time is searched in this global
file and the bordering NMEA time in the *.*.gps files is compared and
appropriate interpolation between these times is used in the import.
Flexible degree or radian import can be used to import the external
custom file.
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In this example a single global file inclusive of the entire NMEA time
span and with roll/pitch/yaw is converted to the normalized vector and
placed into columns 9, 10 and 11 of the *.*.gps navigation files made in
GPR-SLICE.
The definition used in the conversion of roll/pitch/yaw
angles to the normalized vector is by coordinate transformations:
sy = SIN(yaw(j))
cy = COS(yaw(j))
sr = SIN(roll(j))
cr = COS(roll(j))
sp = SIN(pitch(j))
cp = COS(pitch(j))
rotation around x-axis:
qy=0
qz=1
yy= qy*cr - qz*sr
zz= qz*cr + qy*sr
rotation around y-axis:
qz=zz
qx=0
zz= qz*cp - qx*sp
xx= qx*cp + qz*sp
rotation around z-axis:
qx=xx
qy=yy
xx= qx*cy - qy*sy
yy= qy*cy + qx*sy
xvec=xx
yvec=yy
zvec=zz
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To correct for the roll/pitch/yaw in compilation of 3D volumes (for
multichannel datasets), the “vector” survey definition for the information
file must be active.
A screen shot of Open GL 3D Vector Radar is shown for several
radargram collected on a burial mound. The vector display shows that
the radargrams are not on simply 2D planes display but have a 3D
projection:

The key to using the most general form of vector imaging in GPRSLICE v7.MT is to be able to set the vector to project the GPR scan via
columns 9-11 in the *.*.gps files. GPR-SLICE currently supplies several
menus to assist the user in generating vector navigation and displaying
radargrams. Additional utility menus will be developed in GPR-SLICE as
more surveys are being done on various kinds of variable 3D surfaces. At
present the user can also modify the vector columns to supply and
geometry that they might be doing with GPR. Several menus currently
available in GPR-SLICE v7.MT are for tunnel applications and automatic
setting of the projected scan vector is provided:
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▪
▪
▪

Tunnel surveys with the radargram collected along the axis of
the tunnel
Meandering tunnel surveys with the radargram collected
along the axis of a meandering tunnel
Topographic surveys and automatic vector surface normals
calculation from the active topography grid file

▪
These menus are just a subset of the possible navigation with the
generalized vector navigation format in GPR-SLICE v7.MT. These
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Vector 3D volume generation from 3D vector radargrams
Finally, the union of vector radargrams is combined with vector
volumes! This has been a long desire of mine to have any radargram in
any orientation in space and to be able to generate a 3D volume from
these projected radargrams. We have in the past provided simple
features like tunnels, cylinders and topographic vector volumes. However,
the generalized operations for any vector were not available. These are
now explicitly available in GPR-SLICE!
The operations are to:
1. Generate vector navigation files in the software or import them
from other sources such as yaw pitch roll sensors etc. The vectors
can show the radargrams in any 3D spatial orientation. (An
example of some radargrams made with a twist in 3D space is
shown in the following figure).
2. The slice/resample menu is run using the XYZA-Vector compilation.
This will slice and bin the data, and then the vector position of that
bin in 3D space will be written to a 3D file called XYZA-vector.dat.
This file is 4 columns and has the xyz position along with the bin
parameter which is usually the abs(amplitude) or squared
(amplitude) average in the bin.
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3. XYZA-vector.dat file is a 3D file and requires 3D interpolation. Using
the Import 3D Geophysical Data menu, the file is imported and this
initially creates a 3D binary file for viewing in OpenGL (2nd figure). This
file will generally have a lot of empty 3D cells so some interpolation is
usually required. The number of cells in the XY direction and the
number of cells in the Z direction can be set independently. After
interpolation, the append identifier "int" is placed on the new gridded
volume. The 3D interpolation currently has inverse distance gridding
hardwired into the interpolation algorithm. After interpolation the
Grid menu can be used to apply additional voxel smoothing to the
volume if desired.

An example of a 3D volume made from vector radargrams having a
3D twist are shown in the third figure. The new operations available for
vector volume generation will allow the user for instance to show
isosurfaces made on all the separate walls in a room and show those
isosurfaces simultaneously in the same volume!
Any visualization
defined by the vector radargrams can now be interpolated in 3D to create
a solid 3D volume of that vector space!
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Vector Longitudinal Tunnel Survey
The steps to generate longitudinal tunnel navigation are outlined in the
Vector Longitudinal Tunnel Warping menu and are also provided here as
well:

Create Info File menu:
Step 1. Create an Y survey info file
(x0,x1=no need to set these)
(y0,y1=profile start/end length along the tunnel)
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Edit Info File menu:
Step 2. Click the Ang X, Y XY to Vector button generating info-v.dat
This operation stores the y0,y1 lengths to the vector info
file.
Note: if the line lengths need to be adjusted, then edit the line
lengths in the Edit Info File menu first, and then click the Ang X, Y,
XY to Vector button in that menu.
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Vector Longitudinal Tunnel Warp menu:
Step 3: Set the longitudinal angles for each radargram
Step 4: Click Vector Longitudinal Tunnel Survey button
(adjusts the 9-11th columns for antenna orientation in the
*.*.gps files)
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Open GL 3D Vector Radar menu:
Step 5: Display the projected longitudinal tunnel radargrams.
An example of the projected radargrams collected along a tunnel is shown
in the following screen shot of the Open GL 3D Vector Radar menu:

Longitudinal tunnel vector with vertical orientation
In order to provide a vertical tunnel orientation, the Vector
Longitudinal Tunnel menu was enhanced to allow for setting the tunnel
axis. With this option the orientation for vertical tunnel surveying can
match the survey geometry.
Note: This menu is specific and limited to vertical or horizontal
orientations. There is always the complete general option for the user to
have an import file called - vector_survey_user_set.dat file imported
under the Create New Info file menu which will have the 3D start/end
points along with the 3 vectors set by the user. This import can
reproduce the vector application in the Vector Longitudinal Tunnel menu
and can provide any vector positioning that the user needs.
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Example of the settings needed to achieve vertical tunnel orientations,
using the Vector Longitudinal Tunnel Warp menu.
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Vector Radial Tunnel Survey
Traditional methods for radargram warping are still available which
entails rewriting new binary radargrams. Radargrams can be warped real
time to show radial tunnel surveys using the vector formats.
With the
new vector descriptions, the display of radial tunnel radargrams is much
faster and shows the radargrams in their true 3D positions. The steps
needed to create vector radial tunnel radargrams is given in the menu
explicitly and also shown here.

Create New Info menu:
Step 1. Create a “Y” information file with the x0,x1 defining the location
along the tunnel.
Set the y0 to 0 and the y1 to a number which will
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defined the number of vector defined for the radargram. In the example
above 36 is used which will make a vector a 10 degrees. Note, if more
resolution in the rounded radial display is needed the number of vector
locations can be doubled to 72 or any number less than the total number
of scans in the radargram.
Edit Info File Menu:
Step 2. The Ang X, Y, XY to vector button is clicked in the Edit Info File
menu to create the vector navigation files as well as store the position of
the radial radargrams.

Vector Radial Tunnel Warping menu:
Step 3. Click the Vector Radial Tunnel Survey button which will read the
start and end angles and the radius for each radargram and will update
the vector in the navigation files. There is also a replicate button to
357

358
quickly set all the radargram to the same start and end angle as the first
radargram. In this example the first 10 radargrams are sent from 90-270
and the last 10 are set to 90 to 450 which would be a full 360 degree
radial radargram starting at 90 and returning 360 degrees to 450. The
settings in the stop and start angles are only updated and stored when
the Vector Radial Tunnel Survey button is run.

Vector imaging has endless capabilities to display any radargram in its’
true 3D space. Again, the most important part of the process is “simply”
to get the *.gps navigation files properly written. Both radial and
longitudinal vector setting menus are available for specific cases of tunnel
imaging is available.
To show the flexibility of the new imaging, we have combined vector
radial and vector longitudinal tunnel radargrams into a single dataset.
GPR-SLICE can show radargrams in which crisscrossing longitudinal and
radial tunnel radargrams in the same volume. The following diagram is
an example of both radial and longitudinal tunnel warp radargram:
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The vector imaging shown in the above diagram is just a small subset of
the endless capabilities with GPR-SLICE for tunnel imaging.
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Vector Circular Survey

A menu to generate circular surveys is available. The menu will allow
the user to easily set the start and end angles of each individual radar
profile as well their specific radii, elevation and the vector orientation.
Four vector orientations are available with settings 0 (horizontal pointing
outside the circle), 180 (horizontal pointing inside the circle), 90 (vertical
pointing upward) and 270 (vertical pointing downward). The beginning
information file should be defined as vector with all the x0,x1,y0,y1
simply set to 0. Clicking the Vector Circular Survey button will generate
a vector *.*.gps file that is broken up into 99 tagged scans with positions
around the defined circle for that radargram.
Should the greater
precision in defining the locations along a circular arc be needed, one can
alter the 99 to a larger value in the Edit Info File menu and then run
navigation and so on to make more designations around the circle.
An example of 4 lines with partial surveying along a circular tank with 2
radargrams measured on the tank wall from 0-180degrees, 185-270 and
their normal vector defined as 180 degrees, and also radargrams over the
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same start and end angle and projected downward with the normal vector
defined as 270 degrees is shown in the following example:

Other possibilities include a vector circular survey with each radargram
progressively having smaller or larger radius… such as surveying around
a circular structure or a pole. The menu is also set up for adjusting the
elevation along the circular surface for looking at progressive radargrams
taken at different heights on a concrete tank for instance. Many more
possibilities exist for the geometric inputs provided in the Vector Circular
Survey menu.
Note: GPR-SLICE provides easy set menus for these simple vector
geometry, however, the software is completely flexible and the user can
also generate any complicated vector geometry by modifying the *.*.gps
file which contain the navigation, scan#’s and the normalized vector of
the tagged scans.
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Vector Imaging for Walls etc.
Making surveys on walls or tanks has just gotten easier inside the
software.
A new import in the Create Info File menu called
vector_survey_information.dat will import this 8 column file for each
radargram in the project that has the name, xstart, ystart, zstart, xend,
yend, zend, and the angle description 0-360. 180 signifies a profile that
is made inside a room for instance, and 0 would be outside the room and
will project the radargram in the opposite direction. 90 degrees would
project the radargrams vertically upward, etc.

Another
optional
import
for
vector
imaging
is
the
vector_survey_user_set.dat file from the Create New Info menu.
The
import file has 10 columns: radname, x0,y0,z0,x1,y0,z1,vx,vy,vz - and
the user must explicitly set the vector (vx,vy,vz) in columns 8-10. This
file must also reside in the main project folder. This input is distinguished
from the vector_survey_information.dat file in that the vector can be held
constant to a desired direction no matter what the direction of the profile
is. The above wall profile vectors can be easily set with setting the
vx,vy,vz to 1,0,0 for radargrams on the right, 0,1,0 for the middle wall
radargrams and -1,0,0 for the radargrams on the left side of the room
etc.
Vector_survey_information.dat file will project the profiles
perpendicular to the radar track and this calculation is automatically
made.
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Vector Volume Addition – example imaging of a 4-sided
square column

GPR-SLICE has a new menu to synthesize a vector volume from
separate localized volume (see screen shot above). This menu can be
used for instance to combine all the surface surveys and their separate
volumes taken on a 4-sided square column and generate a single vector
volume! The new menu on the 3D volume pull down menu has slots to
set the absolute origin that each volume is recorded on, along with their
corresponding axes rotation needed to place the new volumes in their
vector location. There are also separate gain values that can be applied
during the addition process for each individual volume.
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Some of the requirements and recommendations for this new vector
operation are to: 1) make individual volumes that have more density then
the output volume to insure that there are no empty cells during rotation
and translation into the output vector volume, and 2) we highly
recommend that absolute or ABSOLUTE (user defined set min/man)
normalization be used to generate the volumes. With absolute
normalization, keeping the gains lower at depth in each individual volume
will help to ensure that volume elements that are overlapped - as will
occur on the corners of the new volume - do no overwhelm the imagery and only the true amplitudes are being added and not normalized
amplitudes at each level from the time slice dataset. An example of a
column concrete/rebar survey made with a Sensors and Software
Conquest GPR system by Butch Federizon at Geomaster Corp in Quezon
City in the Philippines is shown in the example imagery.
This new option is not limited to just 4 volumes. The menu can be run
several times with the output volumes as input volume to comprise many
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more locations into a single vector volume. The size of the output volume
if areas are separate by large distances can become "intolerable" for
volume memory and it is recommended that adjacent areas be used to
keep the output volume manageable. The vector volumes are
distinguished from our typical volumes in that the z axis is no longer
measured in time and the volume is a depth volume. Time axes will not
appear in OpenGL for these new vector volume displays.
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Automatic Vector Imaging Over Sites with Topography

GPR-SLICE v7.MT has an option to calculate the surface normals
automatically across a topography grid file and place these vector
components into columns 9-11 in the *.*.gps files.
The button called
Generate Vector Normals, will read the active topography grid file and
compute the surface normal to the topography. The surface normal is in
the direction that the GPR scan will be projected into the ground. The
surface normal is computed looking at 2 vectors on the topography grid
file, e.g. looking at 3 points on the topography file and generating 2
vectors of elevation differences between two of the points, leaving one
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point as the origin of the vectors. The cross product between the two
vectors provides the surface normal to the vector.
Currently in GPR-SLICE v7.MT, a distance of 5 grid cells is examined
in order to give a local surface normal without too much rapid change
that would occur in looking at adjacent grid cells and topography. This
provides for a touch of smoothing in generating the vector columns. In
the future, options for adjusting this value by the user and/or vector
smoothing will be provided.
An example of what can be achieved with the automatic vector
imaging options, is that a 2D radargram collected over a site with
topography, gets projected as a 3D radargram when the orientation
(pitch, roll and yaw) of the antenna is included. Shown below are
example 3D radargrams collected over a site with topography.
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Vector Volume
GPR-SLICE Static corrections now incorporate vector topography.
Using the Vector Topo button in the Static corrections menu, flat
rectangular volumes will be warped into their vector space using the
surface normals of the digital elevation model. The topography grid file topo1.grd - is used to position the grid cells into their vector space
assuming the antenna was perfectly parallel with the surface of the
topographic site.
The repositioning and warping of the cells into their
correct 3D space can create voxel gaps in the newly created binary 3D
volume. A button to conveniently interpolate the gap using nearest
neighbors can be applied clicked in the menu. The user should first look
at the raw converted file to see if gaps are significant. If not, then a
simple gap interpolation with a x, y interpolates grid cell length of 1
should suffice. An example of vector warped volume is shown in the next
figure. The vector volume is written with the append identifier "topo-"
added onto the flat rectangular volume. If this volume is subsequently
interpolated the identifier "int" will be further added onto the volume
naming automatically. From this menu standard topographically adjusted
volumes which simply shift the grid cells vertically can also be made using
the Standard Topo button.
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ANG, X, Y or XY Survey Conversion to Vector
Among the miscellaneous improvements which are useful for further
discussion is the conversion of ANG surveys to Vector. Not only can ANG
surveys be converted, but X, Y, or XY surveys can also be converted
using the new button option in the Edit Info File menu. What does this
mean? Well, for ANG surveys, it allows for 3 labeled reporting on
radargrams, e.g., x, y, and the integrated range.
ANG surveys are
treated just like GPS/Vector surveys with random tracks.
Our vector
survey navigation format as stated in a previous newsletter is a
generalized navigation format which is inclusive of all known navigation
methods that are presently done with GPR. Having a standardized
navigation formation will alleviate the confusion of different survey
formats. Providing the conversion button for ANG, or X, Y, or XY surveys
to Vector is a first step in migrating to this single standardized navigation
format. (The Vector formats - just like GPS formats which it is inclusive
of - keep the number of GPS listings in the Y1 column of the profile
information file after making the 20 column vector navigation files
*.*.gps associated with each radargram.)
In addition, features available to X, Y, XY or GPS surveys were
never programmed into the specific ANG survey definition such as
TSPoints or Time Slice/Radargram split screen displays. Converting your
surveys to the generic Vector survey will give one full capabilities of all
the imaging options in GPR-SLICE v7.MT. (Future versions may simply
eliminate all the different survey types and require the generalized Vector
definition).

369

370

Concrete Imaging and Enhancing Linear Features
From Cross XY Surveys (e.g. rebar in concrete)
As many new users of GPR-SLICE are doing geotechnical surveys, it is
useful to show how rebar and concrete mapping options in the software
can be used to enhance linear features. For those doing XY surveys on
concrete, it is possible to decouple the X and Y lines, generate separate
grid maps with directional weighting, and then use grid math to add the
decoupled grid maps back to enhance linear features. Shown in the first
diagram on the next page is one-time slice made from lines parallel to X
axis of a grid. To enhance linear features transverse to the X lines (or
better said, to “bleed” anomalies across to adjacent lines) one can use x
and y search radius which are unequal. In this example the X search
radius is minimized (to a value of 0.5 distance unit) and the Y search
radius is expanded (to a value of 7 distance units). The net effect on
gridding is to better connect linear anomalies going across the lines.
Similar operations are made for the Y lines of the grid (shown in the
bottom figure on the next page) with X search radius set to 7 and the
length of the Y search radius which is minimized to 0.5.
After the
decoupled grids are made, Grid Math is used to add the grids back
together (shown on page 288). Rebar mapping in concrete is shown to
be significantly enhanced.
Comparisons can also be made using combined XY gridding which
show the linear features but not quite as well as the decoupled grids.
Users can practice on this dataset given in the Advanced Users Workshop
folders on the ftp site (\Kisatchie\concrete2\). In general, XY combined
gridding is better when there is no prior knowledge of what kind of
structures are in the ground. However, having prior knowledge can allow
you to enhance these features, particularly for linear structures that are
primarily parallel to the x or y directions
Note: A high cuts-per-mark setting of 10 in the Slice/Resample menu
was used in generating the spatial bins for the time slice ASCII datasets.
This will insure that a high density of bins is generated along the
radargram.
The search radius along the radargrams was set to about
2.5 times the bin width or 0.5 distance units (for enhancing the linear
features transverse to the radargram direction).
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Grid settings used for making time slices of just the X line data.

Grid settings used for making time slices of just the Y line data.
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Grid math operation to add time slices made from decoupled X and Y
lines to generate X+Y time slices are easily accomplished in the Grid
menu. The weight between the grids is usually set to 1 but it can be
changed to decimal values other than one. Negative values can also be
used which in essence represents grid subtraction.
Note: A BlueBox Batch process to completely run the XY decoupled
gridding operation from start to finish is available. See this section in
the manual.
Max(X,Y) Grid Math
XY decoupled gridding for enhancing linear features from cross
surveys has a new option for further enhancements. Overlay analysis is
implemented using a new option called Max(X,Y) in the Grid menu. The
procedure in the Grid menu will chose the maximum value of the X and Y
decoupled grids and place into the output grid. Comparison of the
traditional grid math and the Max(X,Y) option is shown in next figure.
Traditional addition of the independently gridded X and Y datasets which
were completed with elliptical searching, shows simple addition to have
more “dotty” amplitudes at the crossovers between rebar in the image.
The Max(X,Y) procedure because it only takes the peak response between
the two grids shows more even amplitudes. These observations can be
understood in that the addition will double the amplitudes over the
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intersections (particularly when the profile spacing is equivalent to the
rebar spacing). Choosing the Max(X,Y) between the two grids will not
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overweight the rebar intersections.
Max(X,Y) is essentially overlay
analysis however the individual transforms are not being applied - simply
the binary process of using the peak value between the two decoupled
grids. Max(X,Y) shows better constant amplitude mapping along the
rebar.
Because the Max(X,Y) is a very useful operation for concrete imaging
or for sites with linear features parallel to the profiled lines is so valuable,
it is now also included as a setting in BlueBox Batch operation: XY
Decoupled Gridding + Edit + RSP.

Equipment Specific Operations
Mala X3M, CX11, CX12
GPR-SLICE was integrated for the Mala X3M, CX11 and CX12
equipment in 2011. These data can have a unique data format for cross
gridded surveys. The extra operation in GPR-SLICE is to extract the
multiplex radargrams into individual radargrams. The initial radargrams
collected with this equipment are the multiplexed *.rd6 data which are
extracted to create individual lines with the *.rd3 extension. Screen
shots and step by step instructions are given as follows:
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1) Create Info File menu:
step 0) set the recording unit, m, inches, ft etc in the Options menu
step 1) set the xstart/xend ystart/yend to 0-7 if you have 8 profiles
in each direction, or to 0-(N-1) profiles if you have a variable
N number of profiles in each direction. (If *.rhd or *.3dq
Log files are in the folder GPR-SLICE will automatically set
these in the latest version from March 2014 and these do not
have to be set manually)
step 2) set the import listbox to Mala X3M - X,Y or Mala CX11 or
Mala CX12
step 3) click the Import \raw\ - this creates the infomain.dat and
infoxy.dat infomain.dat is the main info file with the multiplexed
radargrams
infoxy.dat is the complete individual extracted cross grid
information file

375

376
2) Edit Info File menu:
step 1) highlight the infomain.dat file
step 2) click the Mala get X3M button to insert samples/scan and
time window if needed

3) Convert menu:
step 1) click the Mala X3M/CX extract or the Mala X3M/CX
Xmulitplex button - you will need to test which button your
equipment has since some older CX11 do not multiplex
the data in the y/*_2.rd6 - in that case click the Extract
button instead etc.
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4) Edit Info File menu:
step 1) highlight the infoxy.dat file
step 2) adjust the line length start or end locations to the correct
values by using the Shift/Times buttons if needed (Note the
*.rhd or *.3dq files are automatically read if they exist to
generate the infoxy.dat line length in the unit chosen in the
Options menu)
step 3) proceed as usual to the Convert menu and use the Mala 16
to 16
(check the *_2.rd3 data to make sure they were properly
extracted or demultiplexed - if incorrect start back from
the Convert menu with the infomain.dat and use the other
button operation)
An example of a Mala CX12 dataset is shown in the next figure. The site
is a concrete survey collected in X and Y directions. A total of 8 lines in
each direction were recorded for the survey.
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(Data courtesy Shawn Williams, Idaho National Labs).
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GSSI Dual Frequency Equipment Channel Separation
In the Edit Info File menu there is a button operation to separate the
dual frequency GSSI radargrams. The raw radargram are written as a
two tier multiplex radargram.
For operations in GPR-SLICE this
multiplexed radargram can first be separated.
The GSSI dual frequency
channel separation will extract the high and low frequency channels from
the multiplex raw radargrams and place these directly into the \raw\
folder. For the high frequency channel, the letter a is appended onto all
the names of the extracted radargrams, and the letter b for the low
frequency channel radargram names. After the extraction processes is
completed two separate information files infoa.dat infob.dat are also
automatically made.
Because the extracted channels are made to the
\raw\ folder, additional pre-conditioning of the radargrams to remove low
frequency drift – wobble – in the pulses can be applied.
Several of the
DF radargrams are shown to have drift, indicating that wobble filtering or
bandpass filtering can be applied to the raw recorded data and will be
needed in processing for this dataset.
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Proceq Auto Import of INFOXY.dat file for concrete imaging
There is a quick auto import of the information file for concrete
surveys collected with Proceq scanners. In the Create New Info menu a
on the import listbox, one can highlight the “Proceq infoxy.dat” item, and
then clicking the Import – Create Info button will open the browser. The
user then navigates to the \raw\ folder of the current project and locates
the *.csv file there. This will then auto create the infoxy.dat file for the
survey.

Pundit PD8000 - UltraSonic Pulse Echo data integration along with
new stitching options for GPR or sonic data

Ultrasonic Pulse Echo (UPE) sonogram data collected with a Proceq
Pundit PD8000 equipment has 8 channels and 3 in-line sensors per channel
for collecting data on infrastructure sites. Using the native output format of
processed sonograms from this equipment in *.csv format, automatic profile
import and direct writing into the \radar\ folder are available through the
Create New Info menu listbox item.
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The PD8000 can be collected in the profile mode as well as in a 3D
mode. Both formats are automatically read in. For data collected in a profile
mode, there is significant overlap between adjacent sonograms (Figure 4).
To stitch these overlapping sonograms together a new function called
Stitch+Avg was added to the Radar Edit menu (Figure 4). In this operation,
the number of overlapping scans are monitored between adjacent
sonograms which can be more than 2 or 3 at a single location, and the data
are re-weighted on writing the stitched sonogram. Using some boxcar
filtering can help to smooth out the stitched data (screen shot 3). The
stitching option can be used for radar data as well. If there is no overlapping
data the button simple called Stitch can be used to locate radargrams on the
same long that one wants to place in a single profile. Null data will also be
shown in a stitched radargrams that does not have complete areal
coverage.

Location to read in Proceq-Pundit 8000 ultrasonic pulse echo data.
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New stitching option to weight overlapped sonograms or radargrams into
a single profile
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3D Visualization with Imported Geophysical Data
(Resistivity, ERT, Seismic)
GPR-SLICE v7.MT has the capability to display any 3D dataset.
Although signal processing of imported datasets is limited to GPR
processing, many useful operations can be used. Electrical Resistivity
Tomography as well as traditional seismic data can be visualized in GPRSLICE.
A special example of importing 2D resistivity profiles and
creating a 3D volume is detailed
7) 2D resistivity profiles are imported and gridded
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8) A 3D volume is generated by interpolating the resistivity profiles.
The one problem now is that the y axis contains the actual depth
axis depth axis.

3)Using a 3D volume pulldown menu and running the reconfigure XZY to
XYZ button will write a new volume interchanging the Y and Z axes in the
volume. To get an equivalent number of grid cells in the new Y and X
axis the user must set an appropriate number of interpolations in
generating the 3D volume. In this example an interpolation of 40 grids to
be interpolated between resistivity profiles was required.
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The archaeological geophysics field school offered by Consiglio Nacionale
delle Ricerche in Rome was sponsored by Salvatore Piro of the Institute of
Technologies Applied to Cultural Heritage at CNR and Stefano Campana of
the University of Siena. In this workshop we had an opportunity to use
the new IDS dual channel GPR systems which performed very well in the
field. Electrical Resistivity Tomography (ERT) was also collected on a test
site with GPR and we were able to process this data and incorporate
these results side-by-side in the Open GL Volume. Shown in following
figure is a Z fence showing a portion of the
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test site imaged with ERT along with a GPR radargram from the IDS dual
channel system.
ERT visualization is GPR-SLICE can be done easily by
simply importing XYZ-N.dat depth slices of ERT data (from the GPR-SLICE
Grid pull down menu), then gridding and interpolating these to generate
3D volumes.
This particular example was made with just 8 ERT
inversions in depth. (There is currently one inconvenience in importing
ERT data in that the depth scale requires editing the 3D header *.hed file
associated with 3D volume to place a “fake” time window to give the
same apparent depth of the radargrams).
The beauty of the ERT method at the test site was that the resistivity
probes were placed only on the boundaries of the site. This powerful
inversion technique of electrical waves allows for developing tomographic
models of areas within the perimeter of the resistivity probes. (ERT data
was collected and provided by Gianfranco Morelli of GeoStudi, Italy).
The large anomalies are rock filled test pits containing cylindrical pipe.
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GPR-SLICE Open GL Volume can also be used to visualize 3D seismic
data. Shown in an example in the following page is a seismic reflection
survey conducted by Mark Olson of Advanced GeoScience from Palos
Verdes. The preprocessed SEGY lines were converted in the Convert
menu using and then processed normally as GPR radargrams. The data
imported although it was already pre-processed, the GPR-SLICE filtering
menu is equally capable of producing signal processed seismic lines of
single fold data.
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